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Océ TDS600

User Manual

Chapter 1
Introduction

This chapter contains a general introduction to the

Océ TDS600, including a general description of the main
features, delivery options and software applications
provided with the system.
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About this manual

12

This manual contains the following chapters

Chapter 1: Introduction contains a general introduction to the Océ TDS600
system, including a general description of the main features, delivery
options and software applications provided with the system.

Chapter 2: Using the Océ TDS600 to print contains a brief description of the
actions that can be performed on the printer operator panel of the Océ TDS600.

Chapter 3 Using the Océ TDS600 to copy contains a brief description of the
actions that can be performed on the scanner operator panel of the Océ
TDS600 plus the basic copy functions that are available from the system.

Chapter 4: Using the Océ TDS600 to scan-to-file describes how to scan
originals to a file.

Chapter 5: Special copy and scan jobs provides a detailed description of
special copy functions that can be performed on the Océ TDS600.

Chapter 6: Océ Power Logic®: Settings Editor gives information about the
Settings Editor. For details about specific settings, refer to the Help on the
Settings Editor.

Chapter 7: Océ Power Logic®: Queue manager describes how to view the
Océ TDS600 print queue and how to abort the active print, how to delete and
pause print jobs in the queue and how to restart jobs that are put on hold.

Chapter 8: Océ Power Logic®: System Control Panel describes how to view
the system status of the Océ TDS600.

Chapter 9: Océ Power Logic®: Remote Logic describes the installation and
the function of the Océ TDS600 applications.

Chapter 10: Océ Account Center contains a description of how to manage the
account information of the print, copy and scan-to-file jobs with Océ Account
Logic and Océ Account Console.

Chapter 11: Media and supplies describes regular maintenance tasks, such as
refilling paper and toner, and refilling the reinforcement unit.
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Chapter 12: Maintenance describes how to clean the glass platen, the
reference roller and how to maintain the reinforcement unit

Chapter 13: Problem solving describes the problems that may occur while
using the Océ TDS600

Chapter 14: The folder contains a description of the folder delivered as an
optional with the Océ TDS600.

Appendix A: Overview and tables contains an overview of the system, the
operator panels, the product specifications for the Océ TDS600, and a list of
available material types and sizes.

Appendix B: Safety information contains the recommended weight limits,
instructions for safe use, the available safety data sheets and the applicable
ENERGY STAR® specifications.

Appendix C: Miscellaneous contains the notation conventions, a reader’s
comment sheet and the addresses of local Océ organizations.

Index indicates where you can find the terms most commonly used in the
manual.
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The Océ TDS600

The Océ TDS600 is a wide format, black and white, mid-volume,
multifunctional system. The Océ TDS600 offers a broad range of print, copy,
and scan-to-file functions. The system is available in a number of printer
configurations, ranging from two rolls in a single drawer (the minimum
configuration) to a maximum of six rolls (with one cassette tray) and three
cassette tray (with four rolls). See ‘Product specifications Océ TDS600’ on
page 245 for more information.

[1] Océ TDS600
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Océ TDS600 key concepts

Printer configuration The Océ TDS600 is available in a number of printer
configurations, ranging from two rolls in a single drawer (the minimum
configuration) to a maximum of six rolls with one cassette tray and four rolls
with three cassette trays. Also a number of optional features are available,
including an integrated folder, a output delivery tray, paper roll loaders and a
paper switch for supporting customer finishing units.

Copy function With the Océ TDS600 scanner a large number of copy
activities can be performed. A wide variety of original and copy related
settings are supported. You can specify particular layout, media, finishing,
feeding and quality enhancement options from the scanner operator panel. See
‘Product specifications Océ TDS600° on page 245 for more information.

Océ Scan Logic® The Océ TDS600 offers an optional scan-to-file function.
Documents are scanned, then stored digitally. Ten customized destinations are
supported.

Adobe® PostScript® 3™/PDF The Océ TDS600 fully supports Adobe®
PostScript® 3™, Five extra fonts are optional for Japanese. They can be
enabled with a password in the Océ Settings Editor.

Network connectivity The Océ TDS600 supports a number of popular network
protocols. This means that it can be used in multiple networking environments
such as TCP/IP, and Novell Pserver (IPX/SPX).

Set processing The Océ TDS600 supports set processing. This means that a
job can consist of several files or originals. You can print or scan these files or
originals multiple times and in sorted sets. The Océ TDS600 is equipped with
a set memory for storing up to 250 AOs which allows for the creation of
identical sets that are sorted either by page or by set. See chapter , ‘Make a set
copy’ on page 110.

Print and copy jobs A print and copy job is a job sent to the Océ TDS600
Printer from a user application (print job) or from the scanner (copy job). A
print or copy job can consist of several sets, which in turn may consist of
several pages. A job can be sorted by page or by set.

Spool memory The Océ TDS600 contains a spool memory which provides a
queuing system for files you want to print. The spool memory allows multiple
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users to send print jobs to the Océ TDS600 simultaneously. The print jobs are
then placed in the print queue where they wait to be printed. The job that is put
first into the queue is printed first.

Job recovery The Océ TDS600 is equipped with a job recovery function that
safeguards users against data loss in case of a printer failure. After a restart, the
data submitted to the printer before the crash will be automatically processed
and printed. This means that jobs do not have to be re-submitted after a printer
malfunction, thus saving valuable time for the users.

Green key principle The Océ TDS600 is a very user-friendly system. The
scanner, in particular, is very easy to operate. Basic copy jobs can be performed
by simply pressing the green start key on the scanner operator panel. In the case
that you want to perform more complex copy jobs, you have to change the
default copy settings with the help of the other settings on the scanner operator
panel.

User interaction

16

The user can communicate with the Océ TDS600 from local locations and
remote locations:

Operating panels The Océ TDS600 consists of two operating panels for
making a wide variety of settings for printing and copying. See ‘Printer
operator panel’ on page 243 and ‘Scanner operator panel’ on page 244 for
more information.

Controller applications The Océ TDS600 controller applications are used for
making default key operator and system administrator settings (Océ Settings

Editor). For viewing the status of the jobs in the print queue you use the Océ

Queue Manager. The Océ System Control Panel shows the status of the entire
system.

Océ Scan logic® With ‘Océ Scan logic®’, you can define all relevant settings
for scan-to-file. See ‘Océ Scan Logic®’ on page 70 for more information.

Océ Remote Logic® Océ Remote Logic® enables you to:

m View system status (Océ System Control Panel).
m Manage print jobs (Océ Queue Manager).
m Change settings (Océ Settings Editor).
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Printer drivers A number of printer drivers can be used with the Océ TDS600,
including a Windows® raster driver, AutoCAD®ADI/HDI drivers and a
PostScript® driver. With these drivers, users in remote locations can print their
files directly from their applications to the Océ TDS600. More information
about installing, configuring and using drivers can be found in the
documentation provided with the drivers. All Océ drivers can be downloaded
for free from the Web at www.oce.com.

0Océ Print Exec® Workgroup Print Exec® Workgroup is optional software
which allows you to create and send a set of files to any Océ TDS printer. You
can send the settings for these jobs from your workstation, using your web
browser or from your Microsoft Windows® environment. See also ‘Print with
Océ Print Exec® Workgroup’ on page 40.

Océ Repro Desk Océ Repro Desk is a print management solution for the
reprographer and their clients. See also ‘Print with Océ Repro Desk’ on
page 42.

FTP The Océ TDS600 supports printing via FTP. You can print files via FTP
from a command line prompt, an FTP application, or from an Internet browser.
The following Internet browsers support drag and drop of files:

m Netscape® Navigator 4.x
Drag the jobs to the Jobs folder on the FTP site of your Océ TDS600. The
jobs will appear in the print queue on the Océ Queue Manager.

The following Internet browsers support copy and paste of files:

m Netscape® Navigator 4.x

m Microsoft® Internet Explorer 5.5

Paste the jobs into the ‘Jobs’ folder on the FTP site of your Océ TDS600. The
jobs appear in the print queue on the Océ Queue Manager.
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Océ TDS600 users

18

On the Océ TDS600, the following user types can be identified:

System administrator The Océ TDS600 system administrator is responsible
for installing and configuring the Océ TDS600 in his environment. He defines
the printer language settings, pen settings and Automatic Language Sensing
(ALS) settings. The system administrator can also provide assistance to normal
users who need to install the printer drivers on their workstations. See ‘Media
and supplies’ on page 177 for more information. Configuration information
can be found in the Océ TDS600 Connectivity Manual provided with the Océ
TDS600.

Key Operator The Océ TDS600 Key Operator is responsible for the daily
maintenance of the Océ TDS600. The Key Operator replenishes toner and
loads media as needed, and defines the default printer settings for recurring
print jobs. Also, the Key Operator defines all time settings, such as panel
timeout and sleep mode timeout. See ‘Océ Account Center’ on page 171 for
more information.

Repro Operator The Repro Operator is responsible for the daily operations on
the Océ TDS400. The Repro Operator settings are a subset of the Key Operator
settings. The Repro Operator has no rights for changing settings in the Océ Settings
Editor. In the Océ Queue Manager and the Océ System Control Panel, the Repro
Operator has the same user rights as the Key Operator and System Administrator.

Anonymous user Typically, an anonymous user on the Océ TDS600 can be
either a PC user who has remote access to the system through one or more
drivers (Windows® driver, AutoCAD® ADI/HDI or PostScript®) or the remote
applications (Océ Queue Manager, Océ System Control Panel and Océ
Settings Editor), or the print submission/print management applications, or a
user performing a copy job at the scanner.

Service Operator TA user mode for service purposes.
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Océ TDS600 components

The Océ TDS600 is available as a digital network printer, a scanner or as a full
combination which can print, copy or scan to file. It consists of the following
components (see figure 1 on page 14):

= Printer
m Scanner
m Océ Power Logic® Controller

These components, in combination with your network, Océ Print Exe® LT
Web and one or more drivers (Windows ®driver, AutoCAD® HDI or
PostScript®), allow you to use the Océ TDS600 as your default enterprise print
and copy solution.

See the Océ TDS600 Connectivity Manual for more details about making
networking settings on the Océ TDS600 printer. You find more information
about installing, configuring and using drivers in the documentation provided
with the drivers.

Note: All Océ drivers for the Océ TDS600 (except PostScript® 3™,) can be
freely downloaded from the World Wide Web at www.oce.com.

Océ TDS600 printer

The Océ TDS600 printer has the ability to contain two rolls in a single drawer
(the minimum configuration) to a maximum of six rolls with one cassette tray
and four rolls with three cassette trays. The printer delivers your jobs on the
integrated receiving tray, on top of the printer.

You can choose to buy the following options:

m an output delivery tray

m a folder to fold the output

m a reinforcement unit to add a reinforcement strip to folded output
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Océ TDS600 scanner

You use the Océ TDS600 scanner to make copies or with the optional Océ Scan
Logic®, to scan-to-file.

The optional original delivery tray enables you to stack your originals behind
the scanner.

Océ Power Logic® controller

20

The Océ TDS600 is equipped with an Océ Power Logic® controller which

helps you to make optimum use of your system. On this Océ Power Logic®

controller a number of applications run which allow you to control your print

jobs, make your default printer settings and monitor the printer status. These

applications include:

m Océ Queue Manager (QM)

m Océ System Control Panel (SCP)

m Océ Settings Editor (SE)

m Océ Remote Logic® (includes QM, SCP and SE on a remote workstation
which connects to the Océ Power Logic® controller)

Océ Queue Manager The Océ TDS600 Queue Manager (QM) application

provides you with a graphical representation of the print queue. It allows you

to view the print queue and the status of the print jobs as well as to manage the

jobs in the queue. With the Océ TDS600 Queue Manager you can:

m View the print queue

m Abort the job currently being printed

m Delete jobs in the queue

m Pause jobs in the queue

m Restart previously paused job(s) in the queue

m Print jobs from the Inbox queue

m Print jobs from the History queue

m Give jobs a priority.

m See ‘Managing print jobs’ on page 146 for more information about the Océ
TDS600 Queue Manager.

Océ System Control Panel The Océ TDS600 System Control Panel (SCP)
application provides you with status information about the printer. This
includes:
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m Machine status of the Océ TDS600 printer, scanner and the Océ Power
Logic® Controller

= Set memory monitor to view the available storage space on the controller.

m Overview of the loaded media types and sizes.

See ‘Océ Power Logic®: System Control Panel’ on page 149 for more
information about the Océ TDS600 System Control Panel.

Océ Settings Editor The Océ TDS600 Settings Editor allows an operator to
configure and set up job, printer, system and scanner specific settings. These
settings include:

= Format options

m Editing options

m Media related options

m Finishing options

The system administrator settings in the Océ TDS600 Settings Editor
application allow the system administrator to configure and set up all aspects
related to the infrastructure of the system. These settings include:

m Host information

m Network settings

= Pen settings

m Printer language settings

m General administrator settings

See ‘Océ Power Logic®: Settings Editor’ on page 123 for more information
about the Océ TDS600 Settings Editor application.
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Options: you can order the following options for the Océ Power Logic ®

controller:

m Océ Scan Logic® consists of Océ Scan Manager and Océ View Station LT.
With Océ Scan Logic® you can perform scan-to-file.

m Océ Print Exec® Workgroup is a job submission application, which allows
you to send print jobs to a destination device (Océ printer) from your web
browser. For detailed information see ‘Print with Océ Print Exec®
Workgroup’ on page 40.

= Job templates
The job templates on the scanner operator panel give you direct access to five
different sets of settings. You define the template settings in the Océ Settings
Editor. You select a template on the scanner operator panel by pressing one
of the five function keys. The fifth template includes the last used settings on
the scanner.

m Account Logging. Account Logging is for accounting purposes, the Océ
Power Logic® Controller is able to keep track of all your jobs. For each job
the job information and the paper usage is stored.

m Océ Matrix Logic®
Océ Matrix Logic® allows you to create, in one single operation, different
copy sets from one set of scanned originals using predefined settings (see ‘Océ
Matrix Logic® introduction’ on page 111).

= Stamping
Stamping allows you to print a predefined text on all your copies (see
‘Stamping’ on page 66).
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Turn on and off the Océ TDS600

You must separately turn on and off Océ TDS600 printer, scanner and the Océ
Power Logic® Controller. You do not have to use a specific order in which you
turn on and off the Océ TDS600 printer, scanner and the Océ Power Logic®
Controller.

Use the On / off switch at the rear of the printer to turn on and off the printer.
Use the On/ off switch underneath the original feed table on the scanner to turn
on and off the scanner. Use On/ off button on the Océ Power Logic® Controller
to turn on and off the Océ Power Logic® Controller.

[2] On / off switch on the printer

[3] On / off switch on the scanner
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[4] On / off button on the Océ Power Logic® controller

Turn on and off the Océ TDS600 printer

1 Set the On / off switch at the rear of the printer to position ‘1’, (see figure 2).
The green LED turns on.
The message ‘Ready to print’ appears.

2 Set the On / off switch at the rear of the printer to position ‘0’.
Note: Before you turn off the printer, make sure that the printer is not
printing a job.

Turn on and off the Océ TDS600 scanner on

1 Set the On/ off switch at the front of the scanner to position ‘1°., (see figure 3).
The green LED turns on.
The message ‘Ready to scan’ appears.

2 Set the On / off switch at the front of the scanner to position ‘0’.

Start up the Océ Power Logic Controller

1 Turn on the controller and the screen.
After the initial system test of the controller the applications, Océ Queue
Manager, Océ System Control Panel, Océ Settings Editor and Océ Scan
Manager are automatically started and the controller applications are ready for
operation.
Note: The Océ Queue Manager and the Océ System Control Panel applications
are visible on the screen. The Océ Settings Editor is minimised, to save screen
estate.

Take the following actions to turn off the controller:
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Turn off the Océ Power Logic® Controller

Go to the Océ System Control Panel application.

Select the ‘Shutdown’ option from the ‘System’ menu.

Confirm shutdown by clicking on the ‘Yes’ button in the ‘Shut down’ window.
The system automatically performs the shutdown procedure for the controller.
Finally, the Windows ‘Shutdown Computer’ window appears, which informs
you that you can turn off your computer.

You can now restart the controller by pressing the ‘Restart’ button.

Note: Wait at least 5 seconds before you restart the Océ TDS600.

Turn off your computer and display.
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Chapter 2
Using the Océ TDS600 to Print

This chapter contains a short description of the operator
panel of the Océ TDS600 printer and the actions you can
perform on the printer operator panel.
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Before you begin

You must turn on both the Océ TDS600 printer and the Océ Power Logic®
Controller before you can print. See ‘Turn on and off the Océ TDS600’ on
page 23.
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How to print

See ‘User interaction’ on page 16 for information about how to print to the Océ
TDS600.
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Printer operator panel

The printer operator panel consists of a number of keys and a graphical display
(see Figure 5). At the top of the panel you will find an attention light which
starts flashing when operator intervention is required.

Readytoprint

&7 1 AD paper &2 41 paper Up / down
(3 Al paper & 4 A2 paper keys
=1 A3 paper ﬂ

T, papet L2 &< paper [

Selection
keys

On-line

key
Stop key

an line
[5] Printer operator panel
Display

The graphical (LCD) display offers feedback about the current printer status.
It provides you with the following information:

m Status information (e.g. ‘Preparing for run’ or ‘Ready to print’).
During normal operation the following message types may appear:
Status/action message: indicates the actual status of the printer plus the
action to be taken, e.g. ‘Roll empty. Feed A2, plain paper’.
Warning message: during a warning message the printer will continue to
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operate, but it may be that the prints are not being made in optimal quality,
e.g. ‘Fill BS toner’.
A graphical overview of available rolls and cassette trays, including the
material type and size used by each roll or cassette tray.

m A symbol indicating the paper orientation (for cassette trays only).

= An indication that a particular roll or cassette tray is empty (if applicable).
An empty roll is represented by a dotted roll symbol.
An empty cassette tray is displayed as an empty paper tray.

m In the event of an error, a graphical representation of any error location
(cover or panel), together with instructions on how to solve the problem is
displayed.

Counter

On the operator panel of the Océ TDS600 Printer a counter will be displayed
that gives the user feedback about the progress of the job that is currently being
printed. The counter, which is located at the bottom of the upper window on
the operator panel, displays the number of sets and/or pages printed. Counting
starts at 1. The following options are available:

» When no sets are made, only the current page and the total number of pages
are displayed (e.g. ‘Page 3 of 57). At the beginning of a job, when the system
does not know the total number of pages yet, only the current page may be
displayed (e.g. ‘Page 5°).

= With set input: set counter. In this case, the counter shows the current total
number of sets and the current page (e.g. ‘Set 3 of 5, Page 10’). At the
beginning of a job, when the system does not yet know the total number of
sets, only the current set and page may be displayed (e.g. ‘Set 2, Page 5°).

m With set input: multiple sheet counter. In this case the counter shows the
current page, the total number of pages and the current copy, e.g. ‘Page 2 of
12, Copy 5°). At the beginning of a job, when the system does not yet know
the total number of pages, only the current page and copy may be displayed
(e.g. ‘Page 2, Copy 5°).
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Keys

32

With the keys on the operator panel you can make a number of settings for the
Océ TDS600 Printer, such as the media type and size or the preferred language.

The following keys are available:

Key types

Key Types Function

Selection The selection keys are located immediately below the

keys graphical display. The left key can be used to activate one of
the main menu choices (Language, Folding or

Media) on the left part of the display.

Note: A shadow highlighting effect is used to indicate the
active menu option.

The right selection key can be used to activate the options on
the right part of the graphical display.

Note: To identify the active selection, the dotted line around
this selection is changed into an uninterrupted line and the
small selection triangles next to the specified option are no
longer dimmed.

These selection triangles indicate that you can select an option
from a predefined list with the help of the Up / down keys.

Up / Down These two triangular keys to the right of the graphical display
keys are used to display the next or previous option from the
selected menu choice and to select the desired option.

On-line key By pressing the on-line key you can put the printer on-line or
off-line. If the green light above the on-line key is on, the
printer is on-line; if this light is off, the printer is off-line.

Stop key The red stop key is used to stop the current print job. After this
key is pressed, a dialog will be displayed asking for
confirmation.

Note: The printing process does not stop instantaneously since
a number of prints may already have been submitted to the
printer after processing. The prints cannot be stopped.

Extra Key This key is reserved for future use.
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Printer operator panel actions

On the Océ TDS600 printer operator panel you can perform a limited number
of actions:

m Set the media type

m Set the media type for manual feeder
m Set the media size

m Set a special media indication

= Stop a print job

m Select the preferred language

m Make off-line folding settings

= Change the display language

m Clean the reinforcement knives

Media type and size on the printer

One of the features of the Océ TDS600 printer is the automatic media change
function. This function allows the printer to switch to another roll of the same
format and material when the roll or cassette tray becomes empty during
printing.

Since the Océ TDS600 Printer cannot detect the loaded media type and format
itself, you have to specify type and size after you (re)load media, as described
in ‘Maintenance of the glass platen and the reference roller’ on page 192.The
Océ TDS600 supports both DIN and ANSI media formats.

See ‘List of available material types and sizes’ on page 252 for an overview of
all materials that can be used on the Océ TDS600 Printer.
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Set media type

1 Press the on-line key on the printer operator panel to put the printer off-line.
The message ‘off-line’ is displayed in the status window.

Language

Folding Binding 2 | siee

* hiedia Roll 1 =} | | Binding

an line

[6] Operator panel in off-line mode

The focus is shifted to the Media option (indicated by the shadow effect).

Use the Up / down keys to select the roll or cassette tray for which you have

just loaded new media.

Press the right selection key to activate the Mat. (Material) option.

The dotted line around the current selection is changed into an uninterrupted

line and the small selection triangles next to the specified material are no

longer dimmed.

Use the Up / down keys to select the material you just loaded.

5 Press the on-line key to put the printer on-line again. The printer now knows
which material is used for the specified roll or cassette tray.

N

(2]

=Y

Set media type for manual feed

1 Press the on-line key on the printer operator panel to put the printer off-line.
The message ‘off-line’ is displayed in the status window.

2 Press the left selection key to shift the focus to the Media option.

A shadow effect is used to indicate that the focus is set to this option.

Use the Up / down keys to select the Manual option.

Press the right selection key to activate the Mat. (Material) option.

The dotted line around the current selection is changed into an uninterrupted

A W
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line and the small selection triangles next to the specified material are no
longer dimmed.

Use the Up / down keys to select the material you just loaded.

Press the on-line key to put the printer on-line again. The printer now knows
which material is used by the manual feeder.

Set media size

Press the on-line key on the printer operator panel to put the printer off-line.
The message ‘off-line’ is displayed in the status window (see Figure 6 on
page 34).

Press the left selection key to shift the focus to the Media option.

A shadow effect is used to indicate that the focus is set to this option.

Use the Up / down keys to select the roll or cassette tray for which you have
just loaded new media.

Press the right selection key to activate the Size option.

The dotted line around the current selection is changed into an uninterrupted
line and the small selection triangles next to the specified size are no longer
dimmed.

Use the Up / down keys to select the size for the media you just loaded.

The printer shows both DIN and ANSI sizes. Select a size from the correct
format.

Press the on-line key to put the printer on-line again. The printer now knows
which media size is used for the specified roll or cassette tray.

Special media indication

On the Océ TDS600 Printer, you can attach a Special indication (exclamation
mark (!)) to a roll or cassette tray which uses special media (for instance
colored paper). This indication is used to identify the roll or cassette tray to the
printer. For this roll or cassette tray the automatic media change option is
disabled.

Set a special media indication

Press the on-line key on the printer operator panel to put the printer off-line.
The message ‘off-line’ is displayed in the status window (see Figure 6 on
page 34).

Press the left selection key to shift the focus to the Media option.

A shadow effect is used to indicate that the focus is set to this option.

Use the Up / down keys to select the roll or cassette tray for which you have
just loaded special media.
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4 Press the right selection key to activate the “Type’ option.
The dotted line around the current selection changes to an uninterrupted line
and the small selection triangles next to the specified type are no longer
dimmed.

5 Use the Up / down keys to select the Special option for the specified roll or
cassette tray.

6 Press the on-line key to put the printer on-line again. The printer now knows
that the specified roll or cassette tray contains special material.

Stop a print job

The red ‘stop key on the Océ TDS600 Printer operator panel stops the active
print process. You can cancel or continue the current print job.

Cancel a print job

1 Press the ‘Stop’ key.
A dialog is displayed informing you that you can press on-line to continue or
stop to cancel the job.

2 Press the ‘Stop’ key again to cancel the current job.

Note: In general, the printer cannot be stopped immediately because the
started prints have to be finished. Printing will be stopped at the end of the
page.

Continue a print job

1 Press the ‘Stop’ key.
A dialog is displayed informing you that you can press on-line to continue or
stop to cancel the job.

2 Press the ‘On-line’ key to continue the current print job.

Select a language

36

On the operator panel of the Océ TDS600 Printer you can specify which
language you want to use for displaying printer information, such as status and
error messages.

By default, you can choose between two languages in the Settings Editor,
which have been defined for your system by the key operator (see ‘Find system
settings in the Settings Editor’ on page 137).
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Note: Ifthe key operator has specified only one language, it will not be possible
for you to choose. In that case, the language option will not appear on the
operator panel.

Selecting a language

Press the ‘On-line’ key on the printer operator panel to put the printer off-line.
The message ‘off-line’ is displayed in the status window.

Press the left selection key to shift the focus to the Language option.

A shadow effect is used to indicate that the focus is set to this option.
Activate the Language option by pressing the right selection key.

The dotted line around the current selection is changed into an uninterrupted
line and the small selection triangles next to the specified language are no
longer dimmed.

Use the Up / down keys to switch between the predefined languages.

The language specific elements on the display are immediately customized to
reflect your language choice. Only the indicator for the language itself, is in
the alternative language. This way you always know what your alternative
language is.

Put the printer on-line again by pressing the on-line key. The printer now uses
the selected language.
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Off-line folding settings

On the operator panel of the Océ TDS600 Printer you can specify the settings
you want to use for off-line folding. These settings include defining the length
and width of the folded package, enabling and defining the binding edge,
selecting the input method and legend position and cleaning the reinforcement
knife.

Make off-line folding settings

Press the on-line key on the printer operator panel to put the printer off-line.
The message ‘off-line’ is displayed in the status window.

Activate the Folding option by pressing the left selection key.

The dotted line around the current selection is changed into an uninterrupted
line and the small selection triangles next to the specified option are no longer
dimmed.

Use the Up / down keys to switch between the available options.

4 Activate the Input option and press the right selection key to activate the

0 N O O

10

Legend option.

If necessary, change the value in the Legend field with the Up / down keys.
Press the right selection key again to activate the Method option.

If necessary, change the value in the Width field with the Up / down keys.
Press the left selection key again and use the Up / down keys to select another
option. This can be Package (with optional Length and Width), Binding (with
optional Size and Binding), or Special (with optional Knife).

Define any settings you desire.

Put the printer on-line again by pressing the on-line key. The printer now uses
the specified off-line folding settings.

Positioning the reinforcement knives (optional)

38

Because the knives of the optional reinforcement unit of the folder get sticky
from the glue on the reinforcement tape, they have to be cleaned regularly. You
are recommended to clean the knives each time you have inserted a new tape
roll (see ‘A new tape roll” on page 194) or when an error in the reinforcement
unit has occurred.

Before you can clean the reinforcement knives, you have to place them in such
a position that all the parts that need to be cleaned are accessible. You can do
this from the printer operator panel.
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Prepare the reinforcement knives for cleaning

Press the On-line key on the printer operator panel to put the printer off-line
The message ‘off-line’ is displayed in the status window.

Press the left selection key to shift the focus to the Folding menu.

A shadow effect is used to indicate that the focus is set to this menu.

Select the Special option from the Folding menu.

Press the right selection key start activate the Knife option.

The following information is now displayed in the panel display:

0pen doar and clean forcement knife

[7] Cleaning the reinforcement knife

Note: When a job is running, the message ‘Job interrupted’ appears. The
machine stops running after it has correctly finished the prints that were
already in the engine. Then the reinforcement knives are placed in the
correct position.

You can now continue to clean the reinforcement knives (see ‘Maintenance of

the reinforcement knives’ on page 204).
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Printing with Océ Print Exec® Workgroup

Introduction

Océ Print Exec® Workgroup is an optional print job submission application
that allows you to send print jobs to the Océ TDS600 through your web
browser. Enable Océ Print Exec® Workgroup with a password in the Océ
Settings Editor. Océ Print Exec® Workgroup allows you to do the following.

Select and collect the files to print (documents and drawings), in a print job.
Configure the print job.

Preview the files to print.

Submit the print job.

Check the print job and the printer configuration status.

g H WON =

Options

Océ Print Exec® Workgroup has the following options:

m View status information about the printer configuration and available media.
m View status information of submitted print jobs in the historic queue.
m Set the document or drawing settings.

m Set the job settings for a print job.

m Add a settings configuration for a print job.

m Add a maximum of 100 documents or drawings to a print job.

m Add documents or drawings from the Océ Doc Exec® archive.

m Add a stamp to the document or drawing.

m Add a banner to the print job.

m Preview the document or drawing before you print.

m Save and retrieve print jobs.

= Submit print jobs to printer queue or inbox queue.

m Manage serveral print jobs.

Connect to Océ Print Exec® Workgroup

Requirements for the browser software and network. =
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= Microsoft® Internet Explorer® 5.0 or higher versions, or
m Netscape Navigat0r® 6.0 or higher versions.
m TCP/IP network which connects the printer and the end user workstation.

v How to connect to Océ Print Exec® Workgroup
1 Enable Océ Print Exec® Workgroup in the Océ settings editor.
(see ‘Find system settings in the Settings Editor’ on page 137).
2 Enter the following link URL in you browser: http://printer name.
When you enter the URL for the first time, the required software is installed
automatically at your workstation

The documentation set

The complete documentation set of Océ Print Exec® Workgroup includes the
following:

u The Océ Print Exec® Workgroup user manual
m On-line help files in the Océ Print Exec® Workgroup application.
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Printing with Océ Repro Desk

Introduction

Océ Repro Desk is the preferred print management solution for reprographers.
Océ Repro Desk consists of the following two parts:

m Océ Repro Desk Remote software which facilitates the electronic
submission of drawing files and print request from the clients to their
reprographers.

m Océ Repro Desk Server which provides the reprographers with extensive
print management and accounting functions to maximize the productivity of
their print equipment assets.

The documentation set

The complete documentation set of Océ Repro Desk includes the following:

m The Océ Repro Desk user manual
m The on-line help files in the Océ Repro Desk applications.
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Chapter 3
Using the Océ TDS600 to Copy

This chapter contains a short description of the interface of
the Océ TDS600 scanner and the copy function on its
operator panel.
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Before you begin

Note: You must turn on both the Océ TDS600 scanner and the Océ Power
Logic® Controller before you can perform copy jobs. See ‘Turn on and off the
Océ TDS600’ on page 23.
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Scanner Operator Panel

Job
Interrupt

Function
keys

The Océ TDS600 is a very user-friendly system. The scanner, in particular, is
very easy to operate. Basic copy jobs can be performed by simply pressing the
green start key on the scanner operator panel. If you want to perform more
complex copy jobs, you will have to change the default copy settings with the
help of the other settings on the scanner operator panel.

The operator panel is located above the original feed. As you can see in this
diagram (see Figure 8), the panel consists of a display in the center surrounded
by a number of function, section and arrow keys. To the left of the display, you
can find the ‘Stop’ key and below the display you can find the ‘Start’,
‘Numeric’ and ‘Correction’ keys as well as the ‘Counter’ window.

This section consists of two parts: The first part explains the basic use of the
keys. The second part deals with special use of the display. It describes how to
use the soft keys above and along the sides of the display to define your copy
settings.

Section keys Arrow keys
[

@1 A0 Paper ! 72 41 Paper |

@3 A2 Paper ! 4 A1 Paper | ultiple shests :

i1 43 Transp 2 12"Transp. ! et | File
®@Single sheet @ sutomatic ®Print

File mode

—

1
Cannmnnns

Start key Numeric keys Correction key

[8] Scanner Operator Panel
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Keys

46

With the keys on the operator panel you can make a number of settings for the
Océ TDS600.

The following keys are available:

key type

key type Function

Start keys The green key marked with <> is used to start the
feeding of the original, or to re-start the copy process.

Numeric keys The keys with numbers on the lower part of the operator
panel are used to enter numbers.

Correction key The orange key marked with C is located at the bottom
of the central section of the operating panel. Press the
correction key one time to reset the selected setting to
its default value. Press the correction key two times to
reset the numeric display to ‘1°. Press the correction key
three times to return to the first screen on the display.

Stop key Pressing the red key left of the display stops the copy
process for the current original. You can stop the
original transport immediately when an original jam
occurs.

Job interrupt key You use the job interrupt key to set extra priority to your
copy job or to remove extra priority from your copy job.
Determine the priority of your copy job with the Job
interrupt key before you scan your originals. The job is
placed on top of the printing queue in the queue
manager.The interrupt job will start running directly
after the current page is completed. No new job is send
to the printer.
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Section, Function and Arrow keys

Apart from the above mentioned keys, the operator panel of the Océ TDS600
scanner contains a number of other keys. These include:

m Section keys

m Function keys

m Arrow keys.

The section keys are the four keys located above the display. These keys
provide access to the ‘Custom’, ‘Original’, ‘Print’ and “File’ sections on the
display.

Each section contains several functions (cards). These can be accessed with the
help of the left most function key, which is also called the card selection key.

The five function keys (below the display) allow you to select functions or
subfunctions within a card.

Finally, the arrow keys can be used, like the numeric keys, to define numeric
settings. The arrow keys are also used for selecting subfunctions.
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Sections on the operator panel

When the job templates are enabled, the scanner operator panel displays the
templates (see Figure 9). You need to select a template before the sections will
display.

5elect a template

FPreference

Description 1 Description 4

Description 2 Description 3

Template 1 Template 4 Lastused

Template 2 Template 3

[9] The job templates at the bottom of the scanner operator panel

When the job templates are disabled or you selected a job template, the scanner
operator panel displays the following sections with an active ‘Custom’ section.

m The ‘Custom’ section which provides direct access to frequently used
settings, defined by the customer.

m The ‘Original’ section which provides access to the settings of the scanner
input, the original.

m The ‘Print’ section which provides access to the settings of the printer output,
the print.

m The ‘File’ section which provides access to the settings of the scan-to-file
output, the file.

Custom section

The ‘Custom’ section contains the frequently used settings. Figure 8 on
page 45 shows an example with the following settings.

m Media

= Input mode
m Zoom

= File mode
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The key operator defines the contents in the Océ Settings Editor on the Océ
Power Logic controller (see ‘Define the contents of the custom card’ on
page 134). The key operator can change the contents, dependent on your
configuration, for example into the following settings.

m Media

m Input mode
m Folding

m Language
m Exposure

Original section

The ‘Original’ section contains all settings for the scanner input, the original
(see Figure 10 on page 49). The settings are divided over the following cards.
m Scanner

m Image

m Sheet

m Feeding

.Lmes [ text Autornatic ; Darlker
......... | Background
R compensation

[10] The cards of the 'Original‘ section at the left side with an active 'Image’ card

Print section

The ‘Print’ section contains all settings for the printer output, the print (see
Figure 11 on page 50). The settings are divided over the following cards.

= Image

= Layout

m Finishing
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Original

&1 A0 Paper !
Image P o@s AZ Paper ! 4 A1 Paper ! H
Layout #11 A3 Transp. ! z 12" Transp. ! on i Standard
N ® Automatic H :.fo :.Sgnchro
Finizshing H

_ Henuel feed cuttenoth
Sheet I

[11] The cards of the ‘Print’ section at the left side with an active 'Sheet cards

File section

The ‘File’ section contains all settings for the scan-to-file output, the file (see
Figure 12 on page 50). The ‘File’ section is only available if you have the
scan-to-file option installed(see ‘Use the Océ TDS600 to scan to file’ on
page 67).

eady to scan to file

dest. 1 . TIFF

I H
o Destination File type TIFF
subformat

[12] The cards of the ‘File’ section at the left side with an active ‘Destination’ card

Job templates

A job template contains all settings for a job. Figure 9 on page 48 shows an
example with the following job templates.

= Template 1
= Template 2
= Template 3
m Template 4
m Last used
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The key operator defines the settings in the Océ Settings Editor on the Océ
Power Logic controller (see ‘Define the job templates’ on page 135). The key
operator can change the job template names, except for ‘Last used’, for
example into the following job names.

= Single copy
= Set copy

m Matrix copy
m Scan-to-file
m Last used

When you select the ‘Last used’ job template, you recall all settings from the
previous job. You can change the settings or do the same job again. The ‘Last
used’ job template does not display when you turn on the scanner.

After you select a template, the sections display. The sections provide access
to the settings for the scanner input, the printer output and the scan-to-file
output (see ‘Sections on the operator panel’ on page 48). Use the Custom Card
here to provide access to frequently used settings reffered to the type of job.

Change the operator panel language

It is possible to change the operator panel language. You can choose between
two preferred languages.

v To select a language

1 Open the ‘Scanner’ card in the ‘Original’ section.
Press the ‘Language’ function key to set the needed language.

Settings on the Océ TDS600 scanner operator panel

When job templates are enabled in the Océ Settings Editor, the job templates
are displayed on start-up of the Océ TDS600 scanner (see Figure 9 on

page 48). When job templates are not enabled in the Océ Settings Editor, the
‘Custom’ card is displayed on start up (see Figure 8 on page 45).

The custom section gives access to the settings you defined in Océ Settings
Editor. This contains a number of settings which are direct accessible. The key
operator defines the custom section in the Océ Settings Editor
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How to make settings

Select a template (only applies when job templates on the scanner operator

panel are enabled in the Océ Settings Editor).

Press one of the Section keys to activate the desired menu.

Note: The active menu is slightly moved downwards to visually separate it

from the other menus. Apart from that, a shadow highlighting effect is used

for extra highlighting.

Press the Card selection key to select the appropriate card. You can switch

cards (from bottom to top) by pressing the key again.

Note: Here, too, the active card is visually separated from the other cards

and given a shadow highlighting effect for extra highlighting.

Select the desired function values in one of the following ways:

= Simple (non-numeric) selection: press the Function key to activate the
desired (non-numeric) value. The selected value is preceded by a ‘@’ symbol.

m Long list selection: if you want to select a value from a list of options that can
not be fully displayed on the panel, you first activate the selection triangles
next to the specified option (the dotted line around this selection is changed
into an uninterrupted line and the selection triangles are no longer dimmed),
which indicate that there are additional options available and then select one
of the non-displayed values with the Arrow keys. The ‘Original type’ setting
demonstrated in figure 10 on page 49 is an example of this.

= Numeric selection: activate the selection triangles and select the desired
value with the arrow keys or with the numeric keys.

Also a combination of simple selection and numeric selection is possible.
The Correction key use the Correction key to do the following:

Press the Correction key one time to return to the default value of the active
setting.

Press the Correction key two times to set the numeric display to 1.

Press the Correction key three times to return to the top layer of the Scanner
Operator Panel. When job templates are enabled in the Océ Settings Editor the
top layer shows the job templates. When job templates are not enabled in the
Océ Settings Editor, the top layer shows the ‘Custom’ section.
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When ‘Automatic feed’ is selected for a single sheet job, this setting stays
active after the job is completed.

Job interrupt only stays active for one job. You have to press the Job interrupt
key before each new job you want to give interrupt priority.

The Scanner Operator Panel will automatically return to the top layer and the
default settings after the time defined in the ‘Panel Time-out’ setting in the Océ
Settings Editor (see ‘Find system settings in the Settings Editor’ on page 137).
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Perform basic copy jobs

On the Océ TDS600 scanner you perform a number of basic tasks. These
include:

= Make copies

m Select the required media

m Select the input mode

m Specify the zoom factor

m Select the exposure

m Background compensation

m Deliver originals after scanning

m Define settings for the next original
= Account logging

m Using the manual feed for copying
m Define delivery of copies

m Job interrupt

= Stop a job

Make copies

54

1 Place your original face-down, right aligned along the original guide. Keep the

legend at your right hand side.
Note: When you feed the original, keep it in place until it is transported
(about 1 cm) into the machine.

[13] Inserting the original
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2 Specify the number of copies using the numeric keys.

3 Specify the ‘Paper series’ on the ‘Sheet’ card in the ‘Original’ section.
Note: The Océ TDS600 supports both DIN and ANSI media formats.

4 Specify the desired media on the operator panel.
If you select ‘Automatic’, the Océ TDS600 will use a zoom factor that is
needed to obtain a copy without loss of information. After inserting the
original, the zoom factor that is used is indicated by the ‘O’ symbol.
Note: The zoom factor is based on the selected media size
Use the ‘Media’ function to select copy material and format.

5 Specify how a job will be sorted: ‘Single sheet’, ‘Multiple sheets’ (output: 1-1,
2-2, 3-3) or ‘Set’(output: 1-2-3, 1-2-3).
The currently selected input mode is indicated by the ‘I’ symbol.

6 Specify a reduction or enlargement factor on the operator panel by using the
‘Zoom’ function.
If you select ‘Automatic’, the Océ TDS600 scanner will use a zoom factor that
is needed to obtain a copy without loss of information. After inserting the
original, the zoom factor that is used is indicated by the ‘m’ symbol.
Note: The zoom factor is based on the selected media size.

7 Specify the desired brightness on the operator panel.
You can use the ‘Brightness’ setting to correct for a lighter or darker original.

8 Specify folding options on the operator panel.
If the optional folder is installed, you can use the ‘Folding’ settings to get a
neatly folded copy.

9 Press the green start key > to start the copy job.
Your original is fed into the scanner. The printer starts.

10 Collect your output.

Your copy will be delivered on the selected output unit of the print engine.

Select the required media

The ‘Media’ setting can be used to select output material and format. The
display will show you what rolls or sheet feeders are currently loaded. The
currently selected roll or sheet feeder is indicated by the ‘I’ symbol.

If you select ‘Automatic’, the Océ TDS600 scanner will try to use a roll or
sheet feeder format that matches the original size. After inserting the original,
the roll or sheet feeder that is used is indicated by the ‘m’ symbol.
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Note: The ‘®° symbol remains in place until a new original is inserted. Then it
may move to indicate another roll or sheet feeder, depending on the original
format.

First select the paper series, then select the media size.
Note: The zoom factor is based on the selected media size.

Select the paper series

1 Select the ‘Sheet’ card in the ‘Original’ section
2 Select the required paper series with the ‘Paper series’ function key

Ansirmixed Le ading:

Scanner i Ansismall o . 35.0"

DIN Carto ili Mon standard
[ ] Standard

u}
Soen Vit

[14] Select the required paper series

Select the required media

1 Select the ‘Sheet’ card in the ‘Print’ section.
2 Select the required media with the ‘Media’ function key.

Custom

@1 A0 Paper !
P @s AZ Paper !

A1 Paper |
A1 Paper ! H
12"Transp. ! an : Standard

Autormnatic f.fo f.Sgnc:hro

_ ranuel feed cuttenath

[15] Select the required media

11 A3 Transp.!

Note: You can also select the desired media from the ‘Custom’ section, if this
setting is defined for the ‘Custom’ section in the Océ Settings Editor (see
Figure 15 on page 56).
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Select the input mode

You can use the ‘Input mode’ setting to specify how a job will be sorted: the
‘Single sheet’ option treats each sheet as a separate job. ‘Multiple sheets’
produces the specified number of copies for each sheet in a job and then
continues with the next sheet. Graphically that would look something like this:

You can use the ‘Input mode’ setting to specify how a job will be sorted: the
‘Single sheet’ option treats each sheet as a separate job. ‘Multiple sheets’
produces the specified number of copies for each sheet in a job and then
continues with the next sheet. Graphically this looks as follows:

(0]

[16] The principle of ‘Multiple sheets’

‘Set’ produces one copy for each sheet in a set and then continues with the next
copy of the entire set, as follows:

[17] The principle of set copy

See ‘Make a set copy’ on page 110.
The current input mode can be closed by pressing the Stop key.
The currently selected input mode is indicated by the ‘®’ symbol.

v Select the input mode
1 Select the ‘Feeding’ card in the ‘Original” section.
2 Select the desired media with the ‘Input mode’ function key.
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[18] Selecting the input mode

Note: You can also select the input mode from the ‘Custom’ section (if this
setting has been defined for this).

Select the zoom factor

58

You can use the ‘Zoom’ setting to select a zoom factor.

Select the zoom factor

1 Select the ‘Image’ card in the ‘Print’ section.

2 Select Automatic, 1:1, or set the zoom factor on the display of the operator
panel

= Automatic zoom selection: the system automatically calculates the zoom
ratio based on the original size and the output media size

m 1:1: Results in an image that is exactly the same size as the original.

m Set the zoom factor on the display of the operator panel:
Use the Arrow keys on the right of the display (see Figure 8 on page 45). If
you press one of the vertical keys, the zoom factor will increase or decrease
with steps of 0.1%. If you press one of the horizontal keys, the zoom factor
will increase or decrease with the steps predefined in the Settings Editor by
the key operator (see ‘Find system settings in the Settings Editor’ on
page 137).
Use the numeric keys at the bottom of the operator panel. You can specify
the exact zoom factor with 0.1% increments.
For example, if you want to specify a zoom factor of 25.4%, you type 254. If
you want to specify a zoom factor of 254%, you type 2540.

Selecting the zoom factor

1 Select the ‘Image’ card in the ‘Copy’ section.
2 Select the desired media with the ‘“Zoom’ function key.
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Finighing

[19] Selecting the zoom factor

Note: You can also select the zoom factor from the ‘Custom’ section (if this
setting has been defined for this).

Select the exposure

You can use the ‘Exposure’ setting to correct for a lighter or darker original.

v Selecting the exposure setting

1 Select the ‘Image’ card in the ‘Original’ section.
2 Select the desired exposure level by using the Arrow keys to the right of the
display (see Figure 8 on page 45).

Readytocopy B HUULL

i Lighter

.Llnes /text Automatic Darlier

X Original type Background Exposure
Feading compensation

[20] Selecting the exposure level

Note: You can also select the exposure level from the ‘Custom’ section (if this
setting has been defined for this).
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Background compensation

You can use the ‘Background compensation’ function with dark originals.
Select ‘Background compensation’ on, to get all information correct on the
copy. A gray background is visible.

If you select ‘Background compensation’ off, there is no gray background, but
weak lines will be affected.

Deliver originals after scanning

You can choose for delivery of the original at the front (rewind) or the rear side
of the scanner.

Attention: The ‘Rewind’ function is disabled when the optional original
delivery tray is installed.

Note: When you copy thick or very thin originals, originals that are damaged
or originals in a carrier sheet, it is recommended to use the output at the rear
side of the scanner to ensure correct delivery (‘Rewind’ function off).

v Select original delivery
1 Open the ‘Scanner’ card in the ‘Original’ section.
2 Press the ‘Rewind original’ function key to make your selection:
m ‘On’: Originals are delivered at the front side of the scanner. You have to
collect each original by hand.
m ‘Off’: Originals are delivered at the rear side of the scanner.

Custom
Original

Mederlands

English

Automatic feed Rewind original Language 7
Taal

[21] Using the Rewind original function to select original delivery at the front or the rear
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Define settings for the next original

You can define the settings for each original you want to copy. When
‘Automatic feed’ is enabled, you should bear in mind that the original is
automatically pulled into the scanner. If you want to be absolutely sure about
the settings that belong to an original, insert an original when the settings are
correct.

Note: To increase your versatility at the scanner input side, you can ask your
key operator to turn off Automatic feed. When using the scanner with
automatic feed off, you must press the start key for each new original to be
scanned. This offers you the possibility to change the settings for the next
original, even if you already put the original in place on the scanner feed table.

v Define settings for the next copy job
1 Select all settings required for the next original.
2 Insert the next original.
If ‘Automatic feed’ is off, press the start key.
If ‘Automatic feed’ is on, the original is fed automatically.
Note: You can enable or disable this function from the ‘Scanner’ card in the
‘Original’ section. See figure 13 on page 54.

Account logging

For accounting purposes, the system is able to log job information for each job.
The job identification attributes and the number of print jobs are logged in the
account file. For more information on account logging (see ‘Maintenance’ on
page 191)

Note: The account settings are only available if the accounting option is
enabled in the system configuration.
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[22] Accounting function option

Aecount 1D:

Irnage

v To select accounting
1 Open the ‘Scanner’ card in the ‘Original’ section.
2 Press the ‘Accounting’ function key to set ‘Accounting’.
3 Select the needed ‘Account id’ or ‘User id” with the Arrow keys to the right of
the display.
4 Enter the ‘Account ID’ or the ‘User ID’ with the numeric keys.

Using the manual feed for copying

If you want to copy a job on a media type or size that is not available on one of
the paper rolls or sheet feeders, it can be convenient to manually feed sheets
instead of switching paper rolls or sheet feeders. The sheet feed is a special slot
just above the roll drawers on the engine. You can insert pre-cut copy material
in this slot, one sheet at a time.

Note: Only use media as specified in ‘List of available material types and sizes’
on page 252.

v Copying on pre-cut sheets
1 Open the ‘Sheet’ card in the ‘Print’ section.
2 Press the ‘Manual feed’ key. The display will look as follows:
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[23] Using the manual feed option

Select any required other settings.

Enter the number of copies using the numeric keys.

Feed the original.

Press the start key.

Take your sheet of copy material to the side of the printer engine that contains
the sheet feed.

Use both hands to align the copy material in accordance with the format
indication and the sticker on the manual feed table.

Move the copy material forward in the nip of the roller. This must cause an
ample paper bulge over the full width of the page.

Hold the paper with both hands until the engine pulls in the first part of the
sheet.

The bulge will be reduced or it will disappear. A few seconds later the complete
sheet will be pulled in the printer.

Note: If the copy job requires more sheets, the display will ask you to feed
the next sheet.

Repeat steps 7 to 11 to complete the job.

Collect your output.

Note: The image will be printed on the side of the sheet which is facing up.
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Define delivery of copies

Normally, your copies are delivered on the integrated receiving tray on top of
the Océ TDS600 Printer. However, you can specify to deliver your copies on
the optional output delivery tray or on a folder. If you want to use your output
delivery tray, you take the following steps.

v Deliver copies on the output delivery tray
1 Open the ‘Finishing’ card in the ‘Print’ section.
2 Use the ‘Copy delivery’ function key to select the ‘Output delivery tray’
option.

Original

Length:

Imnage

os"

i First fold only i
P FUM i Belt
.Stacl(er

Folding Folded copy Folded package Binding
delivery

[24] Delivering copies on the output delivery tray

Reinforce

Layout

Interrupt a job

Press the Job interrupt key on the scanner panel to give extra priority to a copy
job. When you press the Job interrupt key your copy job will be placed on top
of the printing queue. When you select Job interrupt a message appears on the
scanner panel display (see ‘Feedback on the scanner panel display when Job
interrupt is selected.” on page 64).

Original

Multiple sheets
1:1 Set

Autornatic #®5ingle sheet
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[25] Feedback on the scanner panel display when Job interrupt is selected.

The print process will be interrupted after the current page is printed. The
transport of originals on the scanner will not be interrupted.

How to interrupt a copy job

Press the Job interrupt key on the Scanner operator panel.

The printer interrupts the active job and stops after the current page is printed.
The Océ Queue Manager displays the interrupt job in the print queue at the
active job position .

The Océ Queue Manager displays the interrupted job with the icon &

The Océ Queue Manager displays the interrupt job with the icon & .

The Océ Queue Manager changes the exit interrupt button from gray into
colored and changes this button into the active condition.

Make copies (see page 54).

Press the Job interrupt key again to do another interrupt job.

Press the Exit interrupt button at the Océ Queue Manager to continue with the
interrupted job and collect the output at a later time.

Collect the output and press the Exit interrupt button at the Océ Queue
Manager to continue with the interrupted job.

Note: An interrupt job can not interrupt another interrupt job.

Managing of interrupt jobs in the Océ Queue Manager

There can be several new jobs in the queue during Job interrupt. They are
put in a First In First Out sequence. In the Océ Queue Manager you can
manage interrupt jobs in following way:

m An interrupt job can be canceled in Océ Queue Manager.

m An interrupt job can be put on hold. An interrupt job will lose its priority
position in the queue when put on hold.

= When there are more interrupt jobs, an interrupt job can be moved to the top
of the printing queue.
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Stop a job

Press the Stop key to interrupt the original transport on the scanner.

How to stop a job

Press the Stop key.

The original transport is now stopped and you are prompted to open the
scanner cover in order to remove the original.

Open the cover, remove the original and close the cover again. You are now
ready to start the next copy job.

Stamping
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Stamping is an Océ TDS600 option which allows you to print a predefined text
on all your copies. Enable stamping with a password in the Océ Setting Editor.
The key operator can predefine a maximum of 50 stamps in the Océ Settings
Editor (see ‘Find system settings in the Settings Editor’ on page 137).

You can select one stamp per original and you can select a colour, font size or
position. A stamp can consist of the following parts:

m predefined text
m date
m time

How to select a stamp

Open the ‘Stamping’ card in the ‘Print’ section.
Select stamp ‘On’ with the ‘Enable’ function key.
Select a stamp with the ‘Select stamp’ function key.

Note: the following steps are optional.
Select a ‘Colour’ with the ‘Format stamp’ function key and the arrow keys.

Select a ‘Size’ with the ‘Format stamp’ function key and the arrow keys.
Select a position with the ‘Stamp position’ function key and the arrow keys.
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Océ TDS600

User Manual

Chapter 4
Using the Océ TDS600 to
Scan-to-file

This chapter describes the scan-to-file function of the Océ
TDS600. This chapter contains a description of the
interface of the Océ TDS600 scanner, and of the Océ Scan
Manager and Océ View Station LT applications on the
local controller
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Before you begin

You must switch on both the Océ TDS600 printer and the Océ Power Logic®
Controller before you can scan-to-file. See ‘Turn on and off the Océ TDS600’
on page 23.
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Scanner operator panel

For a description of the scanner operator panel and how to perform actions on
the scanner operator panel, see the chapter, ‘Scanner operator panel’ on
page 45.
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Océ Scan Logice

Océ Scan Logic® is an option which enables you to scan a document to a file
for later use. You enable scan-to-file with a password in the Océ Settings Editor
(see ‘Find system settings in the Settings Editor’ on page 137).

You use scan to file in order to:

m print documents at a later time

m archive documents

m email documents

m reuse the information documents contain in another application

A scan-to-file is made at the Océ TDS600 scanner. On the scanner operator
panel you can, among other things, choose at which resolution you want to
scan and where you want to store your file.

The result of the scan to file can be stored on the controller (temporary store)
or directed forward towards a network destination via Windows® Network
neighborhood.

Océ View Station LT, linked to the Océ Scan Manager application, enables you
to automatically or manually view the scanned documents afterwards.

Scan clicks

70

The Océ TDS600 counts the area of media that you scanned during scan to file
operations. You view the scan click count in the bottom right corner of the Océ
Scan Manager (see Figure 26 on page 71).

The scan click count is measured in square feet or square meters. You set the
measurement unit in the Océ Settings Editor (see Chapter , ‘Measurement’ on
page 95).
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[26] Scan click count in the Océ Scan Manager
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Making a scan-to-file

72

Perform the following steps to scan an original to file:

How to scan-to-file
1 Place your original face-down, aligned to the right along the original guide.
2 Select the appropriate original type.
3 Select the ‘Destination’ card in the ‘File’ section.

eady to scantofite @2 @ @

Original

dest. 1 ® TIFF

Destination File type TIFF
subformat

[27] ‘Destination’ card in the file section

4 Press the section key ‘File’, to select ‘File mode’ On.
The status message displays: Ready to scan-to-file.
5 Select a Destination (see ‘Destinations’ on page 82).
6 Press the start key <.
The original is scanned.
A status message displays (see Figure 28 on page 72):
“Scanning job “Scan job number X
“File scan22.tif”

Scanning job “Scan job™ BB om0,

Original

Cornpression:

dest. 1 ®TIFF

Destination File type TIFF
subformat

[28] Feedback during scan-to-file

7 When enabled in the view menu in the Océ Scan Manager, Océ View Station
LT starts automatically on the controller, showing the result of the scan (see
Figure 29).

Océ TDS600 User Manual



& Océ View Station LT M=

FEile  View Preference Help

M@a®e] olne[n] SN

& CAocelngetzc ankzpooler Satellit cal =l

Coard: |[D,D] wiging

[29] Océ View Station LT
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Settings for scan-to-file

The settings for scan-to-file on the scanner operator panel are divided into two
cards: Destination and Image.

Destination card:

m Destination

m File type

m TIFF subformat or PDF compression

Custom

Destination File type TIFF
subformat

[30] Scanner operator panel: Destination card

Image card:
= Resolution

m Zoom
= Optimization
= Mirror

Ready to scan to file

200 dpi
300 dpi i1t
400 dpi ® sutomnatic ®3can quality [ Tilig

optimisation

[31] Scanner operator panel: Image card

i File size an
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File mode

File mode can be ‘Off’, ‘On’ or ‘On with check print’. ‘Off” means scan to file
is not active. ‘On’ means scan to file is active. To scan to file with a check print,
activate both the file mode and the print mode on the scanner operator panel.
The check print quality is the same as the scan resolution. A check print is a
print of the scanned original, ensuring consistency with a later print of the
scanned file.

v How to scan-to-file with check print
1 Press the section key above the File section two times
The File mode is enabled
2 Press the section key above the Print section two times
The Print mode is enabled
3 The system is now ready to scan to file with check print.

Note: The Océ TDS600 system does not allow you to change the ‘File mode’
setting during a set from ‘On’ to ‘Off " and the other way round. However
changing from ‘On’ to ‘On with check print’ and vice versa is allowed.

Note: In scan to-file-mode, the automatic behavior is optimized for scanning.
Turning check print on or off does not influence this automatic behavior.

Destination

You can store your scan either in the temporary store on the controller or on a
network destination. You can define up to ten destinations in the Océ Scan
Manager application. On the scanner operator panel you can choose one of
these destinations.

v Select a destination
1 Press the function key to select destination 1 until 4.
2 To select destination four till ten, initially you have the select destination four.
Press the arrow keys to select destination 4 until 10.

Note: The names of the destinations can be any. However, for your
convenience, you are able to define understandable names in the Océ Scan
Manager application (see ‘Create a local destination’ on page 82).
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File type

To define the internal organization of the scanned files, choose between TIFF
(Tagged Image File Format), CALS-I (Continuous Acquisition and Life-Cycle
support), and Adobe® PDF (Portable Document Format).

TIFF describes image data that typically comes from scanners, frame grabbers,
and paint- and photo-retouching programs. The purpose of TIFF is to describe
and store raster image data. A primary goal of TIFF is to provide a rich
environment within which applications can exchange image data. This
richness is required to take advantage of the varying capabilities of scanners
and other imaging devices. For example, TIFF supports lossless image
compression. Though TIFF is a rich format, it can easily be used for simple
scanners and applications as well because the number of required fields is
small.

CALS is an industry strategy for transition of paper-intensive processes to
highly automated, integrated processes for defense system acquisition, design,
manufacturing, and life cycle support.

PDF Portable Document Format (Adobe® Postscript® 3™ /PDF) is a file
format that has captured all the elements of a printed document as an electronic
image that you can view, navigate, print or forward.

Tiff subformat

76

Within the “Tiff subformat’ option, you can define the ‘Organization’ and
‘Compression’ of the file.

Organization can be (select with the arrow keys):
m Striped

m Tiled

= Raw

Note: Only choose ‘Striped’ or ‘Tiled’ when you are sure you can use these
organizations afterwards. Choose ‘Raw’ in any other case.

Compression can be (select with the arrow keys):
m Group 4

= Group 3

= None
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Note: Only choose ‘Group 4’ or ‘Group 3’ when you are sure you can use these
compressions afterwards. Choose ‘None’ in any other case.

Note: If you scan grayscales or dark originals then use Group 3 compression.
In these cases group 4 can increase the file size.

Note: ‘Group 4’ or ‘Group 3’ are compression methods which are optimised
for text and vector drawings. If you choose these compressions when scanning
a photo with many grayscales these compressions can result in a negative
compression: the file size increases instead of decreases. So use these
compressions with care.

PDF compression

Within the ‘PDF compression’ option, you can define the ‘Compression’ of the
file.

Compression can be (select with the arrow keys):
u Group 4
m None

Note: Only choose ‘Group 4’ when you are sure you can use this compression
afterwards. Choose ‘None’ in any other case.

Resolution

The Océ TDS600 scan to file option allows you to scan at the following three
resolutions:

m 200 dots per inch (dpi)
= 300 dpi
= 400 dpi

The higher the resolution the better the image quality. Higher resolution also
leads to larger file sizes. The default value is 200 dpi.
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Zoom

The ‘Zoom’ option allows you to scale while scanning to a file. When you set
‘File mode’ to ‘On’ then the automatic “Zoom’ setting will resultin ‘1:1°. You
can change this default setting into one of the following three settings:

Custom This option let’s you specify a custom zoom value. You can enter a
range from 25% through 400%. This value also shows the zoom value when
the option ‘Automatic’ is chosen.

1:1 With this option selected, scan to file will result in an image that is exactly
the same size as the original. ‘Zoom’ displays 100%.

Automatic Selecting ‘Automatic’ always results in a 1:1 scan to file.

Optimisation

There are two ways to optimise a scan-to-file.

Scan quality Optimises for the best image quality. The scan resembles the
original as close as possible.

File size optimises for better compression. Generally resulting in a smaller file
size.

Mirror

78

You can use the ‘Mirror’ option to scan a horizontally mirrored image of an
original. Mirroring is performed in the vertical axis.
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Océ Scan Manager

The Océ Scan Manager is an application available only locally on the
controller. With the Océ Scan Manager you can configure the destinations for
scan to file. To increase your productivity you can define automatic file
naming. This way you can do batch scans without operating the controller.

During scan to file, Océ Scan Manager displays the filename and the status of
the file generation process. When the scan is completed a view of the scanned
image is automatically displayed on the controller.

Figure 32 on page 79 shows the Océ Scan Manager application.The left part
displays a tree view containing folders containing destinations. The right part
displays a table view containing the content of the folder currently selected. In
32 on page 79 folder ‘On Controller’ is selected.

= Dcé Scan Manager 1 =]
File Edit “iew System Help
(=) X [a L] -y
I ey Delete  Properies  View Refresh il
E-E Destinations || Hame | size | Type | Modified | Resoltion ... | Image size .|
; m scandl. . 97 Kb TIFF-file 13M2/001... 200200 296 1800
m scand3... 26.8 Kb TIFF-file 13M 200 1... 400 :x 400 297 1800
m scandl. . 266 Kb TIFF-file 13M2/001... 400 400 297 1800
m scanld. . 271 Kb TIFF-file 13M 200 1... 400 :x 400 297 1800
m scantd. . 11.7 Kb TIFF-file 13M2/001... 200200 420 1800
m scanld. . 9.4 Kb TIFF-file 13M2001... 200 :x 200 2791800
...... @ Unzent
------ _4 Temporary stare
== | localhost | | Counter: 118 | Anomymous | 2

[32] Overview of the Océ TDS600 Scan Manager application
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Note: Not all options are available to all users. You must log onto a particular
user mode to perform specific tasks with Océ TDS600 Scan Manager (see
‘User modes’ on page 163).

Tree view

The tree view displays:

m the system name

m the collapsible destination tree

m the collapsible temporary store tree.

If you scan to a particular destination, that destination is displayed bold, when
not selected. When not selected the destination you scanned last to, is
displayed bold.

If you select a destination, to view it’s content in the right table view, this
destination will show selected.

If for any reason a scan to file cannot be sent to the appropriate remote
destination, the file will be stored in the ‘Unsent’ folder.

Table view
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The table view (on the right side of figure 32 on page 79) displays the
filenames of the files in the opened destination or temporary folder.

Each file has the following information:
= Name

m Size

= Type

m Modified

= Resolution

m Image size.

If the currently viewed destination is the one you are scanning to, then the
scanned file will appear at the end of the table. If you currently view another
destination than the one you are scanning to, then the scanned to destination is
displayed bold.
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It is possible that there are more files in the table than fit on screen. The most
recent scanned file appear at the end of the table. Under these circumstances it
is possible that your most recent scanned file is not visible in the table on
screen. In this case you can update the table view.

Update the table view

From the ‘View’ menu select ‘Refresh’ or click the ‘Refresh’ button on the
toolbar (see Figure 33). If the opened destination is also the one which is
currently scanned to, then the view is automatically updated.

B

Refresh
[33] ‘Refresh’ button on the toolbar
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Actions from the Océ Scan Manager

The Océ TDS600 Océ Scan Manager enables you to make settings regarding
scan to file. You can edit and view the destination properties. You can also view
the properties of scanned files.

Destinations

A destination is a place where you scan your file to. You can create, delete and
lock destinations. You can also define automatic file naming to ensure your
files get the desired names.

A destination can also be a file server or a PC of an end user. It is better to select
remote destinations instead of the local ones. The local destinations are
temporary and cannot contain a lot of scan files.

v Create a local destination
1 Select ‘Destinations’ in the tree view.
2 Open the ‘File’ menu and select ‘New’ or click on the ‘New’ button on the
toolbar (see Figure 34).
=

e

[34] ‘New’ button on the toolbar

Destination propetties x|
|: I™ Locked

MName. Jrew Dest (2)
Destination

Type [on contralier <] Encosing
Systetn Jrizan0-pet « asais
O shift Jis

User name
Passward
Path FSSCAN - Browse:

File naming
Berse hane pESTZRRE

[V Add the appropriate file extension

Start value for ## 1
Ok Cancel Apply

[35] ‘Destination properties’ window
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Enter a logical name for the destination in the ‘Name’ text box.

This logical name also appears on the scanner panel (see Figure 27 on

page 72).

Select the ‘On the controller’ type from the ‘Type’ drop-down list box.
Enter a path of the target folder in the ‘Path’ text box. You can also click the
‘Browse’ button to select the path.

Note: This is only possible if you select ‘On the controller’ as ‘Type’ (see
step 4).

Click Ok to accept the destination properties.

Create a network destination with SMB

Create a shared folder on a workstation. For example c:\Scan

On the Océ Scan Manager Open the ‘File’ menu and select ‘New’ or click on
the ‘New’ button on the toolbar (see Figure 34).

The Destination Properties dialog box appears (see Figure 35)

Select SMB from the “Type’ drop-down list box.

Enter the system name of the workstation where you created the shared folder.
Note: Find the system name of the workstation on the control panel of the
workstation (Control panel - Network - Identification - System name)
Enter the path name. This is the name of the shared folder on your workstation.
For Windows NT®, Windows® 2000 and XP, use the DOS name of the shared
folder.

For Windows 95/98® use the folder name. This is case sensitive.

Note: You can not Browse. Instead of entering the path name by hand, you
can use the drop-down list box to select a shared folder available on the
selected system.

If you have set a username and a password for the shared folder on the
workstation, then enter the username and the password in the required fields.
Set the required file naming properties

Click OK

Océ Scan Manager connects to the new SMB destination. Océ Scan Manager
then shows the contents of the new SMB destination.

Create a web destination with FTP

Create a home directory and a subdirectory on a workstation. For example
c:Ftp/Scan

Enable FTP on the workstation

On the Océ Scan Manager Open the ‘File’ menu and select ‘New’ or click on
the ‘New’ button on the toolbar (see Figure 34).

The Destination Properties dialog box appears (see Figure 35)

Select FTP from the ‘Type’ drop-down list box.
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Enter the system name of the workstation where you created the shared folder.
Find the system name of the workstation on the control panel of the
workstation (Control panel - Network - Identification - System name)
Enter the path name. This is the name of the shared folder on your workstation.
For Windows NT®, Windows® 2000 and XP, use the DOS name of the shared
folder.

For Windows 95/98® use the folder name. This is case sensitive.

Note: You can not Browse.

For access to the directory on the workstation through FTP, a user name and
password is set on the FTP server that runs on the workstation. Enter this user
name and this password in the required fields on the Destination Properties
dialog box of the Océ Scan Manager.

Set the required file naming properties

Click OK

Océ Scan Manager connects to the new FTP destination. Océ Scan Manager
then shows the contents of the new FTP destination.

Note: You can create a maximum number of 10 destinations.

Note: Names in Japanese can only be entered for remote destinations in
SMB.

A key operator can determine whether a destination can be modified by an
anonymous user. This done by locking and unlocking a destination.

Lock a destination

Select a destination.

Open the ‘File’ menu and select ‘Properties’.

Check the ‘Locked’ check box.

Click Ok to accept the destination settings.

The destination properties are now locked.

Note: This option is only available if you are logged on as a Key operator (see
‘User modes’ on page 163).

Unlock a destination

Select a destination.

Open the ‘File’ menu and select ‘Properties’.

Uncheck the ‘Locked’ check box.

Click OK to accept the destination settings.

The destination properties are now unlocked.

Note: This option is only available if you are logged on as a Key operator
(see ‘User modes’ on page 163).

Océ TDS600 User Manual



v Delete a destination
1 Select a destination.
2 Open the ‘File’ menu and select ‘Delete’ or click the ‘Delete’ button on the
toolbar (see Figure 36).

X

Delete

[36] ‘Delete’ button on the toolbar

The selected destination is deleted.
Note: This option is only available if you are logged on as a Key operator or
as a Repro operator.

Note: You are not able to delete the last destination.

Define file names

You can define the file names in the following two methods.

1 by automatic file number definition for all originals in the scan-to-file job
2 by manual file name definition per original in the scan-to-file job.

v Automatic file number definition

1 Select a destination.

2 Open the ‘File’ menu and select ‘Properties’.
The ‘Destination properties’ screen appears (see Figure 35 on page 82).

3 Enter a name in the ‘Base name’ text box.
Do not change the ‘###’ part, this part is used for automatic file name
numbering. Océ Scan Logic replaces ‘###’ by an ascending number. You can
put dots in the ‘Base name’.

4 Select or clear the check box ‘Add correct file extension’ to add or leave out
the file extension. Set the file extension in the Océ Settings Editor.

5 Enter the start value for the automatic file naming in the ‘Start value for ###
field.

6 Click ‘OK’ to accept the destination properties.

7 Scan the originals.
You can scan now with automatic file name numbering. Select the above
destination on the scanner operator panel and set all scan-to-file properties.
While you scan, the scanner operator panel displays the file name. The settings
are active until a copy job interrupts the scan job.
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Manual file name definition

Select a destination.

Open the ‘File’ menu and select ‘Properties’.

The ‘Destination properties’ screen appears (see Figure 35 on page 82).
Select or clear the check box ‘Add correct file extension’ to add or leave out
the file extension. Set the file extension in the Océ Settings Editor.

Enter a name in the ‘Base name’ text box.

Remove the ‘### part, this part is used for automatic file naming. You can put
dots in the ‘Base name’.

Click ‘Apply’ to accept the destination properties.

The ‘Destination properties’ screen stays open and is ready for the next
scan-to-file action after the current original is scanned.

Scan the original.

Repeat step 4, 5 and 6 for each original.

Scanned files

86

The right pane of the Océ TDS600 Scan Manager contains the scanned files
and additional information about the files. You can view, print and delete these
files. You can also view the file properties.

View a scanned file

Select a file in the right pane.

Open the ‘File’ menu and select ‘View’ or click the ‘View’ button on the
toolbar (see Figure 37).

&

Wiew
[37] ‘View’ button on the toolbar

Océ View Station LT (see ‘Océ View Station LT®’ on page 93) starts up and
displays the file.

Note: When you scan to file the controller Océ View Station LT starts
automatically, showing the result of the scan.

Print a scanned file

Select a file in the right pane.
Open the ‘File’ menu and select ‘Print’ or click the ‘Print’ button on the toolbar
(see Figure 38).
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Print
[38] ‘Print’ button on the toolbar

The selected file will be printed with the default settings as defined in the Océ
Settings Editor.

Delete a scanned file

Select a file in the right pane.
Open the ‘File’ menu and select ‘Delete’ or click the ‘Delete’ button on the
toolbar (see Figure 39).

X

Delete
[39] ‘Delete’ button on the toolbar.

The selected file will be deleted.
Note: This option is only available if you are logged on as a Key operator
or as a Repro operator.

View properties of a scanned file
Select a file in the right pane.
Open the ‘File’ menu and select ‘Properties’ or click the ‘Properties’ button on
the toolbar (see Figure 40).
Proies
[40] ‘Properties’ button on the toolbar.

The following window appears (see ‘“Scanfile properties’ window’ on
page 88):
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& Scanfile properties

@

Mame
— Scanfile
File type Tiff Groupd Raw
Wanted lacatian WTG19-MADRIDITSSCAN
Final lacation WTG19-MADRIDITS S CAN
File size 161186
File modified 2000/02M1212:0316
—Image
Image size 841 x 1208
Resolution 200 x 200

Ok Cancel

[41] ‘Scanfile properties’ window

3 Click Ok to close the ‘Scanfile properties’ window.

Automatically view a file after scanning
You can choose to view a file automatically after scanning:
1 Open the ‘System’ menu and select ‘Auto view’.
When you scan to file, Océ View Station LT will start automatically and show
the scanned file.
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Manage the temporary store

When you regularly scan originals to a file, many files are created in the
temporary store. You can clean up the temporary store manually or
automatically.

To manually delete the files in the temporary store select the ‘Purge’ command
from the ‘System’ menu.

To automatically delete the scanned files from the temporary store, you must
make some settings in the Océ TDS600 Settings Editor (see ‘Find system
settings in the Settings Editor’ on page 137).
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How to retrieve scanned files

The scanned files are stored in the logging directory of the controller. You can
retrieve your files from the local host via File Transfer Protocol (FTP). FTP can
be done:

1 via an internet browser

2 an FTP application, or

3 via a command line prompt.

When you scan to file, your files will be stored in the destination you set. This
can be on the local controller or on a remote system. You can retrieve your files
from the local host via File Transfer Protocol (FTP) (see Figure 42). Also if
during scanning to a remote destination, something goes wrong, you can
retrieve your files from the local host.

L)
Get files via FTP i@wﬂ"ﬂ?‘;é\

O
[l —
\\.\E
mlll
i

V1

=
E" Remote client
[—
Get files via FTP H-
Océ Power Logic® Controller e
A==
E——Y

Remote client

[42] How to retrieve scan files
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Favoribes  Tools  Help |

Qsearch [4Folders  AHistory ||E X w | -

J Eile
J = Ecck v =y

JAgdress I@ ftp: /i | j P Gn H Links
MName # | Size | Type | Modified |

=] accounting File Folder 23-11-2000 7:00

[ File Folder 1-1-1980 1:00

Dtempstore File Falder 1-1-1980 1:00

| User: Anonymaus {28 Local intranst A

[43] The tempstore directory with the scanned files on the Océ TDS600 system

Retrieve files via an FTP command line prompt

Launch an FTP client.

Enter the ‘ftp’ command.

A DOS box now appears with the FTP prompt.

Enter the ‘Open’ command followed by either the registered name of the Océ
Power Logic® Controller or the IP address (for example: 194.2.66.146) to
connect to the Controller and press Enter: ‘open 194.2.66.146’.

Note: Instead of performing steps 2 and 3 you could also enter “ftp
host_name” in the FTP client.

The connection with the Controller is now established and a window appears
asking you for a user name.

Enter your user name ‘anonymous’, and enter as your password also
‘anonymous’.

A connection is now set up for the default user ‘anonymous’.

Note: As there is no registered user, you can simply press Enter to initiate
the connection.
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(=]

Set the transmission mode to binary by entering ‘binary’.

Go to the ‘tempstore’ directory using the following command: ‘cd tempstore\’.
Go to the ‘scan’ directory if you want to retrieve a file from a destination on
the local host,

or

go to the ‘unsent’ directory if you want to retrieve a file from ‘unsent’ folder
on the local host.

Get the data file (for example: bugatti.tif) via the ‘get’ command:

‘get bugatti.tif”.

Quit FTP by entering the ‘bye’ command.
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Océ View Station LT®

With Océ View Station LT you can view your scanned files. This can be
automatically (see ‘Automatically view a file after scanning’ on page 88) after
scanning or via Océ Scan Manager (see ‘Print a scanned file’ on page 86).

Océ View Station LT has the following menu’s (see Figure 44):
= File

m View

m Preference

m Help

& Océ View Station LT M=

HE el o[len] SN

& C:\ocelnge\ze an\zpoolertSatellit cal =]

Coard: |[D,D] wigwing

[44] Océ View Station LT

Note: You can view earlier scanned files, if they are scanned to the Océ Power
Logic® Controller. You can not view scans that are sent to remote destinations,
when the next scan is made.
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Menu options
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File menu

Command What does it do?

Close Closes the active document.

Properties Provides technical information about, and allows you to change
certain properties of, the document.

View menu

Command What does it do?

Fit Scales the image to fill the window.

1:1 Displays the image at a 1:1 scale factor.

Magnify Zooms into the page.

Reduce Zooms out of the page.

Refresh Redraws all windows displaying the active document.

Invert Reverses the black and white parts of the image.

Mirror Mirrors the image.

Rotate 90 CCW | Rotates the image 90 degrees counter-clockwise.

Rotate 90 CW Rotates the image 90 degrees clockwise.

Rotate 180 Rotates the image 180 degrees.

Sample When active, displays only a sample of bilevel raster pixels.

Negate Reverses the raster image pixels on display and changes which are

dominant for scaling.

Scale to gray

When active, displays the active bilevel raster image as though it
were a greyscale image.

Monochrome

An image or screen having only background and foreground
colors. Same as black-and-white or bilevel.
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Preference menu

Command

What does it do?

View ribbon

View Ribbon displays and removes the ribbon that contains
buttons. The View Ribbon appears, by default, below the menu bar.
It serves as a fast means of selecting some File, View, and
Preference menu commands.

Status bar Status Bar displays and removes the Status Bar at the bottom of the
Océ View Station LT window. The Status Bar displays the pointer
co-ordinates and a status line.

Reference Reference displays or removes a small, usually floating window.
This window displays the entire current page in miniature. The
crossed box inside the Reference window indicates which part of
the page is displayed in the document window.

By moving or resizing the crossed box, you change which area of
the page is displayed.

Detail Displays or removes the Detail window.

Measurement When active, allows you to measure lines and areas on the image.

Help menu

Command What does it do?

About Shows information about Océ View Station LT.

Note: You can retrieve help about Océ View Station LT via Océ Scan Manager.

Function buttons

A WON =

Below the menu’s there are function buttons in a ribbon. This ribbon can be
turned on and off (see ‘View ribbon’ on page 95).

H e@®Q onr|n $X|N|

[45] Function buttons in Océ View Station LT

Figure 45 displays the buttons:

Invert: Reverses the black and white parts of the image.
Fit: Scales the image to fill the window.

1:1: Displays the image at a 1:1 scale factor.

Magnify: Zooms into the page.
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Reduce: Zooms out of the page.

Mirror: Mirrors the image.

Rotate 90 CCW: Rotates the image 90 degrees counter-clockwise.

Rotate 90 CW: Rotates the image 90 degrees clockwise.

Rotate 180: Rotates the image 180 degrees.

Measurement When active, allows you to measure lines and areas on the
image.

Reference. This small floating window displays the entire current page in
miniature for reference.

Displays or removes the Detail window.

View error

96

When the memory is almost full it can occur that the viewer does not show the
scanned file. Instead it shows a red border with a red cross (see Figure 46).

F Emor (bmp) M= E3
=l
[
Kl || ol

[46] Error view in Océ View Station LT
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Chapter 5
Special Copy and Scan Jobs

This chapter contains a description of special jobs and how
to improve the output quality of those jobs.
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Non-standard size originals

The scanner of the Océ TDS600 system automatically detects the width of the
inserted original. The Océ TDS600 supports both DIN and ANSI formats. The
Océ TDS600 system uses a memory table that contains all standard width -
standard length combinations to predict the length of the original. The scanner
also measures the real length of each original while it is transferred through the
scanner.

Note: If you copy thick, thin or damaged originals or originals in a carrier
sheet, it is recommended to use the output at the rear side of the scanner to
ensure correct delivery (see ‘Deliver originals after scanning’ on page 60).

The scan width

To prevent information loss when copying a non-standard original, you can
select the ‘non-standard’ scan width. The scanned width will then be larger
than the original width. It is also possible to define the scanned width and
length yourself.

Define the scan width

Open the ‘Sheet’ card in the ‘Original’ section.

Press ‘Scan width’ to select the required setting:

m Standard. This option must be used to copy a standard-size original.

m Non-standard. This option can be used to copy a non-standard original. The
scanned width will be larger than the original width (to the next larger,
standard size), to prevent information loss.

= Numeric. You can define the scan width yourself, using the higher/lower
keys or the numeric keys.

Ready to copy

Seanner

Custom

Mon standard

Standard

) Remove strip Scan width
Feeding

98

[47] Selecting ‘Non-standard’ scan size
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The copy size

The copy width depends on the selected roll and the custom defined scan
width. The copy length depends on the selected cut option.

v Copy non-standard size originals
1 Open the ‘Sheet’ card of the ‘Print’ section
2 Use the function key to select ‘Media’
3 Select ‘Automatic’, or select the roll or sheet feeder with the correct width.

Original

@1 A0 Paper !
&3 AZ Paper !
#1 A3 Transp. !

A1 Paper |
A1 Paper !
12"Transp. !

Multiple sheets

i Set P11 File

.Smg]e sheet .Automahc .F'rmt

_ meutmede

[48] Selecting roll or sheet feeder in the ‘Custom’ section

Autornatic

Note: The media can also be selected directly from the ‘Custom’ section.

4 Press the ‘Cut length’ function key to select the required cut option:
m Standard, which cuts copies at a standard length.
m Synchro, which cuts copies at the end of the image. The system cuts at the
measured length of the original times the zoom factor.
= Custom (numeric), which cuts copies on a specified length. You can define
the copy length yourself, using the arrow keys or the numeric keys.
5 Make other settings as required.
6 Feed the original.
Refer to table chapter, ‘Standard folding settings’ on page 232 for more
information about folding copies of non-standard sized originals.

Scanning originals with filing strip

Left hand side You can adjust the original guide of the scanner to remove a
filing strip along the left hand side (right hand side in the feed direction,
face-down). This side can be reduced by up to 60 mm (see Figure 49).

Special Copy and Scan Jobs 99



Leading strip Leading strip

- 400 mm +400 mm
Left hand side Left hand side
-40 mm +20 mm

[49] Example of adjusting the left hand side of an original

v Copying with removed filing strip along the left hand side
1 Press the handle underneath the original guide, and move it to the right.
——/

[50] Adjusting the original guide to add or remove a filing strip along the left hand side

2 Make all required settings.
3 Insert the original face down, right aligned with the original guide on the
original feed table.

Right hand side You can also remove the filing strip along the right hand side
(left hand side in the feed direction, face-down) by selecting a specific roll or
sheet feeder. If the paper width of the original is larger than the paper width of
the selected roll or sheet feeder, the remaining paper part on the right hand side
will not be scanned (see Figure 51).
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Face up: Face down:
Right hand side left hand side in feed
-40 mm direction

[51] Example of removing the right hand side of an original

Copying with removed filing strip along the right hand side
1 Select the required media in the ‘Custom’ section on the operator panel.
2 Select the 100% value for the ‘Zoom’ function.
3 Make other settings as required.
4 Feed the original.

Leading and trailing strip It is also possible to adjust the length of both the
leading and trailing strip to eliminate or add a filing strip. Leading and trailing
strips can be extended up to 400 millimetres (mm) or shortened up to 100 mm
(see Figure 52).

Leading strip: Leading strip:

-40 mm +40 mm
Trailing strip: Trailing strip:
-40 mm +40 mm

[52] Example of adjusting the leading or trailing strip of an original
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Copy with removed filing strips along the leading and trailing strip

1 Open the ‘Sheet’ card in the ‘Original’ section.
2 Press the ‘Remove strip’ function key.

Mon standard
a Standard

.or
ceen it

[53] Removing strip

Adjust the values in mm for the trailing strip using the numeric or arrow keys.
Press the ‘Remove strip’ function key again.

Adjust the values in mm for the leading strip using the numeric or arrow keys.
Make other settings as required.

Feed the original.

N o o s~

Copy with added filing strips along the leading and trailing strip

1 Open the ‘Layout’ card in the ‘Copy’ section.
2 Press the function key ‘Add strip’ function key.

Custam Original

Wertical: Wertical: Leading:

oo

- Horizontal: Horizontal: Trailing:

®Lert

[ - 0.0 e 0.0
>t hoastee -

[54] Adding strip

Adjust the values in mm for the trailing strip using the numeric or arrow keys.
Press the function key ‘Add strip’ again.

Adjust the values in mm for the leading strip using the numeric or arrow keys.
Make other settings as required.

Feed the original.

N o g s~

Océ TDS600 User Manual



Improving the image quality

You can improve the image quality by modifying the exposure setting, or
making use of special functions. You will learn how to switch on and off
automatic background compensation, how to use the lighter and darker keys to
achieve the best possible copy quality, or how to adjust the brightness based on
the type of image you want to copy.

Brightness

You can change the brightness of a print or copy by modifying the exposure of
the scanner. The exposure can be set to lighter and darker.

v Set the exposure

1 Press the ‘Exposure’ function key and use the arrow keys to set the exposure
as desired.
The Up and Down arrow keys can be used to gradually increase or decrease the
exposure setting; the Left or Right arrow keys can be used to go to the highest
or lowest available exposure level at once. If you want to go from any negative
value to the highest possible positive value, or vice versa, you have to press the
appropriate Left or Right key twice.
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Automatic background compensation

104

The automatic background compensation will provide a good quality copy
from a large variety of originals. The automatic background compensation
setting, which is switched on (by default), ensures the production of
background-free copies of most line drawings.

adytocopy B ELL

Darl: original Lighter

Photo ®of

.Lmesftext Autornatic ; Darlker
s PY— Background
........................................... compensation

[55] Brightness settings

Set the automatic background compensation

Open the ‘Image’ card in the ‘Original’ section.
2 Press the ‘Background compensation’ function key if this function is disabled.

When copying extremely light or dark originals, or originals with unequal
background density, the result may not meet your requirements (e.g. too much
background). In such cases you can manually adjust the brightness (see
Figure 55).

Original type The Océ TDS600 scanner allows you to adjust the exposure
setting according to the type of image on the original. There are six original
types available. Select a suitable mode according to the original (see Figure 55
on page 104).
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Set the original type of your image
1 Press the ‘Original type’ function key to select the appropriate image type:

m By default ‘Lines / text’ is selected with ‘Background compensation’
enabled. This is the most suitable setting for originals that contain characters
and line art.

m Press the ‘Original type’ function key to select ‘Photo’ when the original
consists of a combination of characters, line art and picture images.

Note: If you select ‘Photo’ or ‘Greys&lines’, the ‘Background compensation’

will be switched off automatically, by default.

m Press the ‘Original type’ function key to select ‘Greys & lines’ when the
original contains many grey scales and lines.

m Press the ‘Original type’ function key to select ‘Blue print’ when you want
to copy an original with an image in ‘negative’ (image in white on dark
background). The copy will be ‘positive’ (image in black on white
background).

m Press the ‘Original type’ function key to select ‘Printed matter’ when you
want to copy an original that is already a print itself, containing raster
information.

m Press the ‘Original type’ function key to select ‘Dark orig” when the original
has an extremely dark background (i.e. low contrast).

m Press the ‘Original type’ function key to select ‘Cut & paste’ when the
original contains paste edges.

2 Make other settings as required.
3 Feed the original.
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Editing functions

The Océ TDS600 scanner has editing functions. You set the functions before
you scan the original.

Note: You can select only one edit function at a time.

Auto align

To align the image automatically to a side of the print you can use the
alignment functions of the Océ TDS600 scanner. Alignment is possible in the
following ways (see Figure 56):

o (] ]

Top Left Top Middle Top Right

] ] (]

Middle Left Middle Middle Right

{ ] ] ]

Bottom Left Bottom Middle Bottom Right

[56] Auto align options with standard cut option active

v Select default settings for auto shifting with standard cut option

Note: You must switch on standard cut length to get output like the one in
the example of illustration 56 above.
1 Open the ‘Layout’ card in the ‘Print’ section.
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Wertical:

Wertical: Leading:

oo

mage

Horizontal: Horizontal: Trailing:

_ . ag” oon o
................................ Shift Add strip -

[57] Automatic shift with the ‘Align’ function

Layout

2 Press the ‘Align’ function key and select a horizontal alignment value (Left,
Middle or Right) with the arrow keys.
3 Press the ‘Align’ function key again and select a vertical alignment value (Top,
Middle, or Bottom) with the arrow keys.
Note: If you select ‘Centre’, make sure the original width is specified as
follows (see ‘The scan width’ on page 98):
m ‘Standard’ if a standard sized original is used
m The exact original width (numeric) if a non standard sized original is used.
4 Feed your original.

Note: You must switch on standard cut length to get output like the one in the
example of illustration 56 above. If synchro cut length has been switched on,
the result will be as follows:

| A

Top Left Top Middle Top Right

¥
LR
»

Middle Left Middle Middle Right
Bottom Left Bottom Middle Bottom Right

[58] Auto shift options with synchro cut option active

In ‘Shift the image’ on page 108 you can read how to define the exact place of
your image on the page.
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Shift the image

108

In some cases the margin may be too narrow to accommodate filing strips
without loss of information. To avoid this, you can shift the image in horizontal
or vertical direction, as shown below.

[59] Example of shifting the image

Shift the image
1 Open the ‘Layout’ card in the ‘Print’ section.

Wertical: Vertical:

Top oo

- Horizontal:

o ®Lcit
..................................

[60] Image shift

Horizontal: Trailing:
. 0.0 00"
o fddstrie -

2 Press the ‘Shift’ function key and select a horizontal shift value by pressing the
numeric or arrow keys until the required distance is set to shift the image to the
left or to the right.
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Note: When you shift the image horizontally, you can only shift to the left
or to the right.

Press the ‘Shift’ function key again and select a vertical shift value by pressing
the numeric or arrow keys until the required distance is set to shift the image
upwards or downwards.

Note: When you shift the image vertically you can only shift up or down.
Make other settings as required.

Feed the original.

Note: You can use horizontal and vertical shift simultaneously.

Mirror-image copies

With the Océ TDS600 scanner you can make a mirror-image copy of an
original, as shown in the next figure:

T > BE

[61] Example of a mirror-image copy

Make mirror-image copy
Open the ‘Image’ card in the ‘Print’ section.

Imnage

1000 %

Layout

HEE i on

Finizhing

.Automatm .fo

Sheet

Zoom leror --

2
3

[62] Mirror-image

Press the ‘Mirror’ function key to enable the ‘Mirror’ function.
Make other settings as required and feed the original.

Special Copy and Scan Jobs 109



Make a set copy

110

B ON =

Set copying is an input mode which enables you to make one job out of
multiple originals. It is distinguished from the ‘Multiple sheets’ input mode by
the way the job is sorted. See ‘Select the input mode’ on page 57 for a
description of the input modes.

Make a set copy

Open the ‘Feeding’ card in the ‘Original’ section.

Use the ‘Input mode’ function key to select ‘Set".

Make other settings as required and feed the original.

Press the green Start key to start the copy job.

Your original is fed into the scanner. The printer starts.

Feed the other originals that make up your set.

When ‘Automatic feed’ is enabled, you do not have to press the green Start key
everytime you feed an original.

When all originals are scanned, press the green Start key to close the set.
When you want to abort your job, press the red Stop key. When you press the
red Stop key, the entire job is deleted.
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Océ Matrix Logic® introduction

What is Océ Matrix Logic

Océ Matrix Logic® is an optional software application for Océ TDS600
multifunction systems. It allows users to easily create different copy set
outputs from one set of scanned originals.

Matrix Logic copying of a set is based upon storing the entire set of scanned
originals (up to 100 documents) on the Océ Power Logic controller. You can
then apply from 2 to 30 different configurations to that set. The result is that
the output from the one set of scanned originals can be printed out up to 30
different ways. Enable matrix copying with a password in the Océ Settings
Editor.

Workflow

Here are the steps to follow to compose and print a matrix job.

Note: Some steps are mandatory whereas others are only optional as
mentioned below.

m Launch Océ Matrix Logic

m Scan a Matrix Job

m Create a configuration (optional)

m Define settings for the configuration (optional)
m Save the configuration (optional)

m Modify existing configurations (optional)
m Compose an Océ Matrix Logic Job

= Add configurations

= Add banners

m Print

= Reprint
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One scan job is
scanned in on the
scanner.

Configurations are
applied to the scan jo

-
] The matrix copy jobs
I ' are sent to the printer.

The printer prints the
matrix jobs

[63] Workflow of Océ Matrix Logic®
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Access Océ Matrix Logic®

Océ Matrix Logic can be accessed from the ‘Launcher’ window on the Océ

Power Logic Controller graphical user interface:

#* Launcher =

Ccé System Control Panel

Iﬁ.' Océ Queue Manager

4 Océ Settings Editar

Océ Scan Manager

Qcé Matrix Logic®

Note: Océ Matrix Logic® can not be accessed via Océ Remote Logic.
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Use Océ Matrix Logic®

Matrix composition

114

Océ
Matrix composition
User name ,7 User ID |7
Job name ,m Account ID |7
Set of originals Matrix composition
x x ¥ X % & i3}

Remove Remove all  Print Add Delete Move up Move down  Banner

Edit

Click the print” button to print these originals
according to the copy matrix composition

‘When printing is complete, all originals are
deleted.

From this tab, you can:

m set ‘Job Level’ parameters (User name, User ID, Job name, Account ID)

m view a list of the originals (up to 100 originals per job)

m remove originals from the job

m add, delete and manage pre-defined Copy configurations to apply to the
Matrix job.

m change settings to applied Copy configurations

m select banners

m initiate the Matrix job printing
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Create a Matrix Job

v Launch Océ Matrix Copy
1 Using the Launcher' on the Power Logic controller graphical user interface,
select Océ Matrix Logic.
2 Click on the ‘Matrix composition' tab where the set of scanned originals is
displayed.

v Prepare the Matrix job

1 Fill in the 'User name' and 'Job name' fields ('User ID' and 'Account ID' are
optional).
Note: If your Océ TDS600 system has Océ Account Logging activated, then
the 'User ID" and 'Account ID' will be stored by Océ Account Logging.

2 Every original in the set that you scanned is assigned a name by Océ Matrix
Logic®.
m To remove a specific original from the matrix job, highlight that original by

clicking on its name, and then click 'Remove'.

m To remove all the originals from the matrix job, click 'Remove all'.

v Scan your Matrix Job originals

1 Open the 'Original' section on the scanner-operating panel.

2 Select 'Feeding' card.

3 Once the feeding card is open, use the 'Input mode' button to select Matrix
copy'.
Note: After you select Matrix copy, the 'File' and 'Print’ sections as well as
the 'Legend location' and 'Drawing method' cards on the scanner panel are
disabled):.

Ready t

tri

Custom

_.Matrix copy’

Scanner ¢ Multiple sheets

mage i et ®on

Single sheet

Sheet

Input mode Automatic feed

[64] Input mode with Matrix copy selected

4 Scan your entire set of originals (up to 100 originals), and remember to press
the green start button to close the set when you are done.
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Add configurations

You can add predefined copy configurations to your Matrix Job. These
configurations are created in the ‘Copy configurations’ tab (see ‘Copy
configurations’ on page 118).

v Add configurations to your Matrix Job

1 Click ‘Add’ in the ‘Matrix composition’ window. The ‘Select a copy
configuration’ window appears:

Océ TDSB00 Matrix Copy - Select a copy £o x|

Select a copy configuration

« oK »  cancel

2 Select one or several configurations to apply to the job (up to 50).
3 Click ‘OK’:
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81
Océ | Matrix Logice®

Matrix composition

User name oce User ID 135

Job name Maltix eyl 6 Account ID 457
Set of originals Matrix composition
fo
X x & ¥ x + 4 i}
Remove Remove all  Print Add Delete  Move up Move down  Banner

Edit

Click the "print button to print these originals
according to the copy matrix composition.

When printing is complete, all originals are
deleted.

The * Matrix composition’ window now contains the configurations selected
for the matrix job. The user may want to make changes to any particular
configuration selected for this job. This can be done in the edit window.

v Modify configurations from the Matrix Composition window

1 From the Matrix Composition section, highlight the configuration to modify.
The settings are displayed.

2 Click the setting to modify. The value of the setting is displayed in the ‘Edit’
field.

3 Change the value.

4 Repeat steps 2 and 3 for every setting to modify.
Note: When editing a configuration, the change is not permanent. The
original settings for that configuration are not changed. They are only
changed for the Matrix job being printed at that time.

5 Print the Matrix Job (see ‘Print the Matrix job’ on page 117).

Print the Matrix job
v Print the Matrix job

1 Click ‘Print’.
2 Click the ‘Submission queue’ tab to follow the submission status:
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M Océ Matrix Logic®

Océ | Matrix Logice

Submission queue

Current job

x
Cancel
I 0%
Pending jobs Submitted jobs
o
x T & x 13 ap

Delete Move up  Move down Remove Removeall  Print

Job name | Submission status Job content

= Current job: displays the progress bar of the job being processed.
m Pending jobs queue: displays the list of jobs that are pending to be submitted
(busy printer).
= Submitted jobs queue: displays the list of jobs that have been submitted to
the printer.
3 Click ‘Remove’ or ‘Remove all’ or ‘Delete’ if you want to remove one or
several matrix jobs while they are pending or submitted.
4 Click ‘Move up’ or ‘Move down’ in the Pending Jobs queue if you want to
change the print order.

Reprint
v Reprint the Matrix job

1 From the Submitted jobs queue, select the Matrix job.
2 Click ‘Print’.

118 Océ TDS600 User Manual



Copy configurations

Copy configurations are pre-programmed copy settings. These settings are
applied to the originals in the matrix job. Users can create and save up to 50
different configurations:

JSEIE]
Océ | Matrix Logice

Copy configurations

Copy configurations

* x 2]

Create Delete save

Edit

The left side of the Copy configurations tab has the configuration list. This
shows all currently saved configurations. Users can create and save up to 50
different configurations. Configurations may be edited when applied to a
particular matrix job.

The right side of the screen shows the settings list. These are the available
settings that can be stored in a configuration. Using the settings list is similar
to using the Settings Editor of the Power Logic controller.

From this tab, you can manage the configurations:

m create or delete a configuration
m define or modify settings.
m save the changes
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Edit configurations

v Create a new configuration
1 Click 'Create'. A default name is added in the configurations list:

Il Océ Matrix Logic =8 x|
Océ | Matrix Logic®

Copy configurations

Copy configurations New copy configuration-1
¥ x (2]
Create  Delete Save
New copy configuration-1 = [ General [ Edit
Copies
Collate <On> ;
Content tyne <Automatic>
= & Media 1- 989

= & Media source <Automaticx
& Fit method <Largers
=& Media type <Flain papers
< Media weight <75gr>
& Media size <Autornatic>
= ) Transfarmations
%) Zoom =100 %=
= E3 Layout
Alighment <Center-
= £ Leading edye <Add leading edge>
Added leading edge <0.0-
B8 Trailing edoe <Add trailing edge
Added trailing edge 0.0~
= @ Finishing
Cutmethod <Synchros
Fold <Off
Deposit unfolded <Integrated receiving tray>

2 Rename the configuration.

3 Type 'Enter' to validate.

4 Define the settings to apply to the configuration (see ‘Edit settings’ on
page 121).

5 Click 'Save'. Successful saving is confirmed with a message.
Note: If you exit the tab without saving the changes in the configuration, a
message asks you whether you want to save, discard or cancel the
configuration.

120 Océ TDS600 User Manual



Edit settings

Select a configuration in the list.

Select the setting to define or modify. The setting is displayed in the Editing
zone.

Select the value to apply to the setting from the scrolling list.

Repeat steps 2 & 3 with all the settings to edit.

Click 'Save'.

Delete a configuration

Select a configuration in the list.
Click 'Remove'.
Save.

Save changes

Whatever the changes you apply to configurations (Delete, create, edit
settings), you need to save the changes.

Click 'Save' to confirm the changes.
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Banners

Banners are extra informative pages added to a job. They list a number of
attributes that are set in the Banner Selection Page (company name, logo).

v Define a banner
1 From the Matrix Composition view, click ‘Banners’. The Banner selection

page is displayed:
X

Define banner
¥ Enable banner

&7 Banner seftings

Templatz name Nates

[Plain =]
Media source
Automatic hd

Company hame Company logo (g fle)

I Load

V’ 0K K Cancel

2 Check the ‘Enable banner’ option.
3 Define the banner settings:
m Template name: Select a banner template.
m Media source: select Automatic or Roll or Tray
Note: When you select roll or tray, an extra field is displayed to select the
roll or tray number.
m Notes: You can insert notes to your banner in this window. Notes are
persistent from one job to another.
= Enter a company name
m Company logo: click the ‘Load’ button to load your company logo.
4 Click ‘OK’ to apply the defined banner to the job.
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Chapter 6
Océ Power Logic®: Settings Editor

This chapter provides information about the Océ Settings
Editor. For details about specific settings, refer to the Help
on the Océ Settings Editor.
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Introduction

Use the Océ Settings Editor to set the default settings of the Océ TDS600
according to your company's requirements. Two types of users can define
settings in the Océ Settings Editor; Key Operators and System Administrators.
You can log on as either Key Operator or System Administrator. Key Operators
and System Administrators have different rights for defining settings.
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Océ Settings Editor

The Océ Settings Editor is one of the controller applications for the Océ
TDS600. The Océ Settings Editor allows users and operators to view system
settings. If authorized, the system settings can be modified on the Océ Settings
Editor.

With the Océ Settings Editor, two groups of settings can be configured:

m Key Operator settings (KO settings)
The Key Operator group allows authorized users to configure default settings
for copy and print jobs, default off-line fold settings and scan-to-file options.
With the Key Operator settings also the printer, system and scanner defaults
can be set or modified. A subset of the Key Operator settings are the Repro
Operator settings. The Repro Operator has no rights for changing settings in
the Océ Settings Editor. In the Océ Queue Manager and the Océ System
Control Panel the repro operator has the same user rights as the Key Operator
and System Administrator. See ‘User modes’ on page 163.

m System Administrator settings (SA settings)
The System Administrator group allows authorised users to configure default
printer language (PDL) settings and printer pen settings. It also allows the
System Administrator to configure system and connectivity settings.

These groups of settings can be selected from the ‘View’ menu of the Océ
Settings Editor.

Setting dependencies The Océ Settings Editor is used to display and edit a
specified group of settings. However, some settings are related to other
settings. If you want to change settings that are dependent on or linked to other
settings you will be prompted with a message. When a setting is changed, the
system automatically updates the related settings.

Also, when you change certain settings, such as measurement unit or paper
series, all related settings are instantaneously converted to the new setting
(with a bullet for the settings that are changed).
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@ Custom card: <=
@ Check print <Off=

@ Qutput rode: <Copy=
@ Mirror: <Oft>
re@ Userid: <0=
(@ Accountid: <0-
123 Zoom
Qriginal card
Print carg
File card
Zoom calibration
2 Scanto file

Printer

[65] Océ Settings Editor

General structure

The Océ Settings Editor is structured as follows:
= Menu bar

m Top toolbar

m Left toolbar

m Settings area

m Status bar
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Menu bar

The menu bar of the Océ Settings Editor contains the following menus:

File If you select the ‘File’ menu you can log on as a particular type of user,
log off of the previously selected user mode, open an existing setting file, save
the current settings to a file, connect to a different controller (only for remote
users) or exit the Océ Settings Editor.

Edit If you select ‘Options’ from the ‘Edit’ menu, a window is displayed in
which you can view your default system and the display languages (first and
second) for the Océ Settings Editor application. The ‘Automatic logon’ option
allows you to start the Océ Settings Editor application automatically in the
specified user mode.

View The ‘View’ menu allows you to switch between the display languages as
defined in the Edit options window and to switch between KO settings and SA
settings.

Help The ‘Help’ menu contains the following options: ‘Contents of the Océ
Settings Editor’ and ‘About the Océ Settings Editor’.

File Edit “iew Help
[66] Menu bar

Top toolbar

The top toolbar of the Océ Settings Editor contains four control buttons:
‘Open’, ‘Save as’, ‘Apply’ and ‘Undo’.

Open Save as... fate ] i ] i

[67] Top toolbar

Open When you click on the ‘Open’ button, you open a saved file.

Save as All Key Operator and System Administrator settings can be saved in
a file. This way you can have different settings for different customers,
departments or other situations.
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Note: These settings can only be saved in Key Operator or System
Administrator mode.

Apply When you click on the ‘Apply’ button, the changes you have made
become effective. Initially, this button is disabled. It is enabled after the first
setting is changed and disabled again after the apply action is performed or
after an undo action.

Undo This button restores the settings to the state it was in the last time the
settings were applied (and not back to the factory default). Initially, the ‘Undo’
button is disabled. This button is enabled the moment the first setting is
changed. It is disabled after an Apply action is performed or after an undo
action.

Left toolbar

There are four different buttons available at the left toolbar of the Océ Settings
Editor. These are ‘Jobs’, ‘Printer’, ‘Scanner’ and ‘System’. Each button
provides access to a specific group of settings. By clicking on each of these
buttons, you can get access to the settings related to the selected group.

A shadow highlight is used to indicate which button is activated.

Printer

Scanner

[68] Left toolbar

Settings area

The settings area consists of two parts: a setting tree and an update area.
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Tree structure Most settings are displayed using a tree structure. By clicking
on the settings, folders can be opened to show all the entries or closed to hide
all the entries below these folders.

The settings for system components that are not available are not displayed.
So, if you do not have a folder, no folder settings are available. This means that
different configurations result in different tree structures.

Note: When a tree item has been changed, this item will be marked with a
bullet.

Update area The user can move through the tree and select a setting. If he
selects a setting for which he is authorised, he can edit the setting in the update
area.

If the user is not authorised for a particular setting, the update area is grayed
and no changes can be made.

Note that a few settings, such as basic card and pen settings, are not edited from
the tree structured, but are accessed directly from the settings area.

The update area contains some additional information about the selected
setting. This includes a brief definition of the setting, as well as the minimum,
maximum and default values (if appropriate).

opy & File | Print] Offline folding

=

::
=

=& Defaults é Ueerd

#-{Z] Zoom calibration
-7 Scantofile

i@ Custom card: <»
+-@ Checkprint, <Off=
g Mumber of printsisets; <1= ID
L@ Output mode: <Copy=
Wirrar: <Off-
serid: <0=

Accountid: <0-
3 Zoom

79 Qriginal card
€21 Print card Default: 0
{7 File card

(1) Tosette userid
The user id can be used afterwards to determine how many jobs are
processed by thatuser.

[69] Settings area
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Status bar

The Océ Settings Editor has a status bar displaying the following information
(left to right):

m System status (icon for connected or disconnected)
The following icons are used:

=.;|D.= The Océ Settings Editor is connected to a system.
="|] D= The Océ Settings Editor is not connected to a system.
m System name (‘localhost’ if you are working at the controller)
m User mode (Repro operator, Key Operator, System Administrator or

anonymous)
= View mode (KO settings or SA settings).
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Use the Océ Settings Editor

Key Operator settings

a H ON =

The Key Operator is responsible for correct default settings of the system.
These settings include the default settings, and groups of default printer
settings for the print and the copy jobs that again occur.

The Key Operator can define all timer settings, like the panel time out and the
sleep mode time out.

Note: One Key Operator or System Administrator can log onto the Océ
Settings Editor at the same time.

In order to perform special Key Operator functions, you must log onto the Océ
Settings Editor as a Key Operator.

As these functions are restricted to a dedicated Key Operator, a password is
required to access them. The service engineer will provide this password to
you upon installation.

Note: When you are finished, make certain you log off from the Key Operator
mode of the Océ Settings Editor to prevent unauthorized use of the Océ
TDS600.

Make Key Operator settings in the Océ Settings Editor

Maximise the Océ Settings Editor on the screen.

Log on as Key Operator.

Click on one of the top buttons to display the desired group of settings.
Select the setting you want to update in the tree structure.

Update the setting in the update area, as required.

Note: A few settings, such as the defaults for the Custom card, are made
directly from the tree structure area.

Click on the ‘Apply’ button.

The new value is now applied for the setting

Log off from the Key Operator mode when you have finished updating the
settings.
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System Administrator settings

The Océ TDS600 System Administrator is responsible for:

m Dithering matrix and Poker settings

m Printer language controller settings

m Pen settings

= Automatic Language Selection (ALS) settings
= Controller identification settings

= Set memory reservation settings

= Connectivity settings.

Note: Poker stands for Portable Kernel. Poker performs automatic
interpretation of the host language in which the data from the scanner or in the
Jjob ticket is encoded. Poker makes sure that the quality between the input from
the printer driver or scanner and the output from the printer is consistent.
Poker supports data compression for scan-to-file and changes raw data from
the scanner into high level file formats.

To modify the System Administrator settings you have to access the SA
settings in the Océ Settings Editor.

There are two types of System Administrator settings (see Figure 70):

m Printer
= System

File Edit Wiew Help

= = o i)

Open Bae ag Apply Wi

PDLSl Pensl

= -4 oker POL heap si Mb>

Printer i@ Poker minimum number of verlices in polygons: <17500=
L@ Poker madmurm number ofvertices in polygons: <17500=
i@ Scale down algorithm: <Sampling>

ZTHPGL

CIHPGL-2

73 Calcomp

I Postscript

#12 NIRS

L oh)

I TIFF

ZIcALs

(=12 ASCI

[70] System Administrator settings in the Océ Settings editor
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In order to perform special System Administrator functions, you must log onto
the Océ Settings Editor as a System Administrator (see ‘User modes’ on
page 163).

Note: When you are finished, make certain you log off from the System
Administrator mode of the Océ Settings Editor to prevent unauthorized use of
the Océ TDS600.

v Make System Administrator settings in the Océ Settings Editor

1 Maximise the Océ Settings Editor on the screen.

2 Logon as System Administrator.
See ‘User modes’ on page 163 for more information about logging onto the
Océ Settings Editor.

3 Click on one of the top buttons to display the desired group of settings.

4 Select the setting you want to update in the tree structure.

5 Update the setting in the update area, as required.
Note: A few settings, such as the default pen settings, are made directly
from the tree structure area.

6 Click on the ‘Apply’ button.
The new value is now applied for the setting

7 Log off from the System Administrator mode when you are finished updating
settings.

Access the Océ Settings Editor

In order to perform special Key Operator functions, you must log onto the Océ
Settings Editor as a Key Operator.

As these functions are restricted to a dedicated Key Operator, a password is
required to access them. The service engineer will provide this password to
you upon installation.

Note: Only one Key Operator or System Administrator at a time is authorised
to make modifications. However, there may be multiple users viewing the
settings. When a second user tries to log on as Key Operator or as System
Administrator, an error message is displayed.
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Start Océ Settings Editor

You can start the Océ TDS applications on the controller as well as on a remote
workstation.

Start Océ Settings Editor on the Power Logic® Controller

Select the Launcher' application.
Select Océ Settings Editor. Océ Settings Editor starts.

Start Océ Settings Editor on a remote workstation

Note: You must first install the Océ Remote Logic® as described (see
‘Installation procedure for MS Windows® systems’ on page 157).
Select 'Océ Remote Logic®' via the 'Start' menu.

Select the 'Launcher' application.

Select Océ Settings Editor. Océ Settings Editor starts.

Define the contents of the custom card

134

A ON =

Use the custom card to provide direct access to the frequently used settings.

How to open the custom card editor

Click the ‘Jobs’ button in the left toolbar.
Click the ‘Copy & File’ tab in the settings area.
Select ‘Custom card’ in the tree structure.
Click the ‘Edit’ button in the update area.

The ‘Custom card editor’ displays.

How to add settings

Open the ‘Custom card editor’.

Select the settings group in the ‘Setting groups’ list.

Click the right arrow button to move the selected setting group to the ‘Custom
card’ list. The maximum number of setting groups that can be added to the
‘Customer card’ list is five.

Select the settings group in the ‘Custom card’ list.

Click the up or down arrow buttons to change the order of the setting groups in
the ‘Custom card’ list.

Click the ‘Close’ button.

Click the ‘Apply’ button.
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The ‘Custom card’ settings are now available in the custom section at the
scanner operator panel (see ‘Custom section’ on page 48).

How to remove settings

Open the ‘Custom card editor’.

Select the setting group in the ‘Custom card’ list.

Click the left arrow button to remove the selected setting group from the
‘Custom card’ list.

Click the ‘Close’ button.

Click the ‘Apply’ button.

The ‘Custom card’ settings are now removed from the custom section at the
scanner operator panel (see ‘Custom section’ on page 48).

Define the job templates

© 0o NOoO G s~ WOWDN =

a & WON =

Use the job templates to define frequently used jobs.

How to define the template name and description

Click the ‘Jobs’ button in the left toolbar.

Click the ‘Copy & File’ tab in the settings area.

Open a template in the tree structure.

Select “Template description’ in the tree structure.

Click in the text field under ‘“Template name’ in the update area.
Enter the template name.

Click in the text field under ‘“Template description’ in the update area.
Enter the template description.

Click the ‘Apply’ button.

The template name and description now displays on the scanner operator panel
(see figure 9 on page 48).

How to define settings in the job templates

Click the ‘Jobs’ button in the left toolbar.

Click the ‘Copy & File’ tab in the settings area.

Open a template in the tree structure.

Open the ‘“Zoom’ menu in the tree area to access the zoom settings
Open a card in the tree structure.

Open the ‘Original card’ to access the settings for the scanner input, the
original.
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Open the ‘Print card’ to access the settings for the printer output, the print.
Open the ‘File card’ to access the settings for the scan-to-file output, the file.
Open a submenu.

Select a setting in the tree area.

Change the setting in the update area.

Click the ‘Apply’ button.

The settings of the job templates are now available at the scanner operator
panel.

The ‘Original card’ settings are available at the original section (see ‘Original
section’ on page 49).

The ‘Print card’ settings are available at the print section (see ‘Print section’
on page 49).

The ‘File card’ settings are available ate the file section (see ‘File section’ on
page 50).

Manage different system adjustments with save and load

136

Use the save and load button to manage the different system adjustments for
the customers, departments or other situations. Save stores all settings, the
custom card and job templates included.

The Océ TDS600 has the following special files for your use.

m Backup.kos/Backup.sas
These files contain the previous values for the key operator settings and the
system administrator settings before the last apply.

m Current.kos/Current.sas
These files contain the values for the key operator settings and the system
administrator settings after the last apply.

How to save all settings to a file

From the ‘File menu’, select ‘Save as’.

You can also click the ‘Save as* button on the top toolbar.

If the client is a local client, the screen displays a dialog box. You can enter a
file name. The file is saved in the specified directory on the system.

If the client is a remote client, the screen displays a dialog box. You can enter
a directory name and a file name.

Enter the filename without .kos or .sas.

Click the ‘Save’ button.
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Note: all settings, key operator and system administrator included, are saved.

How to load KO or SA settings from a file

From the ‘File’ menu, select ‘Open’.

You can also click the ‘Open’ button on the top toolbar.

The screen displays a dialog box from where you can browse to the required
file.

Click the ‘Apply’ button.

The settings are loaded to the system.

When you are logged on as a key operator, the system only loads the KO
settings.

When you are logged on as a system administrator, the system only loads the
SA settings.

Repro operators and anonymous users are not authorised to load the settings
from a file.

Note: this is only possible if the user is logged in as a Key Operator or System
Administrator.

Find system settings in the Settings Editor

The following table displays all references in this manual that refer to a
Settings Editor setting. KO indicate that you must have Key Operator
permission to change the setting. SA indicates that you must have System
Administrator permission to change the setting. Open the ‘File’ menu and
select ‘Logon’ to logon as Key Operator or as System Administrator (see
Figure 66 on page 127).

System setting Reference |Path in Settings Editor
on
IPanel language page 36 IKO - System - Localisation - Display

page 166 languages

Custom card settings page 48 IKO - Jobs - Copy & File - Custom card
page 134 IKO - Jobs - Copy & File - Template -
Custom card

Job template settings page 50 IKO - Jobs - Copy & File
page 135
[Panel time out page 52 KO - Scanner - Timers - Panel time-
out
Zoom factor steps page 58 IKO - Scanner - Zoom steps
Stamping page 66 IKO - Jobs - Stamp
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System setting Reference |Path in Settings Editor

on
Passwords page 70 KO - System - Enabling passwords
Scan clicks page 70 IKO - System - Localisation -

IMeasurement unit

Scan memory page 89 SA - Scan memory reservation

reservation

Manage temporary store  [page 89 IKO - System - Disk cleanup - Scan
spool cleanup

Set memory threshhold  page 151 SA - Set memory reservation

Set copy priority page 143 IKO - Job priorities - Copy priorities

History queue job page 148 IKO - System - Job management -

settings History queue

IA4 Reinforcement page 238 IKO - Printer - Folder reinforce A4
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Chapter 7
Océ Power Logic®: Queue
Manager

This chapter describes how to view the Océ TDS600 System
print queue, history queue and inbox queue. This chapter
contains a description of how to manage jobs in the Océ
Queue Manager.
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Introduction

The Océ TDS600 Queue Manager application provides you with a graphical
representation of the print queue. It allows you to view the print queue and the
status of the print jobs as well as to manage the jobs in the queue. With the Océ
TDS600 Queue Manager you can:

m Abort the job currently being printed

m Delete job(s) in the queue

m Put job(s) in the queue on hold

m Print jobs from the history queue

m Print jobs form the inbox queue

= Move job(s) to the top of the queue

m Restart job(s) that were previously put on hold in the queue

Start Océ Queue Manager® on a remote workstation

Note: You must first install Remote Logic® in ‘Installation procedure for MS
Windows® systems’ on page 157.

Select 'Océ Remote Logic® via the 'Start' menu, or

Select the Launcher' application.

Select Queue Manager. Océ Queue Manager starts.

Note: To start more than one Océ Queue Manager, Océ System Control
Panel or Océ Settings Editor you are advised to use the 'Application
Launcher'.

Structure

140

The Océ TDS600 Queue Manager window is divided into the following parts
(see Figure 71 on page 142):

m The standard menu bar.
The menu bar for the Queue Manager contains the following menus:

m File: Logon, Logoff, Connect to, Close

m Edit: set the default printer and 'Automatic logon'.

m View: selecting the language, switching between queues, and configuring the
view of the queues.

m Help: About Océ Queue Manager, Contents of the help.

m The toolbar
The toolbar for the Océ Queue Manager contains the following icons:
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m Hold, resume, move to top, delete and print job(s).

m The active print job window.
This window displays the job currently being printed on the Océ TDS600.

m The print queue window.
This window has a tabular format and shows the jobs waiting to be printed.
The jobs are displayed in the order in which they are expected to be printed.

Note: Copy jobs take preference over print jobs.

= Inbox queue
The inbox queue contains print jobs which have been sent to the 'Inbox' on
the controller. You can print these jobs, view the properties and delete these
jobs.

m History queue
The history queue contains print and copy jobs which have been printed. You
can print these jobs, view, edit some the properties and delete these jobs. You
can set how long and how many jobs are kept in the history queue, in the Océ
Settings Editor.

Note: You can select the ‘History’ or ‘Inbox’ queue from the drop-down list

box on top of the right window.

m Status bar
The Océ Queue Manager has a status bar displaying the following
information:

m System status (connected, not connected)

m The connected system

m The job status e.g. ‘printing job.AO.hp’

= User mode

For each job the following information is displayed:

m The current status and schedule of the job in the form of an icon. See ‘Icons’
on page 144.

m The name of the print job.

m The type of job (print job or copy job)

m The name of the user who has submitted the print job.

m The number of sets and pages.

m Any remarks (e.g. 'Manual Feed').

You can resize the columns in the main queue window by dragging the table
header separators. It is also possible to change the order of the columns by
dragging a specific column to a new position.

Note: You can sort the inbox and history. You can not sort the printer queue.
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[71] Queue Manager window with the Inbox queue

Modes

The Océ Queue Manager has the following modes:
= Anonymous user mode

m Repro operator mode

m Key operator mode

= System administrator mode

= Service Operator

These different modes are designed to limit access to the specific functions to
authorized users only.

The anonymous user mode only offers view access to the queue. In this mode
the available buttons are disabled.

The repro operator, the key operator and the system administrator modes allow
you to perform a number of activities on the jobs in the queue, with the help of
the Abort, Delete, Resume and Hold buttons. The service operator mode is
meant for Océ technicians.

Note: In the Océ Queue Manager and the Océ System Control Panel, the repro
operator, the key operator and the system administrator have the same user
rights. In the Océ Settings Editor, however, the user modes offer different
rights.
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Access The access to the key operator, repro operator, system administrator
modes and service operator is password protected to allow only authorized
personnel to use particular functions. You can enter these modes by selecting
the Logon option from the File menu and by specifying the correct password
when prompted for it (see ‘Log on’ on page 164).

From the ‘File’ menu, select ‘Close’ to exit the Océ Queue Manager.

Job priority The priority of print and copy jobs in the Océ Queue Manager is
determined by the order in which they are submitted to the Océ TDS600.
However, there is a setting in the Océ Settings Editor which allows you to give
copy jobs priority over print jobs (see ‘Find system settings in the Settings
Editor’ on page 137).
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Icons

The Océ TDS600 Queue Manager uses a number of icons to display
information about a job in the queue. The following icons are used:

[72] Receiving job

[73] Received job

[74] Processing job

Cl

[75] Processed job

Cl

N

6] Job in progress

S

77] Printing job

Ef |

78] Delivering job

2

79] Delivered job

)

80] Deleted job

[81] A job that requires manual feed

[82] The job is placed on hold by the user or the system.
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[83] Attention, needs operator attention (e.g. a media request).
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Managing print jobs

Print queue

v

146

View the print queue

The Océ Queue Manager displays all jobs sent to the print queue in a list sorted
according to the order in which they will be printed.

This ordering can be changed by:

m deleting jobs

m putting jobs on hold

m restarting jobs currently on hold

m moving jobs to top (if advanced Queue management is enabled)
m the list will be automatically updated.

Note: Queue operations can only be performed when you are properly
authorized. Before you can use the Océ Queue Manager in a different mode,
you first have to enter a password to get the required access

Delete print jobs

Select the desired job(s) by clicking on it/them.

Note: You can select a consecutive list of jobs to be deleted by clicking on
the first job, holding down the Shift key and clicking on the last job. You can
select a non-consecutive list of jobs to be deleted by clicking on each
desired job while holding down the Ctrl key.

Note: To delete a job from a remote client, you need repro operator, key
operator or system administrator rights.

Click on the Delete button.

A cross icon is displayed in front of the job and a confirmation window will
now be displayed.

Note: Consider carefully before you use the Delete button. A delete
operation cannot be undone.

Put print jobs on hold
Click on the job to select the desired job.
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Note: You can select a consecutive list of jobs to be put on hold by clicking
on the first job, holding down the Shift key and clicking on the last job. You
can select a non-consecutive list of jobs to be put on hold by clicking on
each desired job while holding down the Ctrl key.

2 Click on the Hold button.
An icon for a job that is put on hold (see ‘Icons’ on page 144) is displayed in
front of the job when the job is put on hold.
Note: A job that is put on hold will retain its position in the print queue.
Once it reaches the top of the queue, the job that is put on hold will stay
there until it is restarted or deleted. While a job is on hold, other jobs will
be printed, even when they were behind the job on hold in the queue. The
active job and the jobs in printing state can not be put on hold by the Queue
Manager.

v Restart jobs that are put on hold
1 Click on the job to select the desired job.
2 Click on the Resume button.
The selected job(s) are now restarted.

v Move jobs to top

1 Click on the job to select the desired job.
2 Click on the ‘Move to top’ button on the toolbar.

If more than one job is selected then the first selected job will be on top, the
second will be on top, the second below that one and so on.

Inbox queue

All print job are sent to the ‘Inbox’ queue, if the setting ‘Jobs in inbox’ is set
in the Océ Settings Editor. if you want to print your jobs, select the jobs in the
‘Inbox’ from the queue manager, and press the ‘Print’ button (see Figure 71 on
page 142).

The Key Operator determines if jobs go to the inbox, are send to the print
queue or if the jobs are printed as described in the job ticket. The setting in the
in the Océ Settings Editor: ‘System - Job management - Print jobs’
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History queue

148

The purpose of the history queue is:
m to view the printed jobs
m to reprint a job

The key operator enables the history queue in the Océ Setting Editor (see ‘Find
system settings in the Settings Editor’ on page 137). When the history queue
is enabled, the printed jobs can be seen.

The key operator selects the length of time that the jobs are stored in the history
queue after printing, and how many jobs are stored in the history queue.

The ‘Rights for printing’ setting has two values:

= 'Everyone', everybody can print or reprint jobs from the ‘Inbox’ queue.

m 'Special user', only the key operator or the repro operator can print from the
‘Inbox’ or the ‘history queue’.

Note: If you use the print job setting 'As in ticket' you need Océ Print Exec®
LT to print the job.
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Chapter 8
Océ Power Logic®: System
Control Panel

This chapter describes how to view the status of the Océ
TDS600.
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Introduction

The Océ System Control Panel (SCP) application provides you with status
information about the system. This includes:

m Status of the printer

m Overview of the loaded media types and sizes

m Status of the scanner

m Status of the controller

= Memory usage.

Note: If you do not have a scanner, the scanner status is not available. If you
have a scanner only, the machine status of the printer and the overview of the
loaded media is not available.

Structure

150

The System Control Panel window is divided into the following parts (see
Figure 84 on page 152):

The menu bar which contains the following menu’s:

= File - Logon, Logoff, Connect to and Exit.

= Edit
If you select this option a window is displayed in which you can view your
default system for the System Control Panel application. The ‘Automatic
logon’ option allows you to start the application automatically in the
indicated user mode.

m View
The View menu allows you to switch between the display languages as
defined in the Edit options window and to enable or disable System Control
Panel sub windows.

m System
The System menu allows you to dump your configuration settings, make a
demo print, clear the system and shut down the system.

= Help options: Contents of the Océ System Control Panel, About the Océ
System Control Panel.

m Toolbar
The toolbar of the Océ System Control Panel contains the following buttons:
Printer: to hide or to show the status of the printer.
Media: to hide or to show media information.
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Scanner: to hide or to show the status of the scanner.

Controller: to hide or to show the status of the controller.

Memory: to hide or to show the amount of set memory that is used.
Note: If operator invention is required for a device, the respective button
flashes.

The Printer status window Displays the current status of the Printer. Any error
messages displayed on the printer control panel also appear in the printer status
window of the System Control Panel.

The Media display Provides graphical information about the status of the rolls
and sheetfeeders (available, empty or disabled) of the printer and about the
available media (size and type).

Note: If the Media type equals polyester, the thickness is expressed in mil
(0.001"), otherwise the weight is expressed in g/m?2.

When a roll or tray is disabled the roll icon is dimmed and the media
information is replaced by the text “-disabled-" (see ‘Icons’ on page 152).

Note: Special media are excluded from the automatic behavior of the Océ
Power Logic® Controller.

The Scanner status display Displays the current status of the scanner. Any
error messages displayed on the scanner control panel will also appear in the
scanner status window of the Océ System Control Panel.

The set memory meter Indicates how much of the set memory is filled. The

information is displayed in the form of a meter which is divided into three

zones:

= Green: safe, you have enough space left to print large jobs/many small jobs

m Orange: pay attention, you might reach the set memory limit soon

m Red: the set memory is (nearly) full; you should remove files or wait until
files are printed and automatically removed or flushed from memory. No
more print jobs are accepted. You can still perform copy jobs.

Note: At the right of the set memory meter a percentage is displayed,

indicating the amount of set memory currently being used.

Set the threshold values for the orange and red zones in the Océ Settings Editor
(see ‘Find system settings in the Settings Editor’ on page 137).

Below the Océ System Control Panel main window is displayed:
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B! Dcé System Contiol Panel HE K
File Edit Wiew System Help
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Printer Media | Scanner |Caontroller | Memory

é Sleeping

@ (=7 1: E+ (38") Paper 75 gim2 (=7 2 E+ (38") Paper 75 gim2

== Sleeping

7 Ready

(= [ | 0%

== ta18-madrid | | Key operator
EEr e
[84] System Control Panel window

Note: You can hide the media by de-selecting it in the View menu option.

Icons

152

The Océ TDS600 System Control Panel uses a number of icons to display
information about the media available on the printer. The following icons are
used:

@ The material is available and the roll is ready for printing.

The roll is disabled.

©O)

The roll is enabled but empty.

The material is available in portrait orientation and the sheetfeeder
is ready for printing.

i

The material is available in landscape orientation and the
sheetfeeder is ready for printing.

The sheetfeeder is empty and material should be loaded in portrait
orientation.

15
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$ The sheetfeeder is empty and material should be loaded in
landscape orientation.

The sheetfeeder is disabled.

-]
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User operations

154

The Océ System Control Panel allows you to perform the following operations:
= Make a demo print

m Print your system configuration

m Clear the system

m Shut down the system

Make a demo print

Select the Demo print option in the System menu.
A demo print is made on the printer.

Print your system configuration
Select the Print settings option in the System menu.
A list is printed of the current settings on the Océ Power Logic® Controller.

Clear the system

Select the Clear system option in the System menu to delete all jobs.

You can use this option in case of a corrupt job which can not be deleted with
the Océ Queue Manager.

Note: This option is only available in repro operator, key operator and
system administrator mode. In anonymous user mode it is not possible to
clear the system.

Shut down the system

Select the Shut down option in the System menu to shut down the system.
This option is only available in repro operator, key operator and system
administrator mode. In anonymous user mode it is not possible to shut down
the system.
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Chapter 9
Océ Power Logic®: Remote Logic

This chapter describes how to install and use Océ Remote
Logic®.
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Introduction

156

Océ Remote Logic® enables you to:

m View system status (Océ System Control Panel).
m Manage print jobs (Océ Queue Manager).

m Change settings (Océ Settings Editor).

Océ Remote Logic® has five different user modes (see ‘User modes’ on
page 163). These user modes are meant to limit access to the special functions
to authorized users. Log on to get access to one of the user modes.

Change the display language, to operate the Océ Remote Logic® in your
language. Use the help system if you do not know how to use the applications.

Océ Remote Logic® is available on the local host and as a remote version
except for Océ Scan Manager which is only available on the local host.

Océ Remote Logic operates separately. You have to log on and select a
language in each application.
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Installation procedure for MS Windowse
systems

Before you install Océ Remote Logic®, you must take note of the following
minimum system requirements for the remote system. The system must be a
Pentium® 233 with 32 Mb RAM running Windows® 95, 98, NT® (service pack
3) , Windows® 2000 or XP. Contact your local Océ organization for more
possible systems.

Océ Remote Logic® (Océ Queue Manager, Océ System Control Panel and Océ
Settings Editor) are on the Océ TDS600 CD-ROM and on the Océ Power
Logic® Controller CD-ROM provided with the system. The installation
procedure for the Océ Remote Logic® is quite simple and self-explanatory.
When you select the ‘Install remote applications’ option on the CD-ROM, a
Wizard starts to guide you through the installation process. When the
installation process is complete you do not have to restart your system.

Note: Océ Remote Logic® only works when TCP/IP is enabled on your system.
Refer to your system administrator for assistance with the installation
procedure for TCP/IP.
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Install Océ Remote Logic®

Insert the Océ remote Logic® CD-ROM or the Océ Power Logic® Controller
CD-ROM into the CD-ROM drive of your PC.

Select the ‘Install remote applications’ option.

The installation Wizard starts, and asks to select a setup language.

Choosge Setup Language

Select the language for this installation from
the choices below.

ak I Cancel |

[85] Choosing a setup language

Indicate the required language and click ‘OK’.
Follow the instructions on screen to complete the installation of ‘Océ Remote
Logic®’.

When the installation is complete, you can start the applications by selecting
them from the specified folder in the ‘Start’ menu.

To work with the applications you first have to connect to an available Océ
TDS600 machine. How to connect is described in ‘How to use the remote
system’ on page 169.

If you plan to work with more than one of the available remote applications,
you are advised to use the ‘Application Launcher’, because this uses less
system resources than the individual applications.
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Installation procedure for Unix systems

Océ Remote Logic® is set up to be platform independent. It runs on a variety
of operating systems providing that a Java™ runtime environment is available
for that platform. The Java™ runtime environment must be installed by a user
with system administrator privileges. It is also assumed that Océ Remote
Logic® is installed by an experienced user.

UNIX versions and the required JRE

UNIX version OS version JRE |Default installation directory
IBM AIX 4.1.5 1.1.6 |/usr/jdk_base
IBM AIX 4.2.1 1.1.8 |/usr/jdk_base
IBM AIX 4.3.3 + fix 1.2.2  |/usr/jdk_dev2
IBM AIX 4.3.3.10 + fix 1.3.0 |/usr/jdk_javal30
SUN Solaris® 2.6 1.1.6

HP-UX 10.20 1.1.3

LINUX 1.0 1.1.3

LINUX 1.2 1.1.8

Note: OS = Operating System, JRE = Java™ Runtime Environment

[86]

Install Océ Remote Logic®

Check whether a Java™ runtime environment (JRE) is installed on the system.
The preferred version is JRE 1.1.8. Below you can find some links to JRE’s for
various UNIX platforms.

Unpack the contents of the file ‘RemoteLogic_vX.tar’, from the directory
Products/remotelogic/UNIX, to a subdirectory on the system.

Use ‘tar xvf RemoteLogic_vX.tar’ to unpack.

Set the environment variable ‘RL_VM_HOME’ to point to the installation of
the JVM.

Run the file ‘remotelogic’ with the applications as parameters. (e.g.
remotelogic QM SCP SE to start the three applications), or use ‘remotelogic
AL, for the application launcher.

Note: If you do not supply any options, a short help text is displayed.
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IBM AIX

For the various versions of IBM AIX, Java™ runtime engines can be
downloaded from:
http://www.ibm.com/java

The preferred version of the Java™ runtime engine for use with Océ Remote
Logic is the 1.1.8 version.

HP-UX
For HP-UX 10.20 and 11.00 the runtime engine can be downloaded from:
http://www.unix.hp.com/java
The preferred version of the Java™ runtime environment for HP-UX 10.20 and
HP-UX 11.00 is version C.01.18.xx.

Linux

IBM has a runtime engine available for Linux which can be downloaded from:
http://www.ibm.com/java
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Installation procedure for other systems

In general, Océ Remote Logic® can run on any system with a Java™ Virtual
machine.

v Steps to install Océ Remote Logic® in general

1 Install Java™ Virtual machine (preferred 1.1.8 (or higher)).

2 Extract ‘RemoteLogic_vX.tar’ or ‘RemoteLogic_vX.zip’, from the Océ
Remote logic CD-ROM.

3 Set the environment variable RL_VM_HOME to point to the Java™ VM
installation directory.

4 If needed, edit the remote logic script (tar file) or batch file (zip file).

5 Use remotelogic script or batch file to start the applications.
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Use Océ Remote Logice

162

Océ Remote Logic® enables you to:

m View the system status (Océ System Control Panel).
m Manage print jobs (Océ Queue Manager).

m Change settings (Océ Settings Editor).

Océ Remote Logic® has five different user modes. These user modes are
meant to limit access to the special functions to authorised users only. Log on
to get access to one of the user modes.

Change the display language, to operate Océ Remote Logic® in the language
of your selection. Use the on-line help system if you do not know how to go on
with the applications.

The Océ Remote Logic® applications can operate separately. If you start the
applications separately, you have to log on and select a language in each
application. If you start the applications via the ‘Application Launcher’, the
language is selected automatically.

Note: The default language is English US

Start the Océ Remote Logic® applications via the ‘Start’ menu or via the
‘Application Launcher’ application.

Start Océ Remote Logic® on a remote workstation

1 Select 'Océ Remote Logic' via the 'Start' menu.
2 Select ' Application Launcher'.
3 Select the required application from the ‘Application Launcher’.
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User modes

The following user modes are available:
= Anonymous user mode

m Repro operator mode

m Key operator mode

m System administrator mode

m Service operator mode

The anonymous user mode only offers monitoring capabilities. You are not
allowed to change anything.

The repro operator, the key operator and the system administrator modes allow
you to perform a number of user actions.

In the Océ Queue Manager and the Océ System Control Panel the repro
operator, the key operator and the system administrator have the same user
rights. The repro operator, the key operator and the system administrator
modes allow you to perform a number of activities on the jobs in the queue,
with the help of the Abort, Delete, Resume and Hold buttons.

In the Océ Settings Editor, however, the user modes offer different rights. In
repro operator mode, the operator is allowed to only view settings in the key
operator and system administrator views.

In key operator mode, the operator is allowed to view and change settings in
the key operator view. The key operator is also allowed to view system
administration settings, but is not able to change them.

In system administrator mode, the operator is allowed to view and change
settings in the system administrator view. The system administrator is also
allowed to view key operator settings, but is not able to change them.

The service operator mode is meant for the Océ technician.

When you are not authorised to perform a certain action, the action is grayed
out.

Note: The status bar at the bottom displays the active user mode.
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Log on

A ON =

The access to the key operator, repro operator, system administrator and
service operator modes is password protected to allow only authorised
personnel to use particular functions.

The default password for the System Administrator is: SysAdm.

The default password for the Key Operator is: KeyOp.

The default password for the Repro Operator is: ReproOp.

Note: The default passwords are case sensitive. Change the passwords after
your first logon.

How to log on

From the ‘File’ menu, select ‘Log on’.
Select the correct user name.

Enter the Password.

Click ‘OK’.

Note: You must log onto each application separately.

Log on is restricted to one user only. When a second user attempts to log on an
error message will appear (see figure below).

Error

fou cannot log in hecause kKey operator
is already logged in on system: BOSTOROT

[87] When a second user attempts to log on an error message will appear

Log off

164

You have to log off to leave the key operator, repro operator and system
administrator modes.

How to Log off

From the ‘File’ menu, select ‘Log off’.
You return to anonymous user mode.
Note: You must log off from each application separately.
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To change the password

O s WN =

You can change your password on a standard base. You can change the
password for each user mode (except anonymous user mode, for which no
password is required and service operator) by taking the following steps:

Change the password:

From the ‘File’ menu, select ‘Log on’.

Click the ‘Password’ button.

Select the correct username in the ‘Username’ drop-down list box.

Enter the old password in the ‘Password’ text box.

Enter the new password in the ‘New password’ text box.

Enter he new password in the ‘Confirm new password’ text box and click ‘OK’
to confirm the new password.

Automatic logon

w

If you do not want to log on each time you start an application, you can select
the automatic logon function. This option allows you to start an application
automatically in the indicated user mode.

Enable automatic log in

From the ‘Edit’ menu, select ‘Options’.

The Options window appears.

Select the ‘Enable automatic logon’ check box.

Select the correct user mode and enter your password for that user mode.
Click ‘OK’. Automatic logon is now enabled.
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Language

From the ‘View’ menu, select ‘Language’, to select one of the supported
languages.

Note: The check mark in front of the language indicates that this is the active
display language.

v Set the languages
1 From the ‘View’ menu, select ‘Language’.
You have to change the display language setting in the Océ Settings Editor, to
change the languages in the scanner and printer operator panels, and in the
local applications (see ‘Find system settings in the Settings Editor’ on
page 137).

Help

v Display help information
1 Open the ‘Help’ menu and select ‘Contents’.
Now you can find help for all functions of the Océ Remote Logic®
applications.

Command line parameters

In order to start the remote applications faster, there are 6 command line
parameters available.

configfile=<config_file> Sets the configuration file to use.
server=server Sets the specified server as the server to connect to.

languagel=lang Specifies the first language in combination with the
parameter ‘country l=country’.

countryl=country Specifies the first language in combination with the
parameter ‘languagel=language’.

language2=lang Specifies the second language in combination with the
parameter ‘country2=country’.
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country2=country Specifies the second language in combination with the
parameter ‘language2=Ilanguage’.

Note: You must always use a matching combination of ‘lang’ and ‘country’
(see table on page 167).

Language
Language Language Country
parameters
Danish da DK
Czech cs CZ
Spanish es ES
Finnish fi FI
Hungarian hu HU
Italian it IT
US English en UsS
UK English en GB
Dutch nl NL
German de DE
French fr FR
Portuguese pt PT
Norwegian no NO
Swedish sV SE
Polish pl PL
Japanese ja JP
Chinese cn CN
Simplified
Chinese cn ™
Traditional
[88]

The parameters can be applied to the following applications:
m QM.exe (Océ Queue Manager)

m SCP.exe (Océ System Control Panel)

m SE.exe (Océ Settings Editor)

m AL.exe (Application launcher)

Note: These executables are usually located in ‘C\Program Files\OceRemote
Logic\Bin’.

The easiest way to do this is by creating a short-cut of an application and then
add the command line properties.
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Example command line parameter Below is an example of how to start the
Océ Remote Logic applications with the configuration file ‘Myconfig.cfg’,
connected to the ‘MyTDS600’ server. The first language is set to US English
and the second to French:

‘C\Program Files\Remote Logic\Bin\AL.exe -configFile=Myconfig.cfg
server=MyTDS600 languagel=en country1=US language2=fr country2=FR’.
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How to use the remote system

Start up the Océ Remote Logic® applications (Océ Settings editor, Océ Queue
manager, Océ System control panel), on a remote client after you installed the
software (see ‘Installation procedure for MS Windows® systems’ on

page 157). In order to use the functionality you first have to add an Océ Power
Logic® controller and then connect to an available Océ Remote Logic
controller.

v Add an Océ Power Logic controller

1 Open the ‘File’ menu and select ‘Connect to’.

A dialog box will appear with a drop-down list box containing the already
added Océ Remote Logic® systems.

2 Click ‘Edit...’. The ‘Edit systems’ dialog box appears.

3 Enter the IP address or the host name of the Océ Remote Logic® system you
want to connect to, in the ‘Systems’ text box.

4 Click ‘Add’. The system is added to the list. You can add as many systems.
Note: You can also remove an Océ Remote Logic® system. Select one in the
list and click ‘Remove’.

5 Click OK twice to return to the application.

Note: Before you can add a system, the system has to be installed and
configured by a system consultant or a technician.

v Connect to an Océ Power Logic controller
1 Open the ‘File’ menu and select ‘Connect to’.
A dialog box will appear containing a drop-down list box with the available
systems.
2 Select one of the available systems and click on ‘OK’. When you connect to
another system, all settings have to be retrieved. This may take some time.
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Chapter 10
Océ Account Center

This chapter describes what account logging is and how to
use it.



Introduction

172

Océ Account Center is an application to manage the account information of the
print, copy and scan-to-file jobs. Océ Account Center consists of the following
two applications.

m Océ Account Logic.
Océ Account Logic requests the operator and the user to enter account
information. The operator can enter the account information at the Océ
Power Logic® controller for the copy and scan-to-file jobs. The user can
enter the account information at the workstation for the print jobs. Océ
Account Logic runs on the Océ Power Logic® controller and is available
through Internet browser (see ‘Océ Account Logic’ on page 173).

m Océ Account Console.
Océ Account Console provides options to manage the account information.
The system administrator uses Océ Account Console to define the contents
of the account information in the dialog boxes at the Océ Account Logic
application. Océ Account Console runs on the workstation of the system
administrator. Access to Océ Account Console application is password
protected and limited to the system administrator (see ‘Océ Account
Console’ on page 175).
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Océ Account Logic

Introduction to Océ Account Logic

Use Océ Account Logic to link account information to your job. The account
information requirements are defined and managed by the system
administrator. Use Océ Account Logic for the following:

= Enter the account information for the print jobs

m Manage print jobs that do not have valid account information
= Enter account information for the copy and scan-to-file jobs

m Lock and unlock the scanner
m Administer Océ Account Logic (administrators only).

Océ Power Logic® controller setup

Before you begin to use Océ Account Logic, you must define the correct
settings in the Océ Settings Editor.

System setting

Reference on

Path in Settings Editor

IKO - System - Enabling
passwords - Advanced
Queue Manager

[Use the correct password
to enable the ‘Advanced
Queue Manager’

IAdvanced Queue
Manager adds

the ‘Inbox’ feature to the
Océ Queue manager.
Océ Account Logic
requires that you use
the ‘Inbox’.

IKO - System - Enabling
passwords - Account
logging

Use the correct password
to enable account

logging.

Before you can use Océ
IAccount Logic, enable
laccount logging on Océ
IPower Logic® controller

Océ Account Center
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System setting

Reference on

Path in Settings Editor

IKO - System - Job
management - Print jobs

Select ‘Jobs in inbox’.

Océ Account Logic
requires that all jobs are
send to the ‘Inbox’.

Note: The print jobs that
have valid account
information are
automatically moved from
the Inbox to the Print queue.
[Enter the account
information for the print
jobs that do not have valid
laccount information on the
‘Print’ tab of Océ Account
ILogic.

IKO - System - Job
imanagement - Rights for

Select ‘Special user’.

Océ Account Logic is a
special user on the Océ

printing IPower Logic®
controller.
KO - Scanner - Settings -  |Océ advises you to set When the check box

Timers - Panel timeout

the panel timeout to the
minimum value (30
seconds).

“The scanner locks when
the scanner panel
timeout expires " is
checked in the ‘Define
the account information
requirements for the
jobs’ section of the
administration window,
the user is required to
unlock the scanner for
the copy jobs and
scan-to-file jobs. The
scanner locks when the
scanner panel timeout
expires.

Note: Please consult the Océ Account Center user manual and the on-line help
in the application for detailed information.

Océ TDS600 User Manual




Océ Account Console

Introduction to Océ Account Console

Océ Account Console is installed on a PC that functions as a server. Access to
Océ Account Console is password protected and limited to the administrator.
Use Océ Account Console for the following.

m Manage, preview, and publish the account information dialog for Océ
Account Logic
m Retrieve and export the log files.

Summary of Océ Account Console

Océ Account Console has the following three sections.

m The ‘Account fields’ tab
Use this tab to create, manage, preview, and publish the ‘Account
information’ dialog for Océ Account Logic.

m The ‘Account data’ tab</ptxt>
Use this tab to define the devices from where the log files are retrieved.
Use this tab to export the log files.

m The ‘Administration’ window.
Use this screen to define the administrative settings for the application, and
to change the password for Océ Account Console.

Note: Please consult the Océ Account Center user manual and the on-line help
in the application for detailed information.
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Chapter 11
Media and Supplies

This chapter describes how to:

m Load paper
m Add toner
m Change tape in the reinforcement unit

177



Media

178

The Océ TDS600 is available in many configurations, ranging from two rolls
in a single drawer, four rolls in two drawers plus three cassette tray and a
maximum of six rolls with one cassette tray.

Note: Contact your Océ representative if you want to know more about the
available configurations.

Each of the rolls and cassette trays on the Océ TDS600 may be loaded with
media of a different size or type. The size and type of the available media are
indicated on the operator panel.

Note: In case you have three cassette trays, no A4 size material and no A3
landscape material can be used in the bottom cassette tray. The minimum size
of media in the third cassette tray is A2.

Attention: After loading new media, you need to inform the system of the
size of the media and of the type of media that was loaded (paper,
transparent, or polyester).

The definition of the size and type of the new media is required to:

= Enable the automatic media switch function to work correctly
m Prevent folding errors (when a folder is installed)
= Support autozoom and auto format functions.

Caution: It is highly advisable to place heavy rolls (for example, AO, Al,
and 175 meter rolls of plain paper) in position 1 of the top drawer, position
3 of the middle drawer or position 5 of the bottom drawer, to minimize user
strain. The diameter of rolls should not exceed 185 mm.
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Load rolls of media

When a roll is empty during a print job, a ‘Roll empty’ message is displayed
at the printer operator panel and on the Océ System Control Panel application.
You then have to load a new roll of media.

Note: Currently, the following media are supported on the Océ TDS600:

m Plain paper (Red label plus) 75g/m2
m Plain paper (Red label) 110g/m2

m Transparent paper 90—95g/m2

m Polyester film (CPRF) 3.5mil

m Polyester film 4.5mil

m vellum (9020/9022) 201bs.

Caution: See appendix B for more information about safely handling and
placing rolls of media in the printer.

v Load media

1 Open the appropriate roll compartment (see Figure §89).

[89] Opening the appropriate roll compartment

2 If necessary remove any scrap material from the paper roll compartment.
3 Remove the roll holder from the paper roll compartment.
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4 Press the green knob inside the roll holder (on the right side) to release the
locking mechanism (see Figure 90) and remove the core from the holder.

[90] Pressing the green knob

Note: You can place the new roll in the groove on top of the printer.
5 Slide the roll holder in the new roll of material while pressing the green knob.
6 Align the roll with the appropriate size indicator on the roll holder and release
the locking mechanism. This line has to be completely visible.
7 Use both hands to place the holder in the roll compartment (see Figure 91).

[91] Positioning the roll
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8 Use both hands to slide the material under the metal paper guide until it makes
contact, as shown in figure 92.

[92] Using both hands to load the material

Note: When the media is particularly curled it may be somewhat difficult to
slide the material under the paper guide. In that case you can slightly fold back
the top few centimetres (no more than 10) of the media to facilitate the load
process.

9 Press the appropriate green key inside the paper roll compartment (see
Figure 93). The material will automatically be fed into the machine.
Also refer to the sticker inside the drawer.

Feed/cut
buttons

[93] Buttons for feeding and cutting the paper

10 Press the green button a second time to cut off the material protruding from the
paper path.

11 Remove the scrap material.

12 Close the roll compartment.
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v Define the media type and size
1 Press the ‘On-line’ key on the printer operating panel to put the printer
Off-line. The message ‘Off-line’ is displayed in the status window.
Press the left selection key to shift the focus to the media selection.
Use the arrow keys to select roll 1, to 6 (see Figure 96).
Press the right selection key to select the setting you want to define.
Use the arrow keys to define the settings.
Note: Media sizes of both the DIN and ANSI paper series are available. Use
the arrow keys to select either a DIN or ANSI format.
6 Put the printer On-line again by pressing the ‘On-line’ key.
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[94] To set the correct media

Note: You only have to adjust the settings on the operator panel when you alter
the size or media type.

Roll loader In order to help customers to comply with the international safety
regulations as far as maximum roll weights are concerned, Océ has developed
aroll loader for use with the Océ TDS600. See ‘Recommended weight limits’
on page 256 for more information about the maximum recommended roll
weights with and without a roll loader.
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Use the optional roll loader to load a roll

1 Fully open the roll compartment.
Inside the drawer, the roll loaders are installed. The roll loaders consist of a
metal frame with a lever and a green knob in the middle of the lever.

2 Put the appropriate horizontal lever in an upright position by pulling it to the
right.

3 Pull the lever completely forward. The roll holder is lifted up (see Figure 95).

[95] Lifting up the holder with the roll loader

4 Remove the roll holder from the paper roll compartment using both hands.

5 Press the green knob inside the roll holder to release the locking mechanism
and remove the core from the holder.
Note: You can place the new roll in the groove on top of the printer.

6 Slide the roll holder in the new roll of material while pressing the green knob.

7 Align the roll with the appropriate size indicator on the roll holder and release
the locking mechanism. This line has to be completely visible.
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8

9

10

1

12

13
14
15
16
17

18

Use both hands to place the holder in the roll loader (see Figure 96).

[96] Placing the new roll in the roll loader

Place the holder back in the roll compartment by returning the roll loader lever
to its upright position. The roll will now be loaded.

Caution: Be careful when lifting the lever to avoid any possible damage to
the roll compartment.

Use both hands to slide the material under the metal paper guide until it makes
contact, as described in the procedure for loading rolls of media.

Press the appropriate green key inside the roll compartment. The material will
automatically be fed into the machine.

Note: Also refer to the sticker inside the drawer.

Press the green key a second time to cut off the material protruding from the
paper path.

Remove the scrap material.

Return the roll loader lever to its starting position by pushing it to the left.
Close the paper roll compartment.

Press the on-line key to put the system off-line.

Specify the size and type of material on the operator panel

Note: Both DIN and ANSI paper series are available on the operator panel.
Press the on-line key again.

Note: When you alter the size or media type, you have to manually adjust the
settings on the operator panel.
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Cut sheet material

When a sheet feeder is empty during a print job, a ‘Sheet feeder x empty’
message is displayed at the printer operator panel and in the Océ System
Control Panel (SCP) application. You then have to load new cut sheet media.

Note: You must fan polyester cut sheet before use to prevent sticking together.
Also avoid the use of sheets that have already been printed on one side.

v Load cut sheet material
1 Open the appropriate drawer (see Figure 97).

[97] Opening the appropriate drawer
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Release the right hand guide by squeezing the light green release handle on the
guide (see Figure 98) and move the guide to the required media size indicator.
Note: Make certain that the handle is properly aligned with the appropriate
indicator.

guide
release
handles

view holes

@ I ~
[98] Adjusting the position of the right hand guide

Remove the packaging of the media. In case of wrapped paper, also remove the
top and bottom sheets.

Note: If you use polyester as media you have to fan the sheets before you
load them to avoid that they stick together.

Position the media in the drawer against the front plate. The side to be printed
should be facing downwards.

Note: You can check if the material is properly loaded by looking through
the view holes in the drawer (see Figure 98).

Adjust the right hand guide.

Note: Carefully place the media in the drawer to avoid damage to the
media.

Slide the two other guides into position.

Also refer to the sticker inside the drawer.

Close the drawer.

Note: When you alter the size or media type, you have to manually adjust the
settings on the operator panel.

Attention: [f you decide to reload media when the drawer is not entirely
empty, it is recommended to remove all remaining media from the drawer
before you insert the new media. This way you can avoid the risk of
inadvertently shifting any remaining media out of place and blocking the
path. This could result in a jam.

Océ TDS600 User Manual



Add the toner

When a ‘Toner low’ message appears on the printer panel, you should refill
toner. From this moment on, you can print a maximum of 260 m2.

Refilling toner can be done at any time, even while a job is printing. You will
be able to finish your current job.

If you do not refill toner in time, the system will stop and an ‘Out of toner’
message will appear. In that case, printing will only be resumed after you have

refilled toner and pressed the on-line key.

Note: Before you refill toner, always make certain that you first replace the
waste toner bag.

v How to add toner
1 Open the left cover of the printer (see Figure 99).

=
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2 Pull the waste toner bag from the holder and place the supplied cap on the bag.

[99] Opening the left printer cover
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3 Slide a new waste toner bag as far as possible over the holder (see Figure 100).

[100] Replacing the waste toner bag

Attention: Use only Océ B5 toner.

4 Shake the toner bottle thoroughly and open the bottle.
5 Screw in the bottle clockwise in a slanted position (see Figure 101).

\4.'”

hl'

[101] Screwing in the bottle
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6 Move the toner bottle to a vertical position (see Figure 102).
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[1 02] Adding toner

7 Tap the bottle to remove the toner from the bottle.

8 Return the bottle to its original position when the toner bottle is empty.

9 Unscrew the toner bottle anti-clockwise and close it.
10 Close the cover.
Printing will be resumed after you press the ‘on-line’ key.

When you have refilled toner after the system had stopped because it was out
of toner, you have to confirm the refill operation by pressing the On-line key.
The ‘Out of toner’ message will then disappear. When you have refilled toner
after a ‘toner low’ message, it will take up to thirty seconds, depending on the
number of prints that you make, before the ‘toner low’ message disappears.

Media and Supplies
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Chapter 12
Maintenance

This chapter describes the maintenance of the glass platen
the reference roller and the reinforcement unit.



Maintenance of the glass platen and the
reference roller

If the glass platen is dirty or static, it should be cleaned to ensure top quality
output. At the same time you can clean the white reference roller.

Attention: When you clean the reference roller, be careful not to damage the
sensors on the scanner.

v Clean the glass platen and reference roller
1 Turn off the scanner.
2 Open the top cover of the scanner (see Figure 103).

[103] Opening the top cover of the scanner
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3 Clean the glass platen with a soft cloth moistened with water (see Figure 104).
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[104] Glass platen and reference roller

4 Clean the white reference roller with soft cloth moistened with a small quantity
of Cleaner A (see Figure 104).

5 Lift the top cover of the scanner to release the lock of the hinge, and close the
cover (see Figure 105).

[105] Closing the top cover of the scanner

6 Turn on the scanner.
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Maintenance of the reinforcement unit

This section covers maintenance activities for the optional reinforcement unit
of the folder, such as:

m Insert a new tape roll

= Empty the waste box

m Clean the reinforcement knives

Attention: To avoid damage to the reinforcement unit, only use the original
reinforcement strips from Océ.

A new tape roll

194

When the tape roll is empty while the printer is in stand-by, one of these
messages will appear on the display:

m ‘Load reinforcement tape’
= ‘Reinforcement unit empty’ (if the printer was running when the roll ran out
of tape).

When a tape roll is empty while the printer is running, this message will be
accompanied by a picture of the printer with the side door of the reinforcement
unit blinking (see Figure 106).
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[106] No tape in reinforcement unit

How to remove an empty tape roll
1 Open the side door of the reinforcement unit (see Figure 107).

@¢]%

[107] Opening the side door of the reinforcement unit
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2 Turn the two guide plates away from the pin roller and lock them into their
open position (see Figure 108).

[108] Opening the guide plates

3 Remove the trailing strip of the old tape (see Figure 109).

[109] Removing the trailing strip of the old tape

4 Open the front side plate of the roll holder by unscrewing the green knurled nut
and remove the old kernel.
Note: Clean the reinforcement knives before you put in a new roll. See
‘Maintenance of the reinforcement knives’ on page 204 for more
information.

196 Océ TDS600 User Manual



How to insert a new tape roll
1 Place the new roll and close the side plate. Make certain that the roll is placed
with the holes to the back and the protection sheet to the front (see Figure 110).

[110] Placing the new roll

2 Detach the end of the roll and lead the tape over the large guide roller (see
Figure 111).
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[111] Guiding the tape around the guide roller
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3 Lead the tape between the upper and lower knife and over the pin roller (see
Figure 112).

[112] Leading the tape between upper and lower knife

4 Make certain that at least 200 mm (2 strip lengths) of tape protrude from the
knife section (see Figure 113).

[113] Protruding tape
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5 The holes in the tape must be aligned with the hole pattern on the sticker you
can find on the frame plate of the reinforcement unit (see Figure 114). If this
is not the case, you lift the tape from the pin roller and push the tape further
between the two knives until the holes are aligned.

[114] Adjusting the holes on the tape

6 Close the guide plates of the pin roller (see Figure 115).

[115] Closing the guide plates
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v How to prepare the tape roll for operation
1 Peel the protection sheet off the tape (see Figure 116).

[116] Peeling off the protection sheet

2 Lead the protection sheet back between the upper and lower knife.
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[117] Leading the protection sheet between upper and lower knife
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3 Lift the guide and lead the protection sheet between the protection sheet
rollers, pulling the protection sheet tight (see Figure 118).
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[118] Leading the protection sheet between the rollers

4 Insert the leading strip of the tape into the closed section of the slide (see
Figure 119).

[119] Inserting the tape into the closed section of the slide
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5 Hold the upper guide plate down and cut the tape at the knife section by quickly
pulling the strip up so that the tape is cut by the upper knife (see Figure 120).

[120] Cutting the tape at the knife section

6 Close the side door of the reinforcement unit.
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The waste box

If a reinforcement unit is installed, the protective sheet from the reinforcement
tape is stored in a waste box. For each roll of tape the box should be emptied
twice.

Note: You can empty the waste box while the printer is running.

v Empty the waste box

1 Open the waste box by first pulling it to the left hand side and next pulling it
towards you.

[121] Opening the waste box

2 Empty the box.
3 Close the waste box by first pushing it forwards and next pushing it to the right
hand side.

[122] Closing the waste box

Maintenance 203



Maintenance of the reinforcement knives
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Because the knives of the reinforcement unit get sticky from the glue on the
reinforcement tape, they have to be cleaned regularly. You are recommended
to clean the knives each time you have inserted a new tape roll (see ‘A new tape
roll’ on page 194) or when an error in the reinforcement unit has occurred.

If you want to clean the reinforcement knives, you have to place them in such
a position that all the parts that need to be cleaned are accessible.

Attention: Only use the original Cleaner K and Fixing Unit Cleaning Oil
(silicon oil) from Océ, to avoid damage to the reinforcement unit.

Clean the reinforcement knives

Press the on-line key on the printer operator panel to put the printer off-line.
The message ‘Off-line’ is displayed in the status window.

Press the left selection key to shift the focus to the ‘Folding’ menu.

A shadow effect is used to indicate that the focus is set to this menu.
Select the ‘Clean knives’ option from the ‘Folding’” menu.

Then the reinforcement knives are placed in the correct position.

Note: When a job is running, the message ‘Job interrupted’ appears. The
machine stops running after it has correctly finished the prints that were
already printing.The focus can now be set to the Folding menu.

A picture of the printer appears on the display with the side door of the
reinforcement unit blinking.

4 Open the side door of the reinforcement unit.
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5 Clean the upper and lower knife using Cleaner K (see Figure 123).

[123] Cleaning the upper and lower knife

6 Oil the felt using Fixing Unit Cleaning Oil (silicon oil).

[124] Oiling the felt

Close the side door of the reinforcement unit. The knives are automatically
placed back in their home positions. The picture on the display disappears, and
the message ‘Press start to resume job’ or ‘Ready to print’ appears, depending
on whether or not a job was interrupted to clean the knives.
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Chapter 13
Problem solving

This chapter describes the problems that can occur when
you use the Océ TDS600.
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Introduction

208

Problems can be:

m Original jams

m Paper jams

m Problems with the reinforcement unit

m Problems that you can correct if you follow the instructions on the display
m Other problems like Call Service.

When an error occurs, the display informs you about
m what the problem is

m where it has occurred

= how to solve it.

An attention light will flash when operator attention is required.

Normally the paper moves through the system without problems. On the
graphic display a cover or door indicates in which part of the system the paper
has stopped.

Stickers on some parts of the system indicate which green handles, green
knobs, green bars and covers, etc. you have to lift, press or open to remove any
jammed paper.

The display guides you through a sequence of steps to correct the problem. If
ajam occurs in more than one location, the display will continue to instruct you
until all jammed paper has been removed.

If you corrected the error, the display gives instruction you how to continue the
job.
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How to clear original jams

When an original jam occurs on the scanner, the message ‘Original jam’
appears on the scanner display. You must remove the original from the scanner.

v Remove a stopped original

1 Open the top cover of the scanner (see Figure 125).

[125] Opening the top cover of the scanner

2 Remove the original.
3 Lift the top cover of the scanner to release the lock of the hinge, and close the
cover (see Figure 126).

[126] Closing the top cover of the scanner

4 Make the original smooth and feed the original.
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If an original jam occurs often:

m Check if you use the correct type of original.

m Check if you insert the original along the guide.

m Check if the original is damaged before you insert it.

Note: When you are working with poor-quality or valuable originals, you are
advised to disable the rewind function to avoid the risk of jams during rewind.
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How to clear paper jams

When paper jams, the copy process stops and the message ‘Paper jam’ appears
in the display. The error location is shown by flashing covers or doors.

When paper jams:

m Follow the instructions on the display

m Leave the main power turned on to prevent the data loss, and correct the
paper jam as described in the equivalent chapter.

= Remove all the pieces of paper from the machine.

If a paper jam occurs often, check if:

m The media is refilled correctly

m The correct media is used, (‘List of available material types and sizes’ on
page 252)

m All the pieces of media are removed from the paper path.

Paper jams can occur in:
m The manual feed

m The fuser section

m The roll feed section

m The folder

m The reinforcement unit.
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E: Folding section

D: Fusing section
C: Manual feed

A: Cut sheet feed section B: Roll feed section

[127] Sections for jams

Paper jam in the cut sheet section

v How to clear a paper jam in the cassette tray
1 Open the appropriate cassette tray.
Note: Only one cassette tray can be open at a time.
2 Remove any jammed printing material from the paper path (see Figure 128).
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[128] Removing jammed material from the paper path

3 Close the cassette tray again.
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Note: If the cut cassette tray covers are still flashing on the display, re-check
the cassette tray section.

Paper jam in the roll feed section

v How to clear a jam in the roll compartments

1 Open the appropriate roll compartment.
Note: Only one compartment can be open at a time.

2 Remove any jammed printing material from the paper path (see Figure 128)
and, if necessary, pull back the paper and rewind it.
Note: Occasionally, a jam may occur before the printing material has been
cut. In that case, you can cut the material manually by pressing the
appropriate green load button in the roll compartment.

3 Reload the roll if the system asks you to do so.

4 Close the roll compartment again.
Note: If the roll feed covers are still flashing on the display, re-check the roll
feed section.

Paper jam in the manual feed

v How to clear a jam in the manual feed
1 Open the manual feed by tilting it towards you (see Figure 129).
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[129] Opening the manual feeder

2 Remove any jammed printing material.
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Note: If the material cannot be removed easily, you must open the cover of
the fusing section to get access to the jammed material. Otherwise, the
OPC drum may become damaged.

3 Close the manual feeder again.

Paper jam in the fuser section

214

The fusing section is indicated as section D (see Figure 127 on page 212).

Caution: During normal use the fuser must be closed. Only open it to
remove paper after a paper jam. Because of hot surfaces the operator
always has to be cautious and wear heat-protective gloves, when removing
printing material in the fuser section.

How to clear a jam in the fuser section

1 Turn off the printer.
2 Wait a few moments to let the fuser cool down.
3 Open the manual feeder to release the printing material.

Attention: If you fail to do so, the OPC drum might get damaged when you
remove jammed material.

4 Open the cover on the left side (see Figure 130).

Note: During normal use the left cover has to be closed. This is necessary to
ensure proper operation.
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[130] Opening the left side cover
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Open the fuser section cover by lifting the cover by the green handle (see
Figure 131).

[131] Opening the fuser section cover

Remove any jammed printing material from the fuser section.

Note: If the printing material is visible for the manual feed section, remove
it from the front side of the Océ TDS600 Printer.

Pull the green knob to release the fuser section cover and close the cover with
the help of the green handle.

Close the cover.

Turn the printer on again.

Paper jam at the integrated receiving tray

v

4
5

How to clear a jam at the integrated receiving tray
Open the manual feeder to release the printing material.

Attention: [f you fail to do so, the OPC drum might get damaged when you
remove jammed material.

Open the cover on the left side (see Figure 130 on page 214).

Open the fuser section cover by lifting the cover by the green handle (see
Figure 131).

Remove any jammed printing material from the Integrated Receiving Tray.
Pull the green knob to release the fuser section cover and close the cover with
the help of the green handle.
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Paper jam in the folder

When printing material feeds wrongly in section E in figure 127 on page 212
a jam has occurred in the folding section.

Any jams in the folder can occur in either the first fold section, the second fold
section, the folder transport section or the belt unit.

v How to clear a jam in the first fold section

1 Open the top cover of the folder (see Figure 132).
The green light on the right of the folder is blinking quickly.

[132] Top cover of the folder

2 Remove any jammed printing material.
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Open the cover of the first fold section (see Figure 133).

[133] Opening first fold section

Open the guide plate (see Figure 134).

[134] Opening guide plate

Remove any jammed printing material.
Close the guide plate.

Close the cover of the first fold section.
Close the top cover of the folder.
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Clear a jam in the folder transport section

1 Open the cover of the transport to the first fold delivery (see Figure 135).

[135] Opening the cover of the folder transport section

2 Remove any jammed printing material.
3 Close the cover of the folder transport section from the left side by lifting it up

and pushing the hinge away from you.

Clear a jam in the second fold section
1 Open the front door of the second fold section (see Figure 136).
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[136] Opening the front door of the second fold section

2 Remove any jammed printing material at the bottom of the second fold section.
3 Close the front door of the second fold section.
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4 If you have a belt unit, put the belt in an upright position (see Figure 137).

[137] Putting the belt in an upright position

5 Open the delivery unit (see Figure 138).

[138] Opening the delivery unit
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6 Open the guide plate with the green lever (see Figure 139).

[139] Opening the guide plate with the green lever

7 Remove any jammed printing material.
8 Open the vertical transport with the green lever (see Figure 140).
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[140] Opening the vertical transport

9 Remove any jammed printing material.
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10 Close the vertical transport (see Figure 141).
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[141] Closing the vertical transport

11 Close the guide plate.
12 Close the delivery unit (see Figure 142).

[142] Closing the delivery unit
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Clear a jam in the belt unit
1 Open the door of the belt unit (see Figure 143).

[143] Opening the belt unit door

2 Squeeze the two green knobs in the upper section of the belt unit and open the

plate (see Figure 144).
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[144] Opening the plate

3 Remove any jammed printing material.

4 Squeeze the two knobs again and put the plate in its original position.
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5 Release the green lever in the lower section of the belt unit (by slightly lifting
it and pulling it forward) to open the lower plate (see Figure 145).

[145] Opening the lower plate

6 Remove any jammed printing material.

7 Pull up the green lever again (until it locks into position) to close the plate.
8 Close the belt unit door.

9 Put the belt in its operating position by pushing it down gently.
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Problems with the Reinforcement Unit

If a reinforcement unit is installed, the following errors can occur:
m Paper jams

m Tape jams

m No reinforcement strips on the output

This section explains how these errors can be solved.

Clear paper jams in the Reinforcement Unit

When a paper error occurs, the following message is displayed: ‘Paperjam’. A
picture of the printer appears on the display with one or two doors blinking,
depending on where the jam occurs (see Figure 146).

[146] Paper jam

v How to clear a paper jam

1 Open the cover of the transport to the First Fold delivery and remove all paper
inside (see Figure 147).
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[147] Opening the cover of the folder transport section

2 Close the cover of the folder transport section.
3 Open the front door of the reinforcement unit (see Figure 148).

[148] Opening the front door of the reinforcement unit
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4 Open the top cover of the reinforcement unit and remove all paper inside (see
Figure 149).
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[149] Opening the top cover of the reinforcement unit

5 Close top cover and side door of the reinforcement unit.
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Clear tape jams in the reinforcement unit

When a tape jam occurs the following message appears on the display:
‘Reload tape in reinforcement unit’.

When a tape jam occurs while the printer is running, the message will be
accompanied by a picture of the printer with the side door of the reinforcement
unit blinking (see Figure 150).

—

v How to clear a tape jam

1 Open the front door of the reinforcement unit (see Figure 151).

@¢]%

[151] Opening the front door of the reinforcement unit
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2 Turn the two guide plates away from the pin roller and lock them into their
open position (see Figure 152).

[152] Opening the guide plates

3 Remove all tape between the rollers and knives (see Figure 153).

[153] Removing the tape

4 Lead a new trailing strip of tape between the rollers and knives.

No reinforcement strips on the output without an error message

This error occurs when there are no reinforcement strips on the output although
reinforcement is selected. This can happen when the file header (Remote
Control Format or Océ Job Ticket) contains instructions to have no
reinforcement.

If you want to process A4 formats, reinforcement can be disabled for this
format.
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Solve this error

1 Put the printer off-line by pressing the on-line key on the operator panel.

2 Open the side door of the reinforcement unit.

3 Check if there are loose reinforcement strips in the unit with the protection
sheet still on (see situation B in figure 154).

[154] Situation A: No mechanical errorSituation B: Mechanical error

4 If there are, remove the tape strips in the reinforcement unit.
Note: If the protection sheet is not on the reinforcement strip (see situation
A in figure 154), there is no mechanical error and you should insert a new
tape roll as described in ‘A new tape roll’ on page 194. If this error
frequently occurs you should call the Océ service organisation (see ‘Other
problems (call service)’ on page 230).

5 Remove all tape between the rollers and knives (see Figure 155).

[155] Removing the tape

6 Lead a new trailing strip of tape between the rollers and knives. For more
information see ‘A new tape roll’ on page 194.
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Other problems (call service)

If you have a problem that you can not correct, call the Océ service
organisation. In that case Turn off the system with the main switch and leave
the system as it is.
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Chapter 14
The Folder

This chapter describes:
u The folder
n The reinforcement unit
n The belt unit

Océ TDS600

User Manual
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Introduction

If you have a folder installed on your Océ TDS600 system, the following two
other optional features are available:

m Reinforcement unit

m Belt unit

Océ TDS600 folder

232

The Océ TDS600 can have a folder to fold your output. The output is folded
according to the selected folding width and length with a drawing method. You
can only fold paper. Polyester, transparent or vellum media cannot be folded.
When you attempt to fold polyester, transparent or vellum media, a media jam
will occur.

Belt

1]
—
Vim!~/
][]

%%"//
=

Stacker

First Fold Delivery Reinforcement
tray Folder Unit

[156] Océ TDS600folder

Standard folding settings By default, you use the standard folding settings
defined for your Océ TDS600 system by the key operator. The following
settings are available:
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Set the folded copy delivery

Press the ‘Finishing’ card in the ‘Print’ section.
Press the function key ‘Folded copy delivery’.
Select ‘Stacker’ or ‘Belt’.

Set folding legend

Press the ‘Feeding’ card in the ‘Original’ section.
Press the function key ‘Legend location’.

Select ‘Leading’ or ‘Trailing’.

In the drivers, this setting is called the ‘Folding orientation’, with the
options ‘Portrait’, ‘Landscape’ and ‘Automatic’.

Set the drawing method

Press the ‘Feeding’ card in the ‘Original’ section.
Press the function key ‘Drawing method’.

Select ‘Standard’, ‘Ericsson’ or ‘Afnor’.

Set the folded package width

Press the ‘Finishing’ card in the ‘Print’ section.

Press the function key ‘Folded package’.

Select “Width’.

Enter a range between 186 - 230 mm in steps of 1 mm; default 210 mm.

Set the folded package length

Press the ‘Finishing’ card in the ‘Print’ section.

Press the function key ‘Folded package’.

Select ‘Length’.

Enter a range between 276 - 310 mm in steps of 1 mm; default 297 mm

Set the binding strip

Press the ‘Finishing’ card in the ‘Print’ section.

Press the function key ‘Binding’.

Select binding enabled or disabled.

If you selected enabled enter a range between 15 - 30 mm in steps of 1 mm;
default 20 mm.

Set the reinforcement

Press the ‘Finishing’ card in the ‘Print’ section.
Press the function key ‘Binding’.
Select ‘Reinforce’ enabled or disabled.
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You can overrule the standard folding program with settings from the printer
driver or the scanner operator panel.

See ‘Standard folding settings’ on page 232 for complete information about
defining default folding settings.

Fold settings from the Océ TDS600 scanner operator panel

Open the ‘Feeding’ card in the ‘Original’ section and press the ‘Legend
location’ function key to select the required legend location (‘Leading’ or
“Trailing’).

Note: Make certain that your legend is always located on your left-hand
side to ensure correct positioning of the legend during folding.

Press the ‘Drawing method’ function key to select ‘Standard’, ‘Ericsson’ or
‘Afnor’ fold.

Ready to copy

Seanner

|7

i Afnor

ultiple sheets

Irnage

et i Leading i Ericsson

Sheet

.Smg]e sheet .Traﬂmg .Standard

E— ] Input mode Legend location Drawing method -
Feeding

2
3

4

5
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[157] Fold options from the scanner operator panel

Open the ‘Finishing’ card in the ‘Print’ section.

Press the ‘Folding’ function key to select ‘Full’ or ‘First fold only’ (see
Figure 158).

Press the ‘Folded package’ function key and change the length and/or width of
the folded package, as required, by using the arrow keys or the numeric keys.
If required, press the ‘Binding’ function key.

Set the required binding edge using the arrow keys or the numeric keys.

Océ TDS600 User Manual



6 Make other settings as required.
Feed the original.

irst fold only
ull i Belt
®Stacker

aff
Folding Folded copy Folded package
delivery

[158] Fold options from the scanner operator panel

Reinforce
aff

Note: You can also select a drawing method and, if needed, a folding length,
folding width and binding strip. When you change the folding length and/or
folding width, and the folder has a belt, you must also adjust the side guides of
this unit.

Maximum folding length There are maximum values for different kind of
paper. The table below shows the maximum values for three types of paper and
the possible folding methods.
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Maximum folding settings for long

prints

First fold output Stacker 2nd fold | Stacker 2nd fold| Belt 2nd fold
Paper 1 fold 2 folds 3 folds 2 folds
density [mm /inch] [mm /inch] [mm / inch] [mm /inch]
[o/m?]
60 1220/48 1220/ 48 1220/ 48 1220/ 48
75 6000 /236 2500/ 98 2000 /79 1220/ 48
110 2500/98 1220/ 48 not possible 1220/ 48

Folding settings 75 grams

Output selection

Output length

Delivery

‘Stacker’ or ‘Belt’ <25m Delivered on stacker or belt

‘Stacker’ or ‘Belt’ 25m-6m First fold only, delivered in
first fold delivery

‘Stacker’ or ‘Belt’ >6m Unfolded, delivered in IRT

length known at start

‘Stacker’ or ‘Belt’

>6m
length not known at start

Possible paper jam

‘Stacker’ or ‘Belt’

‘First fold only’ selected

<6m

Delivered in first fold delivery

‘First fold only’

>6m
length known at start

Unfolded, delivered in IRT

‘First fold only’

>6m
length not known at start

Possible paper jam

Folding settings 110 grams

Output selection

Output length

Delivery

‘Stacker’ or ‘Belt’ <122m Delivered in first fold delivery
(3 folds)

Stacker’ or ‘Belt’ <122m Delivered on stacker or belt
(2 folds)

Stacker’ or ‘Belt’ >122m Delivered in first fold delivery
<25m

Stacker’ or ‘Belt’ >25m Unfolded, delivered in IRT

Stacker’ or ‘Belt’
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Folding settings 110 grams
‘First fold only’ <25m Delivered in first fold delivery
‘First fold only’ >25m Unfolded, delivered in IRT

Oft-line folding

An important productivity feature provided by the Océ TDS600 folder is the
possibility to make off-line folds. For off-line folding the same settings can be
made as for normal folding. By default, the predefined settings in the Océ
Settings Editor for off-line folding are used. Polyester or transparent media
cannot be folded. This may result in a media jam.

off-line folding settings

Output selection Output length Delivery

‘Stacker’ or ‘Belt’ =<2m Delivered on stacker or belt

‘Stacker’ or ‘Belt’ 2m-2.5m (2 folds) |Delivered on stacker or belt

‘Stacker’ or ‘Belt’ 2m-2.5m (3 folds) |Stopped in second fold (possible
paper jam)

‘Stacker’ or ‘Belt’ >25m Unfolded, delivered in IRT

‘Stacker’ or ‘Belt’

‘First fold only’ <6m First fold only, delivered in first
fold delivery

Note: Use off-line folding only for sheets which do not exceed a maximum
length of 6 m. If you try to fold a sheet longer than 6 m anyway, an error occurs.

Make off-line folds

Switch the printer off-line on the printer operator panel and wait for the printer

to finish the jobs that are already in the printer.

Note: Watch the light on the top cover of the folder.

m If this is off, the printer is on-line and off-line folding is not possible.

m If this is blinking slowly, the printer is off-line, but the folder still processing
the last prints.

m If this is blinking rapidly, an error has occurred.

m If this is on, the printer is off-line and you can feed a sheet.

Note: Also refer to the sticker on the top cover of the folder.

Make any settings for (off-line) folding on the printer operator panel.
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Note: If required, the key operator can change the default settings for
folding programs from the Océ Settings Editor. See ‘Maintenance’ on
page 191 for more information.

3 Feed the sheet of paper face down and with the legend on your right-hand side.
Also make certain that you feed the paper with the legend on the right-hand
side (see ‘Océ TDS600 folder’ on page 232 for more information).

Note: Wait until the light on the folder no longer blinks before you feed a
new sheet. Otherwise a media jam may occur.

4 Collect your output.

Reinforcement unit

If you install a reinforcement unit, output can be delivered with a pre-punched,
self-adhesive strip (see Figure 159).

Protection sheet

[159] Example a of reinforcement strip

With this strip the copy can be stored in a binder, without running the risk that
the punching holes tear out. You can unfold a folded map in a binder without
opening the binder mechanism (see Figure 160).
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[160] Example of a folded map with a reinforcement strip

The optional reinforcement unit supports all media sizes larger than A4.
However, A4 size media can also be reinforced if you enable A4 reinforcement
in the Océ Settings Editor (see ‘Find system settings in the Settings Editor’ on
page 137).

Note: Reinforcement is only possible with the Standard folding method.

See ‘Maintenance of the reinforcement knives’ on page 204for more
information about inserting a new tape roll and other maintenance issues.

v Enable reinforcement

1 Click on the ‘Jobs’ button in the Océ Settings Editor.

2 Select the ‘Copy’ tab if you want to enable folding reinforcement for copy jobs
or select the ‘Print’ tab if you want to enable folding reinforcement for print
jobs.

Open the ‘Defaults’ folder.

Open the ‘Finishing’ folder.

Select the ‘Folding reinforcement’ option.

Enable folding reinforcement in the right part of the window.
Click on the ‘Apply’ button to save any changes you have made.

N o g s~

Belt unit

A belt unit offers a large capacity and more flexibility. On the belt unit up to
100 AO prints can be delivered offset stacked. You can adjust the side guides
of the belt, depending on the width of the folded package.
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v Selecting belt as folded copy delivery on scanner operator panel

1 Open the ‘Finishing’ card in the ‘Copy’ section of the scanner operator panel.
2 Press the ‘Folding’ function key to select full folding.
3 Press the ‘Folded copy delivery’ function key to select the belt.

v Adjusting the side guides of the belt
1 Loosen the nuts (see Figure 161).

[161] Adjusting the side guides of the belt

2 Adjust the plate in accordance with the width of the fold package.
3 Tighten the nuts.
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Overview of the Océ TDS600 system

[162] The Océ TDS600 system

Off-line folding input
Integrated receiving tray
Printer operator panel
Manual feed

Printer

Rolls or cassette trays
Scanner

Scanner operator panel
Scanner feed table
Folder

© © 0O NO O & WDN =

=y
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Printer operator panel

Extra key for

future use.
Display Readytoprint
# 1 A0 paper 2 Al paper
(73 A1 paper (T 4 A2 paper
=1 &3 paper C]
T paper L1z Adpaper
On-line
key

on line

Up/Down
keys

Selection
keys

Stop key
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Scanner Operator Panel

Section keys Arrow keys
1

Original

Job

Interrupt @1 A0 Paper ! 2 A1 Paper !

key @5 &2 Paper I 4 41 Paper | Multiple sheets 100%
#1 A3 Transp. ! 2 12"Transp. ! Set

Function [ : ®5ingle sheet ® sutomatic

keys Input mode
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Product specifications Océ TDS600

The Océ TDS600 is a wide format, black and white, mid-volume,
multifunctional system. The Océ TDS600 offers a broad range of print, copy,
and scan-to-file functions.
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Printer

Technology Electrophotographic LED head with organic
photoconductor (OPC) drum and closed toner system

Resolution 400 dpi

Speed 5 linear meters p/min. or approx. 4 A0s p/min.

Media sources

Several possible configurations from 2 to 6 rolls, up to 3
cassette trays, and manual sheet feed

Output sizes

DIN and ANSI formats from A4 to AQ and 36”, upto 15
meters long

Media types

Plain, transparent, recycled, fluorescent and colored
papers; films and vellums

Output reception

Standard Integrated Receiving Tray (IRT) for 100 prints

Warm up time

None, instant behavior

Electrical requirements

120/200/230 V, 50/60 Hz

Dimensions 1,400 mm (W) x 1,470 mm (H) x 753 mm (D) including
integrated receiving tray (6-roll and 1-cassette trayr
model)

Weight From 250 kg (model with 2 rolls) to 360 kg (model with

6 rolls and 1 cassette tray)

Safety approvals

TiiV GS, CETECOM, CE, UL, (c)UL, CB, FCC Class B

Function

Multiple prints: up to 999

Automatic Language Sensing (ALS)

Auto roll/cassette tray selection and switching

Print manipulation: auto positioning, rotation, auto
scaling

File spooling on the controller

Set memory: send once, process once, print many;
capacity to store up to 250 AOs and create identical sets
sorted by page or by set

Concurrent receiving, processing, printing, and
finishing of digital jobs

Sophisticated local and remote user communication
system with:

Océ Queue Manager application: view status for each
job and cancel, hold/restart the entire job

Océ System Control Panel application: view status and
settings of system components

Océ Settings Editor application: customise system
settings
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Océ Power Logic® Controller

Platform Océ Controller with embedded Windows XP®

Memory 128 MB RAM standard, 256 MB RAM for scan-to-file

Disk space High-speed hard disk dedicated to file spooling, and a
high-speed hard disk dedicated to set memory offering
250 AO storage capacity

File formats HPGL, HPGL2, HPRTL, TIFF 6.0, CALS type 1, NIRS,
EDMICS (C4), CalComp 906/907/951, Adobe®
PostScript® 3™/PDF (optional)

Interfaces Standard: Ethernet 10/100 Mbits/s with RJ45

Optional: TokenRing 4/16 Mbits/s

Network protocols

TCP/IP, Novell (IPX, SPX)

Océ Remote Logic® Applications

Model

Local and remote user communication system

Applications

Océ Settings Editor:

customize system settings

Océ Queue Manager:

view and edit status for each job, history queue, inbox
queue.

Océ System Control Panel:

view status and settings of system components

Supported platforms

Windows® 95/98/2000,NT® 4.0 and XP. Apple
Macintosh® OS, Unix (including Linux, HP-UX 10.20
and 11.00, and IBM AIX)

Océ Matrix Logic® (optional)

Applications Océ Matrix Logic®, integrated Matrix Copy solution

Platform Océ Power Logic® Controller with embedded Windows®
XP

Function Allows you to form in one single operation different copy

sets from one set of originals
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Scanner

Model Free-standing console
Optional: Original delivery tray

Technology CCD, Océ Image Logic® real-time image processing
hardware

Speed 5 linear meters per minute or approximately 4A0s per
minute

Original feed Face down, aligned to the right
Automatic feed off/on
Rewind original to front off/on

Originals Automatic original size detection

Image width: 210 - 914 mm
Original width: 210 -1,020 mm
Original length:150 mm - 15 m

Maximum thickness

1 mm

Exposure control

Automatic, manual fine adjustment
Special modes: Lines & Text (default), Photo, Grays &
lines, Dark Original, Blueprint, Printed matter

Media selection

Manual or automatic, based on original size (autodetect)
and zoom factor

Reproduction scale

Zoom: 25% - 400% (adjustable in 1% and 0.1% steps)
Programmable fixed steps
Auto zoom to paper size

Input mode

Single sheet
Set (sets processing/set collation)
Multiple sheets

Other operating
Functions

Concurrent scanning and printing

Multi-copy mode: 1-999 copies (scan once print many)
Pre-programming of next job

Programmable default settings

Programmable custom card

Automatic roll selection

Automatic reduction/enlargement

Standard cut, synchro cut and custom cut modes
Leading and trailing strip adjustment (up to +/- 400 mm)
Two languages available

Image editing

Image align: Horizontal left, middle, right
Image align: Vertical top, centre, bottom
Image shift: horizontal/vertical

Image mirroring
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Scanner (continued)

Dimensions

1,314 mm (W) x 583 mm (H) x 1,353 mm (D)

Weight

90 Kg
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Scan-to-file

Applications

Océ Scan Manager, integrated scanning solution and
Océ View Station LT for viewing.

Scan destinations

10 programmable destinations
Scan to controller

Scan to network directory
File Transfer Protocol (FTP)

Resolution

200, 300, 400 dpi

Data formats

PDF

Tiff (G3, G4, uncompressed) with optimisation to
filesize or quality

CALS type 1

Scan modes Single scan, stream feed productive batch scanning

File naming Automatically generate unique file names for each scan

Check print Single and multiple check prints

Viewing View scans at point of scanning

Océ Image Logic® Optimum scan quality with six special original modes

Ease of use can to file from scanner panel, scan directly to
destination

Options Océ View Station: Edit and enhancement software

Océ Batch Processor: Automated editing software

Drivers and job submission software

Océ HDI driver

For AutoCAD® 2000
Windows® 95/98, NT® 4.0 and XP

Océ Windows driver

Windows® 95/98, NT® 4.0 and XP

PostScript®3™
drivers

For Windows® 95/98, NT® 4.0 and XP

Océ Print Exec ® LT

Single seat job submission software for Windows®
95/98/2000, NT 4.0®, XP and Millennium

Océ Print Exec ®
Workgroup

Multi-seat job submission and back channel
communication software using standard web browsers:
Internet Explorer® 4.02 SP2 or higher and Netscape® 4.08
or higher

Océ Repro Desk

A print management solution for the reprographer and their
clients.

Others

Certified drivers for e.g. Microstation, Intergraph and Pro
Engineer, provided by the CAD/EDM software supplier
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Finishing: integrated Folder

Folding modes

On-line fanfold and crossfold, off-line folding

Folding method

Standard (=DIN-like), Ericsson, Afnor-like;
Length: 276 -310 mm

Width: 186 -230 mm

Filing strip: 15 -30 mm

Paper size

(75 g/m?),

Width: 279 - 914 mm

Length: 210 - 6,000 mm fanfold only;
210 - 2,500 mm for fanfold and crossfold

First fold exit

Extra bin for fanfold

Dimensions 2,200 mm (W) x 997 mm (H) x 1,260 mm (D)
Weight 220 kg
Optionals Reinforcement unit

Belt delivery tray for 100 AO

Finishing: copy delivery tray for the printer

Model Wheeled delivery tray with blower unit

Capacity Up to 150 sheets (media type dependent) from A4 to AO

Types of media Plain paper, transparent paper, film, vellum and
polyester

Power consumption <40W

Electrical requirements

100/120/230 V, 50/60 Hz

Dimensions 1,170 mm (W) x 1,090 mm (H) x 1,440 mm (D) with
tray fully extended
Weight 35.5kg

Finishing: original delivery tray for the scanner

Model

Wheeled delivery tray with blower unit

Capacity

Up to 150 sheets (media type dependent) from A4 to AO

Types of media

Plain paper, transparent paper, film, vellum and
polyester

Power consumption

<40 W operating

Electrical requirements

100/120/230 V, 50/60 Hz

Dimensions 1,170 mm (W) x 1,090 mm (H) x 1,440 mm (D)
Tray fully extended
Weight 355Kg
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List of available material types and sizes
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Océ machines and materials are matched for optimal quality and performance.
It is therefore recommended to use only approved Océ materials in the Océ

TDS600.

A full list of Océ materials suited for use in the Océ TDS600, including plain
paper, transparent paper, colored papers and various polyester films is
available from your Océ representative.

Material types The following material types are available for the Océ TDS600:

Material Types

Plain paper

75 to 110 g/m?

Transparent paper

80 to 110 g/m”

Vellum 16 - 20 1bs
Polyester film 3.5 or 4.5 mil
Top label paper 60 g/m”
Special colored paper, etc.

Minimum Maximum
Width 210 mm 914 mm
Length 279 mm 15m

Material sizes The following material sizes are available for the Océ TDS600:

Material Sizes

Format Width Length Format Width Length
ISO range ANSI range

A4 portrait 210 mm 297 mm A portrait 8.5” 11”7
A3 297 mm 420 mm B 117 17”7
A2 420 mm 594 mm C 177 227
Al 594 mm 841 mm D 227 347
A0 841 mm 1,189 mm E 347 44»
Format Width Length Format Width Length
ANSI PLUS Others

range

A+ portrait 9” 12”7 30~ 307 427
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Material Sizes (continued)

Format Width Length Format Width Length
B+ 127 18” B1 707 mm | 1,000 mm
C+ 18” 24” Bl+ 700 mm | 1,000 mm
D+ 24> 36” B2 507 mm |700 mm
E+ 36” 48” B2+ 500 mm |700 mm

Attention: Avoid storing paper in rooms where temperature and humidity
are high. Also, avoid dust and direct sunlight. Wrap unused paper in plastic
to prevent it absorbing moisture.

Reinforcement strips

Information about the different reinforcement strips is available from your Océ

representative.

Attention: Only use the original reinforcement strips from Océ, to avoid
damage to the reinforcement unit.
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Recommended weight limits

The Océ TDS600 can be equipped with 6 rolls. The following recommended
weight limits (RWLs) for the roll positions can be calculated based on the
NIOSH method (National Institute for Occupational Safety and Health):

Weight limits (in kg

and Ibs.)

Roll 1 13.5 kg (29.7 1bs.)
Roll 2 8.9kg (19.6 1bs.)
Roll 3 13.2 kg (29 1bs.)
Roll 4 8.3 kg (18.3 1bs.)
Roll 5 13.3 kg (29.3 1bs.)
Roll 6 8.0kg (17.6 1bs.)

Note: Every roll placed in the machine includes a 1.3 kg (2.9 Ibs) roll holder.

A roll loader has been designed to allow placement of all available materials in
all roll positions without exceeding the RWLs. The roll loader allows you to
safely use the following weights per roll:

Weight limits (in kg

and Ibs.)

with roll loader

Roll 1 21.7 kg (47.7 1bs.)
Roll 2 20.5 kg (45.1 1bs.)
Roll 3 22.9 kg (50.4 1bs.)
Roll 4 22.4 kg (49.3 Ibs.)
Roll 5 20.1 kg (44.2 1bs.)
Roll 6 21.5 kg (47.3 Ibs.)
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The following overview shows the weights of some commonly used materials:

Roll weights per material

Plain paper, 24 1b bond, E size, 500 feet 9.7kg (21.31bs.)

Transparent paper 23 1b, E size, 500 feet 8.2 kg (181bs.)

Océ polyester film (3.5mil, E size, 150 feet) 11.8 kg (26 1bs.)

Vellum 7500 (20 Ib, 36", 500°) 11.4kg (25.1
Ibs.)

Engineering bond 45-111 (20 Ib, 36", 500”) 11.4kg (25.1
Ibs.)

Note: Weights do not include the 1.3 kg (2.9 Ib) roll holder.

The weight of a stack of sheets never exceeds the RWL.

Caution: If the Océ TDS600 printer is not equipped with the optional roll

loader, the NIOSH limit for load handling will be exceeded when rolls of
imaging materials having a net weight of more than 7 kg (15.5 lbs) (i.e. a
width of more than approximately 50 cm or 20 inches) are placed in the roll
positions 2, 4, and 6 by a single person.
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Instructions for safe use

260

Océ machines and materials have been developed and tested in accordance
with the strictest international safety standards. To ensure safety in working
with these products, it is important that you observe the following safety rules:

m Do not remove any screws from fixed panels.

m The machine is not user-serviceable except for the components and
maintenance materials mentioned in this manual.

m Do not place any liquids in or on the machine.

= Use maintenance materials or other materials for their original purpose only.
Keep maintenance materials away from children.

m Do not mix cleaning fluids or other materials.

m To avoid risks, all modifications to Océ equipment must be performed only
by Océ service personnel. We recommend the use of Océ-specified
attachment cables.

= Do not bridge any mechanical or electrical circuit breakers.

= Do not use an extension cord to connect the machine.

m Locate the machine close to an easily accessible dedicated 16 A wall socket.

m The switch in the fixed connection (if any) should be easily accessible.

m This machine has not been designed for connection to an IT power system.
(An IT power system is a voltage network in which the neutral wire is not
grounded).

= Do not block the ventilation openings of the machine.

m Ensure that the machine is placed on a level, horizontal surface of sufficient
strength. See the Océ TDS600 safety data sheet in this appendix for
information about the weight of the machine.

m Make sure there is sufficient space around the machine. This facilitates
reloading materials as well as maintenance.

= Do not place the machine in rooms which are subject to excessive vibration.

m Do not place the machine in rooms which are too small and insufficiently
ventilated. See the Océ TDS600 safety data sheet in this appendix for
information about space and ventilation requirements.

m Always use materials recommended by Océ and developed for this Océ
machine. Materials not approved by Océ may result in machine errors or
malfunctions.

m Do not use the machine if it is making unusual sounds. Remove the plug from
the power socket and contact your key operator.

= Do not open more than one drawer at a time.

m Do not remove the printer supports underneath the Océ TDS600.
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Caution: All four leveling feet of the TDS600 printer must be screwed into
place to properly balance the machine before opening the paper drawers.
Do not attempt to open the drawers to add paper or other media before the
leveling feet are properly and securely installed in place.
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Safety data sheets

262

Disclaimer The following disclaimer is valid for all safety data sheets in this
manual.

These safety data sheets have been compiled to the best of our knowledge as a
condensed guide to safe handling of this product. We reserve the right to revise
safety data sheets as new information becomes available. It is the user’s
responsibility to determine the suitability of this information for the adoption
of such safety precautions as may be necessary, and to contact the company to
make sure that the data sheet is the most recent one issued. To the extent that
limitation of liability is permitted under applicable law, we do not accept
liability for any inaccuracy that may occur in this information.
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Safety data sheet Océ TDS600 printer

PRODUCT SAFETY DATA SHEET océ
Number E-732-a-US
Date January 2001
Model Océ TDS600 printer engine
Description Electrophotographic printer, console model, plain paper, organic photoconductive drum,
powder toner .
Max. process speed 5 m/min
Dimensions Width 1400 mm
Depth 753 mm
Height 1470 mm
Weight 250 kg
50 kg (extra rolldrawer) 25 kg (extra sheet feeder)
Voltage 120 V 230 V
Frequency 60 V 60 Hz
Current-rated 15 A 75 A
Power consumption, operation 1470 W
Power consumption, standby 50 W
EPA ENerGY STAR®
* Power consumption, low power 15 W Recovery time < 3 seconds
Mains connection Cable with plug
Safety class | (IEC 536) Protective earth connection
Protection class IP 20 (IEC 529)
Standby In operation
Sound pressure level 28 dB(A) mainbody 52 dB(A);
(at operator/bystander incl. optionals 55 dB(A);
position) mpulse Lj=4dB(A)
Sound power level 43 dB(A) mainbody 65 dB(A);
incl. optionals 67 dB(A)
Radio interference Complies with Directive 89/336/EEC and FCC rules and regulations, part 15 Class A
Radiation Below the Threshold Limit Values for UV, Visible and IR radiation (TLV list of ACGIH)
Heat emission Standby 50 W; in operation 1470 W
Ozone emission 0,004 mg/min at continuous operation
Room volume Recommendation: min. 50 m®
Room ventilation Recommendation: min. 25 m%h (natural ventilation)
(For heat evacuation extra ventilation may be necessary)
Use simulation at random With a room volume and ventilation as recommended and a daily volume of 210 m (much
operation more than average) the use simulation at random operation gives the following ozone
concentrations:
- Time weighted average 0,001 mg/m? (0,0005 ppm)
- Peak 0,002 mg/m3 (0,0005 ppm)
Threshold Limit Value/Occupational Exposure Limit
(Time Weighted Average) for ozone 0,2 mg/m® (0,1 ppm)
Odour Perception Limit for ozone 0,04 mg/m3 (0,02 ppm)
Consumables Océ OPC Drum (Océ Material Safety Data Sheet E-218)
Océ B5 Toner (Océ Material Safety Data Sheet E-199)
Océ D5 Developer (Océ Material Safety Data Sheet E-200)
Océ Copying Materials. This apparatus is suitable for processing recycling paper which
complies with the requirements of ENV 12281.
Additional safety information The ozone filter does not haye to be replaced for keeping the ozone concentration in the
workplace below 0,04 mg/m3 (the life of the filter equals that of the apparatus).
Listed according to standard UL 1950 and CAN/CSA-C22.2 No.950 EPA ENerGY STAR®
LISTED 927F
INFORMATION
TECHNOLOGY
c us EQUIPMENT W
E 60871
Copyright © 2001 Océ-Technologies B.V., Venlo, NL

Note: The contents of this safety data sheet are subject to the disclaimer on
page 262 of this manual.
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Safety data sheet Océ TDS600 scanner

PRODUCT SAFETY DATA SHEET

Number
Date

E-731-a-US
January 2001

Radio interference
Radiation

Heat emission
0Ozone emission

Model Océ TDS600 Scanner
Description Freestanding wide format scanner
Max. process speed 5 m/min
Dimensions Width 1314 mm

Depth 583 mm

Height 1353 mm
Weight 90 kg
Voltage 120 Vv 230 V
Frequency 60 Hz 60 Hz
Current-rated 2 A 1A
Power consumption, operation 110 W at continuous operation
Power consumption, stand by 97 W
EPA ENerGY STAR®
* Power consumption low power 7 W
Mains connection Cable with plug
Safety class | (IEC 536) Protective earth connection
Protection class IP 20 (IEC 529)

Stand by In operation

Sound pressure level 26 dB(A) main body 52 dB(A)
(at operator position) impulse Lj=4dB(A)
Sound power level 43 dB(A) main body 62 dB(A)

Complies with Directive 89/336/EEC and FCC rules and regulations, part 15 Class A
Below the Threshold Limit Values for UV, Visible and IR radiation (TLV list of ACGIH)

Standby 97 W; at continuous operation 110 W
Not applicable

Room volume
Room ventilation

No special requirements

Consumables

Not applicable

safety information

None

Listed according to standard UL 1950 and CAN/CSA-C22.2 No.950

LISTED 927F

INFORMATION
TECHNOLOGY
EQUIPMENT

H Us

E 69871

EPA ENERGY STAR®

G

Copyright © 2001 Océ-Technologies B.V., Venlo, NL

Note: The contents of this safety data sheet are subject to the disclaimer on
page 262 of this manual.
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EPA ENERGY STAR

a s ON =

®

Océ-Technologies B.V. has joined the ENERGY STAR® program of the United
States Environmental Protection Agency (EPA). The purpose of the ENERGY
STAR® program is to promote the manufacturing and marketing of
energy-efficient equipment, thereby potentially reducing combustion-related
pollution.

Using the energy management features outlined below prevents unnecessary
power consumption, which helps to reduce air pollution from
electricity-generating plants and saves money on your utility bills.

The Océ TDS600 is supplied as a printer and as a copier/printer and includes
the following separate units:

Océ TDS600 printer

Océ TDS600 controller

Océ TDS600 monitor

Océ TDS600 scanner (copier/printer only)
Océ TDS600 folder (optional)

As an ENERGY STAR® partner, Océ-Technologies B.V. has determined that
both the printer and the copier/printer meet the ENERGY STAR® guidelines for
energy efficiency.

The EPA ENERGY STAR® criteria involve the following features:

Low power mode The Océ TDS600 printer is shipped with the low power
mode default time set at 30 minutes, which means that the device automatically
enters the low power mode 30 minutes after the last print is made.(*) The low
power mode default time can be adjusted by the key operator to between 5 and
60 minutes. The low power mode recovery time is less than 1 second, after
which printing can be resumed ("instant printing", i.e. time to first print less
than 40 seconds).

The Océ TDS600 has a standby mode which complies with the ENERGY
STAR® low power mode criteria for Multifunction Devices.(*) The default
time is zero and the recovery time is less than 1 second.
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Sleep mode The Océ TDS600 is shipped with the sleep mode default time set
at 30 minutes, which means that the device automatically enters the sleep mode
30 minutes after the last copy or print is made.(*) The sleep mode default time
can be adjusted by the key-operator to between 20 and 60 minutes. The sleep
mode recovery time is less than 1 second. Only if a sleep mode default time of
60 minutes still causes you significant inconvenience, due to your particular
usage pattern, the key-operator may disable the sleep mode feature.

Recycled paper The use of recycled paper also benefits the environment. The
Océ TDS600 is designed to use recycled paper. Product literature on
recommended types of recycled copier/printer paper can be obtained from
your local Océ company or Océ Headquarters (Océ-Technologies B.V.) in
Venlo, the Netherlands.

(*) For power consumption data: see the Product Safety Data Sheet in this

s

ENERGY STAR® is a U.S. registered mark.
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How to read this manual

The consistent style that is used in this manual enables you to quickly become
familiar with the use of this manual and ultimately the Océ TDS600.

Description Each section or subsection contains a description of the feature or
operation identified in the title. It might also include possible applications, as
well as any guidelines that you should bear in mind.

Procedures A description is followed by a procedure. A procedure always
begins with a phrase which briefly describes the procedure, followed by a
series of numbered steps that take you, step by step, through all phases of
performing the operation.

Figures and tables Figures and tables are titled and numbered sequentially
throughout this manual. Figures include pictures of product components,
screen dumps, examples, and diagrams of concepts discussed in the
description.

Attention getters There are several types of information to which we draw
your attention. This information is classified as follows:

Note: In a ‘Note’, information is given about matters which ensure the proper
functioning of the machine or application, but useful advice concerning its
operation may also be given.

Attention: The information that follows ‘Attention’ is given to avoid
damage to your copy or original, the copier or printer, data files, etc.

Caution: The information that follows ‘Caution’ is given to prevent you
suffering personal injury. .
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User survey

Did you find this manual to be accurate?
O Yes
d No

Were you able to operate the product after reading this manual?
O Yes
d No

Does this manual provide adequate background information?
1  Yes
d No

Is the format of this manual convenient in size, easy to read and layed out well?
3 Yes
d No

Did you find the information you were looking for?
d  Always

(4 Most of the times

(d  Sometimes

(d Not atall

How did you find the information you were looking for?
(4 Table of contents

4 Index

d  Neither

Are you satisfied with this manual?
d  Yes
d No

Thank you for evaluating this manual.

If you have any other comments or concerns, please explain them on the
following page.
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Comments:

Date:

This reader’s comment sheet is completed by:
Name (optional):

Occupation:

Company:

Phone:

Address:

City:

Country:

Please return this sheet to:

Océ-Technologies B.V.

Attn: ITC-User Documentation
P.O. Box 101

5900 MA Venlo

The Netherlands

Send you comments by E-mail to : itc-userdoc@oce.nl

For the addresses of local Océ organizations see : Wwww.oce.com
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Addresses of local Océ organizations

Océ-Australia Ltd.

P.0.Box 363

Ferntree Gully MDC VIC 3165
Australia

Océ-Osterreich GmbH
Postfach 95

1233 Vienna

Austria

Océ-Belgium N.V./S.A.
Avenue J.Bordetlaan 32
1140 Brussels

Belgium

Océ-Brasil Comércio e Industria Ltda.
Caixa Postal 3187

01060-970 Sao Paulo, SP

Brazil

Océ-Canada Inc.

4711 Yonge Street, Suite 1100
Toronto, Ontario M2N 6K§8
Canada

Océ Office Equipment (Beijing) Co Ltd.

Xu Mu Cheng
Chaoyang District
Beijing 100028
China

Océ-Ceska republika s.r.o.
Hanusova 18

14021 Praha 4

Pankrac,

Czech Republic

Miscellaneous

Océ-Danmark A.S.
Kornmarksvej 6
DK 2605 Brgndby

Denmark

Océ-France S.A.

32, Avenue du Pavé Neuf,
93161 Noisy-le-grand, Cedex
France

Océ-Deutschland GmbH
Postfach 101454

4330 Miilheim an der Ruhr (13)
Deutschland

Océ (Hong Kong China) Ltd.
12/F 1202 The Lee Gardens

33 Hysan Avenue, Causeway Bay
Hong Kong

Océ-Hungaria Kft.
P.O.B. 237

1241 Budapest
Hungary

Océ-lItalia S.p.A.

Strada Padana Superiore 2/B
20063 Cernusco sul Naviglio (MI)
Italia

Océ Systems (Malaysia Sdn. Bhd.)
#3.01, Level 3, Wisma Academy
Lot 4A, Jalan 19/1

46300 Petalig Jaya

Malaysia
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Océ-Nederland B.V.
P.0.Box 800

5201 AV ‘s-Hertogenbosch
The Netherlands

Océ Norge A/S
Postboks 53, Grefsen
0409 Oslo 4

Norway

Océ-Poland Ltd.
ul. Lopuszariska 53
02-232 Warszawa
Poland

Océ-Lima Mayer S.A.

Av. José Gomes Ferreira, 11
Ed. Atlas II Miraflores
1495 Algés

Portugal

Océ (Far East) Pte. Ltd./
Océ (Singapore) Pte. Ltd.,
#03-00 Wisma Gulab

190 MacPherson Road
Singapore 348548

Océ Espafia SA
Business Park MAS BLAU
C/Osona 2, 2-3a Planta

08820 El Prat del Llobregat (Barcelona)

Spain

Océ-Svenska AB
P.O.box 1231
S-164 28 Kista
Sweden

Océ-Schweiz AG
Siagereistrasse 29
CHB8152 Glattbrugg
Switzerland
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Océ (Taiwan) Ltd.

No. 99-24 Nan Kang Road Sec.2
Taipeh, Taiwan

Taiwan, RO

Océ (Thailand) Ltd.

16th Floor, B.B. Building

54 Asoke Road, Sukhumvit 21
Bangkok 10110

Thailand

Océ-U.K.Ltd.

Langston Road

Loughton, Essex IG10 3SL
United Kingdom

Océ-USA Inc.

5450 North Cumberland Av.
Chicago, I11. 60656

US.A.



Index

A

access 119
Account logging 166
Retrieving the account log file 170
add a controller 155
adding toner 191
replacing waste toner bag 191
applications 142
apply 116
attention light 30, 212
Auto align 106
Automatic logon 151
automatically view a scanned file 89
available material types and sizes 255

B

background compensation 104
belt unit 236, 244

binding strip 237

C
call service 234
Check print 77
clear paper jams

folder 220

fuser section 218
clicks 72
command line parameters 152
compression 78, 79
connect to a controller 155
Connecting 155
connecting workstations 92
Controller

startup 24
copy

originals 98
custom card 121

Index

D

default settings 44, 66

define settings 57

delete a scanned file 88

delete print jobs 132

Deleting a destination 87

destination 77

Display language 152

drawing method 237

E
editing image 106

EPA Energy Star 265

exposure
modifying 52

F
file mode 77
file type 78

cals 78

tift 78
folded copies 236

folded package length 237
folded package width 237

folder 236
belt unit 242

standard folding program 236

Folder options
belt unit 236

reinforcement unit 236

folding length 239

folding settings 240, 241

FTP 91
printing 17

Retrieving the account log file 170
function keys 45, 67

functions
Océ TDS600

14
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G

general control buttons 118
get files 92

glass platen 196

H

help 152

History queue 127

history queue 134

How to use the remote system 155

N

|

Import the account log file 171
Inbox queue 127, 133

install remote logic 143
instructions for safe use 260

J

jams 215

Japan support 15
destination names 86

Job interrupt 50, 60, 71

job interrupt 44, 66

K

key operator settings 113

keys 32
correction 44
selection keys 32, 44, 66
stop 32, 44, 66

L

language 47, 69, 152
Leading and trailing strip 101
loading media 182, 196

cutting sheet material 189
rolls 183, 196
using a roll loader 186

Locking a destination 86
Log file 166

Log off 150

Logon 150

Log record 172

M

manual feed 58
media 52

menu bar 115

mirror 80

move a job to top 133

N

non-standard sized originals 98

(o)

Océ Remote Logic 141

User modes 149

Océ TDS600

functions 14

Océ TDS600 application

System Administrator Settings 21

Océ TDS600 applications

Key Operator Settings 21
Queue Manager 20
queue manager 126
System Control Panel 20

Océ TDS600 folder 235
Océ TDS600 printer 14
off-line folding 240, 241
operating panel

scanner 43

operator panel

printer 30
scanner 65

optimization 80

file size 80
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scan quality 80
organization 78
original delivery
selecting front or rear output 57
original type 105
originals 98
copying thick 57
thick 98
other problems 234

P

paper jam
belt unit 226
folder 220

folder transport section 222
fuser section 218
roll feed section 217
second fold section 222
sheet feeder 216
paper jams 215
Paper series 186
paper series 53
password 151
print a scanned file 88
Print Exec LT Web 17
Print Exec LT web 157
Create a new job - advanced 163
Create a new job - basic 162
welcome page 164
printer keys 32
printer settings
selecting language 36
setting a special media indication 33, 35
setting media type and size 33
stop a print job 36
product specifications 249
Prompting for file name 87
properties of a scanned file 89

Q

Queue Manager
active print job window 126
delete print jobs 132

Index

functions 20, 126
introduction 20, 126
menu bar 126
modes 129
move a job to top 133
pause print jobs 132
print queue window 127
restart a paused print job 133
restart a paused print jobs 133
structure 126
view the print queue 132
window 128

Queue Manager window 137

R

recommended weight limits 258
reference roller 196
reinforcement unit 236
Remote logic
languages 152
removing the folder’s Nickel Cadmium battery
266
repro operator settings 18, 113
resolution 79
restart a paused print job 133
retrieve scanned files 91
Retrieving the account files 168
FTP 168
roll holder 183, 187

S
safety data sheet
Océ 9600 printer 263, 264
safety data sheets 262
safety information 257, 260
Scan Manager
deleting a destination 87
destination
lock 86
unlock 86
local destination 84
network destination 85
web destination 85
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scan manager 81, 84
scan to file
how to 74
Scanner
zoom 55
scanner operator panel
keys
correction 66
job interrupt 66
numeric 66
start 66
stop 66
scanner panel
keys 44
correction 44
job interrupt 44
numeric 44
start 44
scanner panel keys
stop 44
Scan-to-file
file name 87
scan-to-file
destination 74
ftp 85
local 84
smb 85
file mode 74
password 72
settings 76
selecting language 36
selection keys 32, 44, 66
Setcopy 110
setting dependencies 113

setting media type and size 33
setting special media indication 35

Settings

scanner operator panel 49, 70

settings area 117
sheet feed 58
solve problems 234

Standard folding program 236

Startkey 110

start key 52

status bar 118

stop a copy job 62

stop a print job 36
Stop key 36

stop key 32, 44, 62, 66
supported media 183

system administrator settings

System Control Panel (SCP)
icons 139
introduction 136
structure 136

T
table view 82

file properties 82
Templates 49, 70
temporary storage 90
tiff subformat 78, 79
tree structure 117
tree view 82

destinations 82

Turn on
printer 24
scanner 24

Turn on and off 23

U

undo 116

Unix 145

Unlocking a destination 86
update area 118

User interaction 16

User modes 149

user modes 119

\"

view a scanned file 88

View error 96

view printer status 135

view station LT 72, 93
view a scanned file 74

view the print queue 132
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waste box 207

waste toner bag 191

work on a remote system 155

zoom 80
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